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INTRODUCTION 

Equipped with two independent digital video channels, the E-HD2 video server plays 
and records high-definition (HD) and standard definition (SD) video as well as 

embedded, digital AES, or analog audio.  Each channel operates as either an encoder 
or decoder (recorder or player) on a scheduled or immediate basis, making the E-HD2 a 
highly flexible playback and recording solution.  Additionally, the E-HD2 will control 

compatible external routing switchers and offers scalable external USB drive and 
network attached storage (NAS) options to meet your digital video storage needs.  

Included with the E-HD2 is WinLGX, a software application that provides all of the tools 
necessary for local and remote system operation.  WinLGX offers a system control 

panel, digital media resource library, and an easy-to-use, drag-and-drop scheduling 
interface. 

IMPORTANT SAFETY INSTRUCTIONS 

1. Read these instructions. 

2. Keep these instructions. 

3. Heed all warnings. 

4. Follow all instructions. 

5. Do not use this apparatus near water. 

6. Clean only with dry cloth. 

7. Do not block any ventilation openings. Install in accordance with the manufacturer’s 

instructions. 

8. Do not install near any heat sources such as radiators, heat registers, stoves, or 
other apparatus (including amplifiers) that produce heat. 

9. Do not defeat the safety purpose of the grounding-type plug. A grounding-type plug 

has two blades and a third grounding prong. The third prong is provided for your 
safety. If the provided plug does not fit into your outlet, consult an electrician for 
replacement of the obsolete outlet. 

10. Protect the power cord from being walked on or pinched particularly at the plugs, 

convenience receptacles, and the point where they exit from the apparatus. 

11. Only use attachments/accessories specified by the manufacturer. 

12. Unplug this apparatus during lightning storms or when unused for long periods of 

time. 

13. Refer all servicing to qualified service personnel. Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or plug is 

damaged, liquid has been spilled or objects have fallen into the apparatus, the 
apparatus has been exposed to rain or moisture, does not operate normally, or has 
been dropped. 
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14. When the apparatus is turned off, certain components in the power supply and 
system board remain energized. In order to remove all electrical power from the 

apparatus, unplug the power cord from the MAINS socket outlet. 
 

 
WARNING 

To reduce the risk of electric shock, do not expose this apparatus 

to rain or moisture. 

 
WARNING 

This apparatus must be connected to a MAINS socket outlet with a 

protective earthing connection. 

FEATURES/SPECIFICATIONS 

NOTE: In no event shall LEIGHTRONIX be liable for any damages whatsoever 
resulting from loss of use, data, or profits, whether or not advised of the 

possibility of damage, and on any theory of liability, arising out of or in 
connection with the use or performance of the E-HD2 high-definition 
server/system controller and WinLGX software. 

 

FEATURE SPECIFICATIONS 

Dimensions 1.75"H X 19.0"W X 15.0"D  

Weight, without carton or 
cables 

14 lbs. 

Display 2 X 10 character liquid crystal display 

Keypad Six push buttons which allow password protected front 

panel status and configuration 

Power Supply Internal power supply which accepts 100–240VAC @ 50–
60Hz 

Product Safety Audio, Video and Similar Electronic Apparatus – Safety 

Requirements certification by ETL Semko for U.S. 
Standards (UL-60065) and Canadian Standards 
(CAN/CSA C22.2 No. 60065) 

Emissions Compliance FCC Part 15 

2 H.264 Hardware 

Encoders (Recorders)/ 
Decoders (Players) 

 Two independent HD/SD digital video channels, with 

each operating as either a player or recorder 

 H.264 High Profile video encoding/decoding, HD Level 

4 and SD Level 3 

 MPEG-1 Layer II audio encoding/decoding 

 Automatic video and audio multiplexing during 
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FEATURE SPECIFICATIONS 

recording results in a single MPEG-2 transport stream 
(.m2t) file containing an H.264 High Profile video 

stream and MPEG-1 Layer II audio. 

 Supports HD (1080i and 720p) and Standard Definition 

(480i) playback and recording 

 High Definition 

o 1920 x 1080 (29.97 Hz Interlaced, IBP group of 

pictures [GOP] structure) 

o 1280 x 720 (59.94 Hz progressive, IBBP GOP 

structure) 

 Standard Definition: 720 x 480 (29.97 Hz interlaced, 

IBBP GOP structure) 

 4:2:0 chroma subsampling, 8-bit, YCbCr 

 Constant and variable video bit rate encoding up to 10 

Mb/s 

 48 KHz audio sampling frequency with audio bit rates 

of 192, 224, or 256 Kb/s 

Digital Video Inputs/Outputs  Two BNC-F HD/SD-SDI video inputs 

 Two BNC-F HD/SD-SDI video outputs 

 Society of Motion Pictures and Television Engineers 

(SMPTE) standards for inputs/outputs: 

 HD: SMPTE292M 

 SD: SMPTE259M 

 Support for embedded audio 

Digital and Analog Audio 

Inputs/Outputs 
 Digital AES balanced audio connections 

 Analog balanced audio connections 

Internal Hard Drive 250 GB of storage, of which 32 GB is available for system 

processing and information, including schedule and log 
files, and 200 GB is partitioned for temporary digital video 

storage 

NOTE: To preserve the life span of your internal hard 

drive, primarily record and store your digital 
video on external USB hard drives and/or NAS 
storage devices. 

2 RS-232 Serial Interface 

“COM” Ports 

Control up to a 250x250, compatible external switcher 

and a Leitch CSD-5300 or ESE “Format A” or “Format D” 
master clock 
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FEATURE SPECIFICATIONS 

Ethernet Network Host 

Management 
 Network Support Interface: 

 Eight-position, eight-conductor RJ-45 modular jack, 

10/100/1000 BASE-T, unshielded twisted pair, 
Ethernet 

 Ethernet_II frame type 
 Protocol: TCP/IP 

 Services: Telnet 

 Remote system management via TCP/IP network 

 Digital media upload/download capabilities 

 Logging: internal 

Firmware Updateable via Ethernet 

WinLGX Software  Compatible with Windows® 2000/XP/Vista/7 operating 

systems 

 Standalone operation 

 Event capacity: 3000 

 Control modes: 

 Drag and drop event scheduling with error checking 

and conflict reporting 
 System control panel for immediate control 

 Library stores up to 2000 resources, including digital 

video files 

Web Interface  Connect to your E-HD2 server’s IP address with 

MICROSOFT® Internet Explorer 7 (or newer)  

 Password protected with user rights maintained from 
WinLGX 

 Obtain system status and digital storage drive 

information, configure and activate Virtual Channels, 
and view current schedule 

 Transfer digital video files to another E-HD2 or third 
party server (FTP capable) 
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DEVICE CONTROL OPTIONS 

FEATURE SPECIFICATIONS 

External, Scalable File 

Storage 

Configure file storage capacity with up to three external 

USB hard drives purchased from LEIGHTRONIX.  
LEIGHTRONIX formats each drive with a FAT32 file 

system and a digital video file directory. 

Each USB drive used with the E-HD2 must be:     

 Only used to store digital video files 

 Powered on until the E-HD2 is shut down from its 
front panel 

 Only removed or installed after the E-HD2 is shut 
down from its front panel.  Do not connect the 

drives to a PC for file management operations.  

The E-HD2 supports a total USB drive storage capacity 

of 4 TB. 

For more information on using USB drives with the E-

HD2, refer to www.leightronix.com or contact 
LEIGHTRONIX at (800) 243-5589. 

See “Digital Video Recorder Specifications,” on page 20, 
for information on the server’s digital video recording 
rates. 

Support for NAS 

Storage/Expanded 
Channel Capacity 

Included TOTAL SHARE option provides support for an 

additional 16 Terabytes of digital media storage.  TOTAL 
SHARE allows users to create a dedicated, high-speed 
network that supports a combination of up to four E-HD2 

units and up to four network attached storage (NAS) 
devices.  See 
http://www.leightronix.com/total_share_ehd2.php for 

more information. 

Support for Compatible 

External Routing Switcher 
or Master Clock 

Control up to a 250x250, compatible external switcher, 

Leitch CSD-5300, or an ESE “Format A” or “Format D” 
Master Clock 

ePRO-BUS Control NOTE: The ePRO-BUS feature is included with the E-

HD2. 

 Control up to 16 LABvault-HD digital video recorders 

by sending PRO-BUS commands over your Ethernet 
network 

 Provides two-function control (RECORD and STOP) 

 

http://www.leightronix.com/
http://www.leightronix.com/total_share_ehd2.php
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DIGITAL VIDEO RECORDER SPECIFICATIONS 

NOTE: Video being fed to the two HD/SD digital video players/recorders must have a 

stable signal.  

The maximum recorded file length allowed by the E-HD2 is 23 hours, 59 minutes, 
and 50 seconds.   

Digital video recording results are based on a combination of the user-defined record 
presets and the quality of the input source.   In each new E-HD2 image file, the record 

presets for the internal digital video players/recorders contain default settings under the 
names “Good,” “Better,” and “Best,” as shown in Illustration 1. 

Illustration 1, E-HD2 Default Recording Presets 
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You may use the default recording presets or change the presets based on your 
recording needs.  When selecting your recording presets, consider how video bit rate, 

video resolution, and audio quality settings will affect the quality and file size of your 
recordings (refer to the following sections for more information).  Once you have 
selected your recording presets, create short files for playback on your E-HD2 to test 

the quality of your presets. 

 Video Bit Rate 

The size and overall quality of your file is directly related to the selected video bit 
rates.  The H.264 High Profile video compression standard used by the E-HD2 for 

encoding allows you to create files with high quality video at lower bit rates.  Select 
either a constant bit rate (CBR) or variable bit rate (VBR) for your file recordings 
based on the following information.  Higher bit rates result in higher quality 

recordings, but keep in mind that your file sizes will be larger and you will be able to 
fit less video onto your storage devices.   

NOTE: Digital video recording does not improve the quality of your input sources.  
When recording a low quality source, use higher bit rate settings to record 
a digital file of equal quality.   

 Variable Bit Rate (VBR)  

When a VBR is used for recording, the E-HD2 records most of the source at the 

selected minimum bit rate.  WinLGX allows you to select a minimum bit rate 
between 1.50-10.00 Mb/s, at intervals of .10.  The poorest recording quality 

results at a minimum bit rate of 1.50 Mb/s and the best at 10.00 Mb/s. 

The video maximum bit rate does not impact file size.  The E-HD2 only records at 

the maximum bit rate when there is a lot of movement in the source and returns 
to the minimum bit rate when the movement decreases.  The maximum bit rate 
must be set at least 2 Mb/s above the minimum bit rate. 

 Constant Bit Rate (CBR) 

Use a constant bit rate (CBR) of 1.50 (lowest quality) to 8.00 (highest quality) 
Mb/s to record sources with little movement.   

 Video Resolution 

The picture quality of your recorded video also depends on the selected video 
resolution.  The following lists the available options: 

 Native: choose the “Native” video resolution setting to record a .m2t file at the 

resolution of the incoming video signal.  Resolutions supported by the E-HD2 are 
as follows: 

o 1920 x 1080 (1080i) 

o 1280 x 720 (720p) 

o 720 x 480 (480i) 

 1920 →1440: reduce the recorded file size for 1080i video signals by choosing 

the “1920 →1440” video resolution setting.  This setting is best for video with 
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lower levels of action.  The E-HD2 records the incoming HD 1920 x 1080i video 
signal at a resolution of 1440 x 1080i while preserving the 16:9 aspect ratio of the 

video in an anamorphic format.  When the E-HD2 plays the file, the video will be 
resampled and displayed in a widescreen 1920 x 1080i resolution.  

NOTE: If this setting is used to record a video signal of any resolution other 

than 1920 x 1080i, the signal will be recorded at its native resolution. 

 Audio Quality Settings 

 Audio bit rate: select 224 or 256 kb/s for sources with audio tracks or 192 kb/s for 

sources with little or no audio. 

 Audio sample rate: the 48k sample rate captures data from the audio signal 

48,000 times per second to ensure high quality audio recording.   
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E-HD2 FRONT PANEL 

Illustration 2, E-HD2 Front Panel 

 

KEYPAD 

The E-HD2 server has a six-button keypad for displaying system information, 
configuring network addresses, and turning the unit on/off.  The four E-HD2 arrow keys 

are used to display status information as well as for the entry of TCP/IP network 
addresses.  If you hold down an arrow key for more than one second, it begins to scroll 
through all of the available options.  Release the key when the desired option is 
displayed. 

The front panel keypad also turns the E-HD2 on/off.  Note that the E-HD2 automatically 

turns on when the unit is plugged in.  When held for four seconds, the red “X” button 
turns off the E-HD2.  If the E-HD2 has been turned off, press the green check push 
button for two seconds to turn the unit back on. 

DISPLAY 

After the E-HD2 has been booted up, press the up or down arrows on the server’s 
keypad to display the following status screens: 

 “COM 1” Serial Port Status 

If applicable, the bottom line of this screen displays the type and status of the 

external switcher or clock connected to your E-HD2 server (see Illustration 3, “COM 
1” Serial Port Status Screen). 

Illustration 3, “COM 1” Serial Port Status Screen 

06/13  10:42:37AM  

SW=Knox#1  Good 
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 Digital Video Playback Status 

The bottom line of this screen shows the playback status for each E-HD2 digital 
video player/recorder (see Illustration 4, Digital Video Playback Status Screen).  

When the E-HD2 is displaying a .m2t digital video file, the playback time is indicated 
on the bottom line of the screen along with the filename. 

Illustration 4, Digital Video Playback Status Screen 

 Digital Video Record Status 

The bottom line of this screen shows the recording status for each E-HD2 digital 

video player/recorder (see Illustration 5, Digital Video Record Status Screen).  When 
the E-HD2 is recording, the record time is indicated on the bottom line of the screen 
along with the filename.  

Illustration 5, Digital Video Record Status Screen 

 Schedule Status 

The bottom line of this screen displays the E-HD2 server’s schedule status (see 
Illustration 6, Schedule Status Screen).  If the schedule status screen shows 

“Active,” the last schedule sent to the E-HD2 is actively running.  If the status screen 
shows “Halted,” the schedule on the E-HD2 is currently not active. 

Illustration 6, Schedule Status Screen 

 Site ID 

The bottom line of this screen displays your site ID (see Illustration 7, Site ID Status 

Screen). 

Illustration 7, Site ID Status Screen 

06/13  10:42:37AM 

P1:0:01:07 filenme 

06/13  10:42:37AM 

Rec 1 Stopped 

06/13  10:42:37AM 

Schedule Active 
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 Bios Date 

The bottom line of this screen displays the date of bios on the E-HD2 motherboard 

(see Illustration 8, Bios Date Status Screen). 

Illustration 8, Bios Date Status Screen 

 Processor Temperature 

The bottom line of this screen displays the temperature of the E-HD2 processor (see 
Illustration 9, Processor Temperature Status Screen). 

Illustration 9, Processor Temperature Status Screen 

 PStat Firmware Version 

This screen is reserved for future use. 

 Firmware Date 

The bottom line of this screen displays the build date of the firmware currently 
loaded on your E-HD2 server (see Illustration 10, Firmware Date Status Screen). 

Illustration 10, Firmware Date Status Screen 

 Build Number 

06/13  10:42:37AM 

E-HD2  

06/13  10:42:37AM 

Bios: 03/14/07 

06/13  10:42:37AM 

Temp 22 OC 

06/13  10:42:37AM  

Fw Blt: 4/21/11 
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The bottom line of this screen displays the build date of the firmware currently 
loaded on your E-HD2 server (see Illustration 11, Build Number Status Screen). 

Illustration 11, Build Number Status Screen 

 Serial Number and Firmware Version 

The bottom line of this screen displays the serial and firmware version of your E-
HD2 server (see Illustration 12, Serial Number and Firmware Version Status 
Screen). 

Illustration 12, Serial Number and Firmware Version Status Screen 

 IP Address 

The bottom line of this screen displays your E-HD2’s IP address (see Illustration 13, 
IP Address Status Screen). 

Illustration 13, IP Address Status Screen 

 

06/13  10:42:37AM  

Bld Num: 143 

06/13  10:42:37AM  

0E0006 V4.28.37F 

06/13  10:42:37AM 

10.14.0.6 
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E-HD2 REAR PANEL 

The E-HD2’s rear panel layout includes, from left to right, top to bottom (see Illustration 

14, E-HD2 Rear Panel): 
Illustration 14, E-HD2 Rear Panel 

 A: “COM 1” communication port with 9-pin male RS-232 DTE connectors for 

use with a LEIGHTRONIX-compatible external switcher with an 
input/output capacity of 4x4 (minimum) to 250x250 (maximum), 
compatible, compatible master clock, or Host mode (factory testing) 

 B: 2 RJ-45 Ethernet jacks with corresponding LED indicators 

 Ethernet port (left): 10/100/1000 BASE-T 

 Ethernet port (right):  use with the included LEIGHTRONIX TOTAL 

SHARE network attached storage (NAS) option to increase both local 
digital media storage and overall digital playback/record channel 
capacity 

 C: 4 USB 2.0 ports 

 D: BNC video output connector for playback with HD/SD digital video 

Player/Recorder 1 

 E: BNC video input connector for recording with HD/SD digital video 

Player/Recorder 1 

 F: Audio output tension clamp terminal block for analog or AES digital audio 

playback on Channel 1 

 G: Audio input tension clamp terminal block for analog or AES digital audio 

recording on Channel 1 

 H: Audio input tension clamp terminal blocks for analog or AES digital audio 
recording on Channel 2 

 I: Audio output tension clamp terminal block for analog or AES digital audio 
playback on Channel 2 

 J: BNC video input connector for recording with HD/SD digital video 

Player/Recorder 2 

 K: BNC video output connector for playback with HD/SD digital video 

Player/Recorder 2 
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 L: “COM 2” communication mini-jack connector RS-232 port for use with a 

LEIGHTRONIX-compatible external switcher with an input/output capacity 
of 4x4 (minimum) to 250x250 (maximum), compatible master clock, or 
Host mode (factory testing); use included serial cable to convert into a 

DB9M port 

 M: Power cord connector 
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SERVER INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

Use this section for step-by-step instructions on connecting your E-HD2 system wiring, 
including devices and Ethernet.  This section also includes information on entering your 
TCP/IP and serial settings through the front panel.   

 

PACKING LIST 

Ensure your E-HD2 shipment box contains the following: 

 (1) E-HD2 High-Definition Video Server 

 (1) LEIGHTRONIX Product Resource Disc with WinLGX Network Management 
Software and Product Manual 

 (1) Part #10-0311, AC Power Cord, 6 ft. 

 (1) Part #10-4856, CAT 5e Ethernet Cable, 7 ft. 

 (1) COM 2 Serial Cable with Instruction Sheet 

 



E-HD2 

Server Installation & Configuration 

Page 30 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

CONNECTING E-HD2 SIGNAL WIRING  

Throughout the following instructions, refer to Illustration 14, E-HD2 Rear Panel. 

1. Rack mount your E-HD2 as follows, ensuring the ventilation holes on the side of the 

unit are not covered and adequate space is available behind the back panel for the 
USB drives. 

NOTE: LEIGHTRONIX recommends leaving empty rack mounts above and 
below an E-HD2.  The E-HD2 is not intended to have anything stacked 
on top of it. 

a. Insert the E-HD2 into the rack, aligning the holes of the server’s mounting 

bracket with those of the rack. 

b. Secure the E-HD2 to the rack with user-supplied rack screws.  

2. The E-HD2 has two RS-232 “COM” ports so you have the option to use an external 

switcher and master clock with your server.  If you are using both external devices, 
convert the “COM 2” mini-jack connector into a DB9M port with the included cable.  
Refer to the following for a list of master clocks and/or external switchers compatible 

with the E-HD2 as well as setup information: 

 Compatible External Switchers 

The E-HD2 is compatible with the external switchers listed in Table 1 and 

supports switcher input/output capacities of 4x4 (minimum) to 250x250 
(maximum).  Install your switcher according to the following steps: 

NOTE: Contact the routing switcher manufacturers listed below for help 

in selecting specific models. 

a. Connect the switcher to E-HD2’s “COM 1” port. 

b. Configure your switcher according to the corresponding parameters listed in 

Table 1, Supported External Switchers and Parameters. This is necessary to 
ensure your switcher works with the E-HD2. 

Table 1, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AUTOPATCH 9600 baud, 8N1 (Level 1: Video, Level 0: All) 

Creator 9600 baud, 8N1 

EXTRON A (most common) 9600 baud, 8N1 

EXTRON B (ISS series) 9600 baud, 8N1 

KNOX  9600 baud, 8N1 

KRAMER 9600 baud, 8N1 

LEIGHTRONIX PRO-16 or NET-164 9600 baud (PRO-16 min. ver. 1.09, 2.03; 
NET-164 min. ver. 1.00.42) 
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SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

LEITCH 9600 baud, 8N1 

PESA Serial 9600 baud, 8N2 

PESA P1N Network N/A 

SIERRA 9600 baud, 8N1 

SIGMA A 9600 baud, 8N1 

SIGMA B 9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 

c. Route the video/audio from any studio/satellite feeds, character generator, 
etc. to the switcher input connectors.   

d. Connect switcher output connectors to the desired destinations (such as 

modulators or television monitors). 

 Compatible External Master Clocks 

Connect any of the following to one of the E-HD2’s “COM” ports: 

NOTE: If you are also using an external switcher with your E-HD2, connect the 

master clock to the “COM 2” port. 

 LEITCH CDS-5300 Master Clock Driver 

 ESE Master Clock 

3. Connect playback destinations to the E-HD2’s HD/SD digital video outputs as 
follows: 

 Channel 1: connect the desired destination or switcher input to E-HD2 Video 
Output 1. 

 Channel 2: connect the desired destination or switcher input to E-HD2 Video 
Output 2. 

4. Connect video sources for recording to the E-HD2’s HD/SD digital video inputs as 

follows: 

 Channel 1: connect the desired video source or switcher output to E-HD2 
Video Output 1. 

 Channel 2: connect the desired video source or switcher output to E-HD2 
Video Output 2. 
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5. Your E-HD2 audio connections are determined by the type of audio signals you wish 

to record and play out, as described below: 

 Embedded Digital Audio: part of your digital video signal, no additional audio 
connections are needed to play or record this type of audio signal. 

 Non-Embedded Audio Signals: the E-HD2 supports two-channel analog and 
AES balanced digital audio signals.  The E-HD2 server comes equipped with four 

audio terminal blocks for playing/recording your non-embedded audio signals 
(see Illustration 15).  

Illustration 15, Audio Terminal Blocks on Rear Panel of E-HD2 Server 

 

 

 

 

To play/record any of the E-HD2’s supported, non-embedded audio signals, connect 
your audio signal wiring according to the following steps: 

NOTES:  The illustrations for the following examples show the terminal 

blocks in vertical positions.  When connected to the rear panel, the 
blocks are horizontal with the AES terminals on each block rotated 
toward its “SDI IN” BNC video input. 

  The E-HD2 supports an audio wiring gauge range of 18 (maximum) to 

28 (minimum) AWG. 

a. Prepare your audio wiring for connection to the terminal blocks by stripping 

approximately a 1/4 inch of shield off the end of each wire.  Twist each wire’s 
individual strands together to prevent separation. 

Illustration 16, Example of Wire Prepared for an E-HD2 Server Terminal Block 

 

Audio Output 
Terminal Block 1  

For Playback on 

Channel 1 

Audio Input  
Terminal Block 1  

For Recording on 

Channel 1 

Audio Output 
Terminal Block 2  

For Playback on 

Channel 2 

Shield Stripped from 

End of Wire 

Audio Input  
Terminal Block 2  

For Recording on 

Channel 2 
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b. Perform the following steps for each E-HD2 channel that you want to play and/or 
record non-embedded audio (refer to Illustration 15, Audio Terminal Blocks on 

Rear Panel of E-HD2 Server). 

i. With your fingers, gently grasp the desired terminal block on the E-HD2’s rear 

panel and pull to separate the block from the server.  

ii. Secure each of your prepared audio wires in their appropriate terminals as 

follows, referring to Table 2 for each wire’s placement on the terminal block: 

Table 2, Non-Embedded Audio Terminal Block Configurations 

AES  

Terminal Block Configuration 

Two-Channel Analog  

Terminal Block Configuration 

  

 
 

AES  

Terminal Block Configuration 

Two-Channel Analog  

Terminal Block Configuration 

Illustration 17, Example of AES Terminal 
Block Wiring 

 

Illustration 18, Example of Two-Channel 
Analog Terminal Block Wiring 

 

Terminals 

NOTE: The AES audio 

configuration uses 

only one of either 

common grounds. 
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(1) Using a slotted, pocket clip screwdriver with a maximum tip width of 
2.5mm and thickness of .4mm, open the terminal’s tension clamp by 

inserting the screwdriver tip into the clamp’s corresponding tension 
release slot (see Illustration 19 for an example).  Firmly push the 
screwdriver into the slot until the clamp in the bottom of the terminal 
slides open (see Illustration 20). 

Illustration 19, Tension Clamp Release Slot on an E-HD2 Server Terminal Block 

 
 

Illustration 20, Screwdriver Inserted into Tension Clamp Release Slot 

 

(2) Insert the audio wire into its corresponding terminal until it is touches the 
bottom. 

(3) While holding the wire in place, pull the screwdriver from the slot.  The 
wire should now be clamped into place and should not fall out of the 
terminal if gently tugged. 

(4) Repeat steps 5.b.ii(1)–(3) for each of the remaining terminals in your 
audio terminal block configuration. 

Terminal 

Tension Clamp 
Tension Clamp 

Release Slot 
(highlighted to 

illustrate) 
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iii. Push the wired terminal block back into its slot on the rear panel of the E-HD2 
server, with the AES terminals on the block rotated toward its channel’s BNC 

video input (“SDI In”).  The block only fits one way into its holder on the rear 
panel. 

6. Attach up to three, LEIGHTRONIX-approved USB hard drives to the USB ports.  The 
E-HD2 system can support up to 4 TB.  For more information on USB drives 

compatible with the E-HD2, refer to www.leightronix.com or contact LEIGHTRONIX 
at (800) 243-5589. 

NOTE: USB drives can be removed or installed only after the E-HD2 is shut 
down from its front panel.  Do not connect the drives to a PC for file 
management operations. 

7. Attach the included power cord to the power cord connector on the back of the E-

HD2, and then plug it into an AC power source.  

 
CAUTION 

LEIGHTRONIX strongly recommends the use of an 
Uninterruptible Power Supply (UPS) with the E-HD2 and 
associated USB drives.  Damage from power loss or spikes is not 

covered under warranty. 

8. Turn on the E-HD2 by holding down the front panel red x button for four seconds. 

NOTE: Do not remove power to the E-HD2 or associated USB drives before 
turning the E-HD2 off in the same manner.   

The E-HD2 will automatically boot up and display the boot up progress screens 
shown in Illustration 21, Boot Progress Screens.  During startup, any saved E-HD2 
settings and active schedule are implemented. 

Illustration 21, Boot Progress Screens 

 

 

9. Proceed to “Configuring Ethernet Network Host Management,” on page 37, to 

configure the E-HD2 for remote control through Ethernet network host management. 

Main Power ON 

Now Booting ... 

Starting Up ... 

 

http://www.leightronix.com/


E-HD2 

Server Installation & Configuration 

Page 36 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

  



E-HD2 

Server Installation & Configuration 

 

LEIGHTRONIX, INC. Page 37 

2018-05-18 WinLGX ver. 7.0.2.52 
 
 

CONFIGURING ETHERNET NETWORK HOST MANAGEMENT 

NOTES:  Your PC must have a Windows 2000/XP/Vista/7 operating system in 

order to run WinLGX software (see “WinLGX Minimum System 
Requirements,” on page 49 for further details). 

  Each E-HD2 system requires the following ports: 

 23 (Telnet) 
 21 (FTP Control Connection) 
 20 (FTP Data) 

 80 (HTTP – E-HD2 Web Interface) 
 2000 (UDP): needed for ePRO-BUS control  
 50001 (Web Program Guide): This port can be changed from the E-

HD2 front panel. 
  If you will be connecting to your E-HD2 system remotely, the following 

ways can be used to set up your router to access your E-HD2 system.  
Keep in mind that more than one method can be used, such as VPN for 
WinLGX access and port forwarding for program guide access.  Consult 

your network administrator and router manual before implementing any 
of the following methods. 

 The preferred method is using Virtual Private Networking (VPN) to 

gain access to the network from outside.  You would then run WinLGX 

and connect to the E-HD2 system as if you were local to it. 

 Another method is to use PC control software such as PCAnywhere® 

or GoToMyPC® to take control of the WinLGX PC from outside the 
network. 

 Ports 80 and/or 50001 only: use port forwarding in your firewall 
router to give public access to Ports 80 and/or 50001.  Public access 
to Port 50001 is required when you want to embed the E-HD2 

program guide on your own website (see “Viewing Program Guide 
from a Web Browser or Your Own Website,” on page 253).  Port 80 
should be made publically available when you want to access the E-

HD2 web interface from public IP addresses on the Internet.   

Port forwarding requires an external, public IP address which is 

configured in the router to have the desired ports forwarded to the E-
HD2 system’s internal IP Address. 

Do not use port forwarding to make the other ports for your E-HD2 
system remotely available, as it allows anyone to connect to your E-
HD2 system and then attempt to log in.  Some advanced routers can 

limit external connections to a certain address range, providing 
protection.    
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Each E-HD2 server is designed to interact with a host PC through a 10/100/1000 BASE-

T Ethernet TCP/IP Network.  Two of the most common connection scenarios are 
outlined below. 

NOTE: In order to share one external routing switcher between multiple E-HD2 
servers, your E-HD2 system and PC must be networked together. 

CONNECTING THE E-HD2 TO AN EXISTING ETHERNET NETWORK 

1. Obtain the following from your technical support personnel or network administrator 

and enter into the front panel of your E-HD2 system (see “Configuring Front Panel 
Settings,” on page 39): 

 IP address 

 Subnet mask 

 Gateway address 

2. Using a straight-through RJ-45 Ethernet cable, connect the E-HD2 system’s left 

Ethernet port (labeled “1”) to a 10/100/1000 BASE-T hub or switch on the TCP/IP 

network. 

3. Ensure the PC from which you wish to control your E-HD2 system has been 

configured and attached to the TCP/IP network. 

CONNECTING A E-HD2 SYSTEM DIRECTLY TO A PC VIA ETHERNET 

1. If necessary, install and configure a 10/100/1000 BASE-T Ethernet Network 

Interface Card (NIC) on the PC.  Refer to the NIC documentation and technical 
support for help in getting the NIC operational. 

2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows: 

a. Click on the Windows “Start” menu. 

b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on 

your keyboard to open the command.com window. 

c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your 

PC’s IP and subnet mask address. 

3. Enter the following IP and subnet mask addresses into the front panel of your E-HD2 

system (see “Configuring Front Panel Settings,” on page 39): 

 IP address: one number above your PC’s IP address (for example, if your PC’s 
IP address is 10.255.9.15, set your server’s IP address to 10.255.9.16) 

 Subnet mask: your PC’s subnet mask address 

4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the E-HD2 
system to the PC’s network interface card (NIC). 
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TURNING AN E-HD2 SYSTEM ON/OFF 

The front panel keypad also turns the E-HD2 on/off.  Note that the E-HD2 server 
automatically turns on when the unit is plugged in.  When held for four seconds, the red 

“X” button turns off the E-HD2 server.  If the E-HD2 server has been turned off, press 
the green check push button for two seconds to turn the unit back on. 

NOTE: Do not remove power to the E-HD2 system or connected storage devices 

before completing a front panel shutdown. 

CONFIGURING FRONT PANEL SETTINGS 

NOTE: All crucial configuration information, such as user information, schedule 
information, time, and network information are stored in battery backed 

memory or on the internal hard drive.  Thus the E-HD2 system configuration 
is protected in the instance of an extended power failure. 

ENTERING PASSWORD 

1. From the front panel of your E-HD2 server, press the right arrow key from any one of 

the status screens to display the password entry screen (see Illustration 22, 
Password Entry Screen).   

Illustration 22, Password Entry Screen 

2. Press five-key password.   

NOTE: The factory-default password is five right arrow keys.  To change the front 
panel password, refer to “Changing Front Panel Password,” on page 76. 

3. If the password entered is correct, the E-HD2 system’s configuration menu will be 

displayed (see Illustration 23, Configuration Menu Screen).   

Illustration 23, Configuration Menu Screen 

If an incorrect password is entered, the display returns to the status screens.  The 
configuration menu allows you to activate optional features and edit the following E-HD2 
system settings: 

 TCP/IP addresses: see “Editing TCP/IP Network Addresses,” on page 40 

Use arrows to 

enter pwd:***** 

CONFIG MENU 

Set XXXX                
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 Total Share network addresses: see “Editing TOTAL SHARE Network 

Addresses,” on page 42 

 Shared Switch: see “Editing Shared Switcher IP Address,” on page 44 

 FTP TCP buffer size: see “Editing FTP TCP Buffer Size,” on page 45 

 Web schedule port: see “Editing Web Schedule Port,” on page 45 

 Serial port usage: see “Selecting Serial Port Settings,” on page 46 

EDITING TCP/IP NETWORK ADDRESSES 

IP Address 

Obtain IP address from your technical support personnel or network administrator.   See 
Table 3, Editing IP Address from Front Panel, for editing instructions. 

NOTE: If you wish to use the ePRO-BUS option to control a LABvault-HD digital 
recorder, a static IP address is required for your E-HD2 server/controller. 

Table 3, Editing IP Address from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set IP Address.”  

2. Press “→” to select “Set IP Address.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any network 
address changes (press the red “X” button for four seconds to turn the unit off and then 

press the green check button for two seconds to return power). 

 

CONFIG MENU 

Set IP Address   

Enter IP Address 

0.  0.  0.   0  

Press ~ to  

confirm IP Addre_     
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Subnet Mask 

Obtain subnet mask address from your support personnel or network administrator.   
See Table 4, Editing Subnet Mask from Front Panel, for editing instructions.   

NOTE: If you are sharing one external routing switcher between multiple E-HD2 

servers, enter the same subnet mask into the front panel of each E-HD2 
system. 

Table 4, Editing Subnet Mask from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Subnet Mask.”  

2. Press “→” to select “Set Subnet Mask.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any network 
address changes (press the red “X” button for four seconds to turn the unit off and then 

press the green check button for two seconds to return power). 

 

Gateway Address 

Obtain gateway address from your technical support personnel or network 

administrator.  See Table 5, Editing Gateway Address from Front Panel, for editing 
instructions. 
NOTE: If you are sharing one external routing switcher between multiple E-HD2 

servers, enter the same gateway address into the front panel of each E-HD2 
system. 

Table 5, Editing Gateway Address from Front Panel 

GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Gateway Addr.”  

2. Press “→” to select “Set Gateway Addr.”  
 

CONFIG MENU 

Set Subnet Mask   

Enter Subnet Msk 

0.   0.   0.   0.  

Press ~ to 

confirm Subnt Ms            

CONFIG MENU 

Set Gateway Addr 
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GATEWAY ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any network 
address changes (press the red “X” button for four seconds to turn the unit off and then 
press the green check button for two seconds to return power). 

EDITING TOTAL SHARE NETWORK ADDRESSES 

The LEIGHTRONIX TOTAL SHARE networking option included with the E-HD2 digital 
video server allows users to increase both local digital media storage and overall digital 

playback/record channel capacity.  With TOTAL SHARE, you can create a dedicated, 
high-speed network that supports a combination of up to four E-HD2 units and up to 
four network attached storage (NAS) devices.   

For proper network operation, enter an IP address and subnet mask for your TOTAL 
SHARE network according to the following steps.  The TOTAL SHARE network 
addresses must be different from those used for the E-HD2 system control network. 

IP Address 2 

Obtain an IP address for your TOTAL SHARE network from your technical support 

personnel or network administrator.   The IP address for each E-HD2 and NAS device 
on your TOTAL SHARE network should begin with the same first two values (for ex., 
172.16.xxx.xxx).  See Table 3, Editing IP Address from Front Panel, for editing 
instructions. 

Table 6, Editing IP Address from Front Panel 

IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set IP Address2.”  

2. Press “→” to select “Set IP Address2.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

Enter Gateway 

0.  0.  0.   0        

Press ~ to  

confirm Gateway_        

CONFIG MENU 

Set IP Address2   

Enter IP Addr2 

0.  0.  0.   0  
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IP ADDRESS CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any network 
address changes (press the red “X” button for four seconds to turn the unit off and then 

press the green check button for two seconds to return power). 

 

Subnet Mask 2 

 Obtain a subnet mask address for your TOTAL SHARE network from your technical 
support personnel or network administrator.   See Table 4, Editing Subnet Mask from 
Front Panel, for editing instructions.   

Table 7, Editing Subnet Mask from Front Panel 

SUBNET MASK CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Subnet Mask.”  

2. Press “→” to select “Set Subnet Mask.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” to enter next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any network 
address changes (press the red “X” button for four seconds to turn the unit off and then 
press the green check button for two seconds to return power). 

 

Press ~ to  

confirm IP Addr2     

CONFIG MENU 

Set Subnet Mask2   

Enter SubntMsk2 

0.   0.   0.   0.  

Press ~ to 

confirm SubntMsk2            
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EDITING SHARED SWITCHER IP ADDRESS 

If you are sharing an external routing switcher between multiple E-HD2 systems, enter 
the IP address of the E-HD2 system connected directly to the switcher into the front 

panel of each additional E-HD2 system.  See Table 8, Editing Shared Switcher 
Configuration from Front Panel, for editing instructions. 

Table 8, Editing Shared Switcher Configuration from Front Panel 

SHARED SWITCH CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Shared SW IP.”  

2. Press “→” to select “Set Shared SW IP.”  
 

3. Press “→” or “←” to position the underscore 

under the editable fields and press “↑” or “↓” to 

edit the values. 

4. Press “→” past all of the editable fields to enter 

the next screen.   

 

5. Either press “→” again to save your changes or 

“←” to abort changes.  If you press “→” to 

accept the change, the E-HD2 server 

automatically performs a partial reboot and 

completes the change. 

 

CONFIG MENU 

Set Shared SW IP 

Enter Sh-Sw IP 

0.  0.  0.   0 

Press ~ to         

Confirm Sh-Sw IP   
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EDITING FTP TCP BUFFER SIZE 

The E-HD2 FTP buffer size setting helps to control the rate at which data is transferred 
to and from the E-HD2 system via WinLGX or third-party FTP software.  The buffer size 

setting defaults to 16 kilobytes, but may be adjusted down to 4 KB or up to 64 KB.  If 
your network equipment can handle a higher rate, edit the setting to 32 or 64 KB for 
faster transfer times.  See Table 9, Editing FTP Buffer Size from Front Panel, for editing 

instructions. 

Table 9, Editing FTP Buffer Size from Front Panel 

FTP BUFFER SIZE CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set FTP TCP Buf Size.”  

2. Press “→” to select “Set FTP TCP Buf Size.”  
 

3. Press “↑” or “↓” to edit the value. 

4. Press “→” to apply change and enter reboot 

message screen or “←” to abort.   
 

NOTE: The E-HD2 must be powered down and then powered back up to apply any FTP buffer size 
change (press the red “X” button for four seconds to turn the unit off and then press the 

green check button for two seconds to return power). 

 

EDITING WEB SCHEDULE PORT 

Each E-HD2 server uses Port 50001 as the default for the web program guide.  If you 
have already assigned this port number, select a different, unassigned port number for 

the web program guide.  See Table 10, Editing Web Schedule Port from Front Panel, for 
editing instructions. 

Table 10, Editing Web Schedule Port from Front Panel 

WEB SCHED PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Web Sch Port.”  

2. Press “→” to select “Set Web Sch Port.”  
 

3. Press “→” or “←” to position the underscore 

under the editable field and press “↑” or “↓” to 

edit the value. 

4. Press “→” to apply change and enter reboot 

message screen or “←” to abort.   

 

CONFIG MENU 

Set FTP TCP Buf Size 

TCP Buf size: 

16 kbytes        

CONFIG MENU 

Set Web Sch Port 

Set Web Sch Port 

50001 



E-HD2 

Server Installation & Configuration 

Page 46 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

WEB SCHED PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

NOTE: The E-HD2 must be powered down and then powered back up to apply any FTP buffer size 
change (press the red “X” button for four seconds to turn the unit off and then press the 

green check button for two seconds to return power). 

 

SELECTING SERIAL PORT SETTINGS 

See Table 11, Selecting Serial Port Settings from Front Panel, for editing instructions 
and Table 12, Serial Port Options, for a descriptive list of the different serial port options 
available for your E-HD2 server’s “COM” 1 and 2 ports. 

Table 11, Selecting Serial Port Settings from Front Panel 

SERIAL PORT CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Set Ser Port Use.”  

2. Press “→” to select “Set Ser Port Use.”  
 

3. Press “→” or “←” to move the underscore 

between the COM port fields and press “↑” or “↓” 

to change each field’s serial port setting. 

4. Press “→” to enter the next screen.   

 

NOTE: Refer to Table 12 for serial port selection 

options. 

5. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any serial port 
changes (press the red “X” button for four seconds to turn the unit off and then press the 

green check button for two seconds to return power). 

Table 12, Serial Port Options 

SERIAL PORT OPTION DESCRIPTION 

SWITCH Enables E-HD2 server to communicate with a compatible external 
switcher 

ESECLK Enables E-HD2 server to receive clock information from an ESE “Format 
A” or “Format D” Master Clock every second 

CSD-5300 Enables E-HD2 to receive clock information from a LEITCH CSD-5300 
Master Clock once an hour and whenever the E-HD2 is powered up 

HOST COM 2 only: enables serial host management for factory testing 

 

CONFIG MENU 

Set Ser Port Use 

COM1 COM2 

SWITCH   HOST

Right arrow to  

confirm config. 
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SHARING EXTERNAL TIME CLOCK WITH MULTIPLE E-HD2 SERVERS 

Up to ten E-HD2 servers can be synchronized to the clock time on one external master 
clock.  The E-HD2 servers that you wish to synchronize to the master clock’s time must 

be networked together by configuring each server with the same subnet mask address 
(see “Editing TCP/IP Network Addresses” on page 40).  If you have more than ten E-
HD2 servers, you can create up to nine additional groups consisting of ten E-HD2 

servers to one master clock per group, for a total of one hundred E-HD2 servers and ten 
master clocks. 

Connect your external master clock to the serial port on one of your E-HD2s and then 
configure the serial port for master clock usage (see “Selecting Serial Port Settings,” on 

page 46).  The E-HD2 connected to the master clock will broadcast the master clock’s 
time to all E-HD2 servers in its group. 

To configure each E-HD2 server for time synchronization, you will need to specify 
whether the server is sending or receiving the master clock time and enter the same 

group number into the front panel of each E-HD2 server in the group according to Table 
13, Editing “Time Settings” Options from Front Panel, for editing instructions. 

Table 13, Editing “Time Settings” Options from Front Panel 

TIME SETTING CONFIGURATION STEPS CORRESPONDING SCREEN DISPLAYS 

1. From the “CONFIG MENU” screen, press “↑” or 

“↓” to proceed to “Edit Time Settings.”  

2. Press “→” to select “Edit Time Settings.”  
 

3. Press “↑” or “↓” to change the “Time Mode” 

setting.  Select the “Server” option if the E-HD2 

is connected to your external master clock or 

“Client” if the E-HD2 is receiving master clock 

time from the connected E-HD2. 

4. Press “→” to edit the “Group” field.  

 

5. Press “↑” or “↓” to change the “Group #,” being 

certain to use the same group number for the E-

HD2s sharing the same master clock (maximum 

of ten E-HD2s per master clock). 

6. Either press “→” again to save your changes or 

“←” to abort changes. 

 

NOTE: The E-HD2 must be powered down and then powered back up to apply any time setting 
changes (press the red “X” button for four seconds to turn the unit off and then press the 

green check button for two seconds to return power). 

 

CONFIG MENU 

Edit Time Settings 

Time Mode   Group # 

Off        1 

Time Mode   Group # 

Server      1  
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SOFTWARE INSTALLATION & CONFIGURATION 

ABOUT THIS SECTION 

This section introduces the E-HD2 system management software, WinLGX, and 
provides instructions on how to enter the configuration settings necessary to control 

your E-HD2 through the software.  Your E-HD2 configuration properties define your 
switch type and digital video recording presets along with your system’s devices and 
media resources.  The configuration properties must be entered into the current image 

file before you can go on to creating a schedule of events (refer to the next section, 
“Software Operation,” on page 141, to learn how to create a schedule).  Each E-HD2 
image file holds your schedule events along with your system, device, and library 

resource properties.  To avoid reentering your configuration information every time 
you create a new schedule, save an image once you have entered the system, device, 
and library properties and before entering any schedule events.  Open and rename this 
saved image each time you wish to create a new schedule. 
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WINLGX MINIMUM SYSTEM REQUIREMENTS 

For the best results while operating WinLGX, LEIGHTRONIX recommends using a 16-
Bit color display adapter at 1024x768 plus the following, based on your operating 
system: 

NOTE: WinLGX does not have to be continuously running on your PC for standard E-

HD2 operation.   

Microsoft Windows 2000 (SP4) or XP Microsoft Windows Vista/7 

1.0 GHz or faster processor 1.6 GHz or faster processor 

512 MB of RAM (1 GB recommended) 1 GB of RAM (2 GB recommended) 
 

INSTALLING WINLGX SOFTWARE 

NOTE: The following steps were written for Windows 7 and 8 operating systems, and 
may vary for earlier versions. 

1. Place the LEIGHTRONIX Product Resource Disc in your DVD drive.  A web page 

should automatically load in your default web browser.   

If the web page does not load, perform the following steps: 

a. Open the Windows “My Computer” folder. 

b. Right click on your DVD drive and select “Click to display main menu.” 

2. From the LEIGHTRONIX web page, click the button for your E-HD2 server product.  

This will load a new page with content specifically for your system.   

3. From your E-HD2’s web page, click on the “WinLGX Software” link.  If the file does 
not automatically download, choose the save file option when prompted. 

4. Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on 

your computer. 

5. Right click the WinLGX installer and choose the run as administrator option to start 

the installation.  Follow the prompts to complete setup. 

6. As WinLGX installs, a succession of two additional installation windows will be 

displayed.  Refer to the following for a description of each window and installation 
guidelines: 

 Microsoft Visual C++ library window 

This window is used to install the Microsoft Visual C++ runtime components 
needed to run WinLGX on your computer or network.  Click the “Repair” button if 

you are using a version of WinLGX starting with 6 or less (for ex., WinLGX 
version 6.0.1.48).  If you are already running WinLGX 7 or greater, click the 
“Cancel” button on the bottom of the popup window. 
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NOTE: Choosing “Cancel” does not stop the WinLGX installation process, 
which will continue as a background operation.  

 VLC media player setup wizard  

VLC media player is necessary in order to use the WinLGX software preview and 
confidence monitor features (for more information on these features, see “Using 

Instant Video Preview Monitor to Display Digital Video Files within WinLGX” on 
page 155 and “Monitoring an MPEG File Recording” on page 220).  If you do not 
intend to use the WinLGX software monitor features, you may opt out of the VLC 

installation process by clicking the “Cancel” button on the bottom of the setup 
wizard.  If you choose to install VLC media player, but do not want the player to 
be automatically chosen for playback of your audio and other types of media files 

on your computer, deselect “Audio Files” and “Other” under the “File type 
associations” settings during installation. 

7. Click “Finish” to close the WinLGX setup wizard and return to Windows. 
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CHANGING WINLGX APPEARANCE (THEMES)  

WinLGX provides the option for changing the appearance or “theme” of its menu bars, 
tabs, and even the entire interface window.  To customize the WinLGX interface:  

NOTE: The “Skins and Themes” options are not available when you are connected 
to your E-HD2 server/controller. 

1. Go to the “View” drop down menu and select “Themes and Colors.”  

2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not 

already selected (see Illustration 24). 

Illustration 24, "Skins and Themes" Tab Window 

 

3. Click to choose a different interface, menu bar, and/or tab theme (see Illustration 

25). To return to the WinLGX default appearance, just select the "Default" button for 
each theme that was changed. 

Themes for 

WinLGX Tabs 

Themes for Entire 

WinLGX Interface 

Themes for 

WinLGX Menu Bars 
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Illustration 25, Example of Custom WinLGX Interface Theme 

 

4. Once you are finished with your changes, either click the “Done” button or the close 
icon in the upper right corner of the pop-up window. 
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ADDING / DELETING E-HD2 LOCATIONS IN THE SITE MANAGER 

Use the WinLGX “Site Manager” window to manage your E-HD2 server’s network IP 
address information.  WinLGX uses each server’s IP address to locate the server and 

send/receive the server’s system information.  Manage the IP address listing of your E-
HD2 as follows: 

ADDING E-HD2 IP ADDRESSES 

1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the 
main toolbar to open the “Controller Site Manager” window shown in Illustration 26. 

Illustration 26, “Controller Site Manager” Window 
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2. Click “Add” on the “Controller Site Manager” window (see Illustration 26) to open the 

“Add new controller” window shown in Illustration 27.  Complete the following fields: 

Illustration 27, “Add New” Window 

 

 “IP Address”: enter the IP address displayed on the E-HD2 server’s front panel.  

This address can be viewed from the front panel by pressing the up or down 
arrows until the IP Address is shown.   

NOTE: Do not enter 255.255.255.255 in the “IP Address” field. 

 Enter your user account name in the “User” field. 

 Enter your password in the “Password” field. 

NOTES:  Your username and password may only contain letters and 

numbers. 

 If you have not changed the username and password from the 
factory defaults, they are as follows: 

FACTORY-DEFAULT USERNAME AND PASSWORD FOR E-HD2  

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR E-HD2 SERVER’S SERIAL #   

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, 

serial number, and time zone displays in the “Add new” window. 
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NOTE: If this is the first time your E-HD2 server has been added to the site 
manager database, the following information will be displayed: 

 “Site ID”: name of the product 

 “Location”: “undefined” 

 “Serial Number”: your E-HD2 server’s serial number 

 “Time Zone”: your time zone 

Illustration 28, “Add New” Window 

 

4. Click “OK” to enter your E-HD2 server in the site manager database or “Cancel” to 
abort entry.   

5. If applicable, repeat steps 2–4 for each additional E-HD2 server in your system. 

DELETING E-HD2 IP ADDRESSES FROM SITE MANAGER 

Click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the 
“Controller Site Manager” window shown in Illustration 26.  Perform the following steps: 

1. Highlight the E-HD2 IP address you wish to delete. 

2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the E-HD2 

IP address from the site manager location.   

3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the 
database, or click “Cancel” to discard your changes. 
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CONNECTING TO YOUR E-HD2 SERVER 

Before you can start controlling your E-HD2 server(s), you must first connect to each of 
your E-HD2 servers.  This allows WinLGX to locate the server(s) you wish to operate 

and enables the software to send your settings and commands to each connected E-
HD2. 

1. Open the WinLGX “Site Manager” window (see Illustration 35) by performing one of 

the following:   

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 29, “Site Manager” Window 

 

2. Once the WinLGX “Site Manager” is open, you should see a list of your E-HD2 

systems.  If not, refer back to “Adding / Deleting E-HD2 Locations in the Site 
Manager,” on page 53. 

3. If desired, reorder your E-HD2 server listing.  Clicking on any column header in the 
“Site Manager” sorts the associated information in ascending order, while clicking 

the header again sorts the list in descending order. 

4. Connect as follows (see Illustration 35): 
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NOTE: The WinLGX title bar on the main window states whether or not you are 
connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 
holding down your keyboard “Ctrl” key and clicking each address with the left 

mouse button.     

b. Log in with the username and password given to you by the E-HD2 system 

administrator.  To simultaneously log into multiple servers, all of the selected IP 
addresses must have the same username and password. 

NOTE: Connect to multiple E-HD2 servers with different usernames and 
passwords by logging in separately to each controller. 

If the username and password have not been changed from the factory defaults, 
enter the following: 

E-HD2 FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR E-HD2 SYSTEM’S SERIAL 

# 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 
password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 

be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 
to a user. 

  The last six digits of your E-HD2 server’s serial number are 

viewable from the front panel (see “Configuring Front Panel 
Settings,” on page 39) and a sticker on the back of your E-HD2 
server. 

c. Click “Connect” or press “Enter” to connect to the chosen E-HD2 server(s) and 
close the login dialog box.  Once you are connected, a tab appears for each E-

HD2 server on the main window beneath the toolbar.  If you logged into more 
than one E-HD2 server, switch between the servers by clicking on the product 
tabs on the main window. 
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CREATING NEW E-HD2 IMAGE FILES 

Before you get started entering your system settings into WinLGX, create and save a E-
HD2 system image file.  E-HD2 system image files hold your system, device, and library 

resource properties as well as your schedule events.  E-HD2 image files have a .nmg 
file extension (for ex., schedule.nmg). 

NOTE: To open a saved E-HD2 image file, go to “Opening a Saved Image File,” on 
page 147. 

1. WinLGX automatically opens with an empty image file loaded.  If you need to clear 
any settings, select “New” under the “File” menu. 

2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 

30.”  

Illustration 30, “Save As” Window 

 

3. From the “Save in” drop down box at the top of the window, navigate to the folder 
where you want to save the E-HD2 image file.   

4. Type a name for the image in the “File name” field.   

5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as 
type” field. 
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6. Click “Save” to save the image under the entered name or “Cancel” to abort the 
“Save as.”   

7. As you enter your configuration settings according to the “Configuring WinLGX” 

section starting on page 60, periodically save your settings in your image file by 

selecting “Save” from the “File” menu or clicking the  toolbar button. 
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CONFIGURING WINLGX 

ABOUT THE MAIN WINDOW COMPONENTS 

Icons to run the WinLGX software are installed on the Windows desktop and in the 
“Start Menu\Programs\Leightronix, Inc.” folder.  Choosing either of these icons opens 

the WinLGX main window shown in Illustration 31. 

Illustration 31, WinLGX Main Window 

 
The components of the main window are as follows: 

 Product Tab(s): a tab appears for each login connection so that users with more 

than one E-HD2 server or other supported LEIGHTRONIX product can switch 
between product views in WinLGX.  Each product view is self-contained, allowing 

users to enter separate configuration and scheduling information for each 
LEIGHTRONIX product. 

 Channel Output Tabs: each tab corresponds to an output on either your E-
HD2’s rear panel or external switcher, depending on your system setup, and is 
selected in combination with a day tab to create a scheduling window 

 Day Tabs: each tab corresponds to a day of the week and is selected in 

combination with a channel output tab to create a scheduling window 
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 Schedule view tab: contains any scheduled events 

 Configuration folders window: contains the “System Configuration,” “Devices,” 

and “Library” folders 

 Resources window: displays the icons of the folder selected in the configuration 

folders window 

 Resource properties window:  displays the properties of the icon selected in 
the “Resources View” window 

 Title bar: displays the program name and connection status, as well as buttons 
for minimizing, restoring/maximizing, and closing WinLGX. 

 Menu bar: contains drop-down menus of WinLGX operations (see Illustration 32, 

Menu Bar and Table 14, Menu Bar Items). 

Illustration 32, Menu Bar 

 

Table 14, Menu Bar Items 

MENU ITEM FUNCTION 

“File” 

 

Click on this menu item to display the following options: 

 “New”: returns window to default settings and removes any user 
scheduling settings (see page 58) 

 “Open”: opens file selection window for selecting image files (see page 

147) 

 “Open as New”: opens file selection window to open an image file with a 

blank schedule (see page 148) 

 “Close”: disconnects WinLGX from E-HD2 server on currently selected 
product tab 

 “Close all”: disconnects WinLGX from all connected E-HD2 servers 

 “Save”: saves an E-HD2 image that was previously saved as a file or 
opens file window for saving an E-HD2 image under a user-specified 

name and folder (see page 151) 

 “Save as”: opens file window for saving an E-HD2 image under a user-

specified name and folder (see page 151) 

 “Send”: select to send an E-HD2 image with a schedule to the E-HD2 

server (see page 202) 

 “Send all”: sends currently open image files to their corresponding E-
HD2 servers with one click (see page 202) 

 “Receive”: select to receive image from the connected E-HD2 server 

(see page 149) 

 “Receive all”: downloads image files from each of the currently 

connected NEXUS series servers/controllers with one click (see page 
149) 
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MENU ITEM FUNCTION 

 “Get log”: select to obtain log file from the connected E-HD2 server (see 

page 228) 

 “Page setup”: opens window to configure schedule printout (see page 

81) 

 “Print setup”: opens window to configure the printer and paper settings 

(see page 82) 

 “Print”: click to select template and then print or export schedule (see 
page 203) 

 “Exit”: closes WinLGX program (see page 145) 

“Edit” Click on this menu item to display the following options (see 

“Scheduling/Editing/Deleting All Events,” starting on page 163): 

 “Edit”: use to edit an event in the schedule  

 “Edit switchback”: when an event or channel switchback is selected, 

option displays the “Channel Switchback Editor” window.  The 
switchback editor allows users to quickly change the inputs assigned to 

the channel switchbacks between programs (see page 200) 

 “Cut”: select to remove an event from a schedule and send to 

WinLGX’s clipboard 

 “Copy”: select to copy an event in the schedule to WinLGX’s clipboard 

 “Paste”: select to paste a copied event into the schedule 

 “Delete”: select to remove an event from a schedule 

 “Select All”: select all events on the selected channel and day/WinLGX-

LT tab configuration’s schedule event window  

“View”  Check the following options to display the corresponding toolbar, window, or 

schedule columns (see page 66): 

 “Schedule Columns”: displays a window that allows you to show and 

hide the schedule columns of your choice 

 “Status Bar”: allows you to hide/show the WinLGX status bar 

 “System Configuration”: allows you to show the “System Configuration 

View” window if it has been hidden 

 “Resource”: allows you to show the “Resource View” window if it has 

been hidden 

 “Properties”: allows you to show the “Properties” window if it has been 

hidden 

 “Reset views”: returns the “System Configuration View,” “Resource View,” 

and “Properties” windows to their default positions and sizes on the main 
window 

 “Themes and colors”: displays pop-up window with options for changing the 

WinLGX interface appearance (themes) as well as the schedule and control 
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MENU ITEM FUNCTION 

panel colors (see “Changing WinLGX Appearance (Themes),” on page 51 
and “Configuring WinLGX Interface Colors,” on page 71) 

“Tools” Click on this menu item to display the following options: 

 “Control Panel”: opens the control panel window for immediate control of 

digital video playback and recording as well as switching (see page 203) 

 “Controller”: opens window for configuring site information, setting clock, 

performing firmware updates, and rebooting (see page 77) 

 “Set front panel password”: opens window for setting front panel 

password (see page 76) 

 “Export/Print Templates”: opens window for creating templates that 
determine which schedule information is exported or printed (see page 

79) 

 “User defined data”: opens window for configuring user-defined schedule 

event columns (see page 83) 

 “Storage Manager”: opens window for managing digital videos (see page 

223) 

  “Site Manager”: opens window for adding or deleting E-HD2 system 

locations (see page 53) 

 “User accounts”: opens window for configuring user account settings 
(see page 73) 

 “Web Interface”: opens the E-HD2 web interface login prompt for the 
connected E-HD2 server IP address in your default web browser 

  “Total Backup”: not for use with E-HD2 servers 

 “System tools”:  

 “Switchback editor”: provides access to the “Channel Switchback 
Editor” window.  The switchback editor allows users to quickly 
change the inputs assigned to the channel switchbacks between 

programs (see page 200) 

 “Sync Library Resources”: checks E-HD2 image files for library 

resources and schedule events referencing digital video files no 
longer on the E-HD2’s storage device(s) (see page 200) 

 “Preferences”: opens window for configuring WinLGX main window 
components, including time format, sorting filter for library resource 

items, and display of schedule columns (see page 86) 
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MENU ITEM FUNCTION 

“Help”  “Leightronix Support Center”: opens the LEIGHTRONIX Support Center in 

your default web browser.  Support Center provides manuals, tutorials, and 
software and firmware updates for your E-HD2 server. 

 “WebEx”: opens the LEIGHTRONIX WebEx portal in your default web 
browser.  LEIGHTRONIX uses WebEx with customers for training and 
technical support. 

 Click on “About WinLGX” to display a window with the WinLGX version 

number (see “Displaying WinLGX Version Number,” on page 144). 

 Main Toolbar: contains icons for some of the most frequently used operations 
(see Illustration 33 and Table 15, Toolbar Items). 

Illustration 33, Main Toolbar 

 

Table 15, Toolbar Items 

TOOLBAR BUTTON FUNCTION 

 
Opens file selection window for selecting image files (see “Opening a 
Saved Image File” on page 147) 

 
Opens file selection window for opening an image file with a blank 
schedule (see “Opening an Image File as New,” on page 148)  

 

Saves an E-HD2 image that was previously saved as a file or opens 

file window for saving an E-HD2 image under a user-specified name 
and folder (see “Saving E-HD2 Image Files,” on page 151) 

 

Opens window for selecting preferences on WinLGX’s appearance 

and select operations (see “Setting WinLGX Viewing and 
Communication Preferences,” beginning on 86) 

 
Displays control panel window (see “Using Control Panel to Perform 

Immediate Device and Switch Actions,” beginning on page 206) 

 
Sends an image file to the connected E-HD2 server (see “Sending E-

HD2 Image Files,” on page 202) 

 

Receives image from the connected E-HD2 server (see “Receiving 
Image Files from the Connected E-HD2 Server(s)” beginning on page 

149) 

 

Checks E-HD2 image files for library resources and schedule events 
referencing digital video files no longer on the E-HD2 system’s 

storage device(s) (see “Checking Schedule and Library Resources for 
Missing Digital Video Files” on page 200) 

 Displays window for managing digital videos (see “Managing Storage 
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TOOLBAR BUTTON FUNCTION 

of Digital Video and Image Files,” on page 223) 

 

Obtains log file from the connected E-HD2 server (see “ 

Retrieving Log Files,” on page 228) 

 
Not for use with the E-HD2 servers 

 
Displays window for adding or deleting E-HD2 locations (see “Adding 

/ Deleting E-HD2 Locations in the Site Manager,” on page 53) 

 

Displays window for selecting an export/print template (see “Printing 
Schedules from WinLGX,” on page 203, and “Exporting Schedules 

into Comma Separated Values Files,” on page 204) 

 
Opens the E-HD2 web interface login screen in your default web 

browser 

 Displays a window with the WinLGX version number (see page 144) 
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CONFIGURING THE MAIN WINDOW COMPONENTS 

 Product Tabs: you can change the order of your product tabs.  Simply click on each 

tab with the left mouse button and then, while holding down the left mouse button, 
drag the tab into the desired position. 

 Close Icon: to remove a view window from the WinLGX interface, click the close icon 
on the window’s toolbar (see Illustration 34).  To display the window again, go to the 
“View” menu and select “Reset views.” 

Illustration 34, View Window Close Option 

 

 Hiding/Displaying Windows and Schedule Columns through the “View” Menu   

The “View” menu, shown in Illustration 35, may be used to hide or show the 
schedule column headings and status bar, as well as display hidden/closed 

“System Configuration,” “Resource,” and “Properties” windows.   

Illustration 35, “View” Menu 
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 To show/hide the WinLGX status bar, click on “Status Bar” in the “View” menu to 
hide it on the main window or uncheck item to display it.   

 To show hidden/closed “System Configuration,” “Resource,” or “Properties” 

windows, click on the desired window in the “View” menu to display it on the main  
window.   

 To return the “System Configuration,” “Resource,” and “Properties” view windows 
to their default positions on the main window, select “Reset views” in the “View” 
menu. 

 To show/hide schedule columns, click on “Schedule Columns” in the “View” 
menu or the “Schedule” tab under “Preferences” in the “Tools” menu (see 
“Setting WinLGX Viewing and Communication ,” on page 86).  Note that the “Day 

Tab Columns” listing corresponds to the columns on the schedule window’s day 
tabs and the “WinLGX-LT” listing corresponds to the columns in the schedule’s 
WinLGX-LT tab (see Illustration 36, Schedule Columns Selection Menu).  
Perform the following steps: 

Illustration 36, Schedule Columns Selection Menu 



E-HD2 

Software Installation & Configuration 

Page 68 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

 

1. Show/hide columns as follows: 

 Click to check column headings you want to show on the schedule 
window and uncheck columns you want to hide 

 Click the “All” button to display all of the columns on the 
corresponding schedule windows  

 Click the “None” button to remove all columns on the corresponding 

schedule windows  
2. When all selections have been made, click “OK” to display changes on 

schedule or “Cancel” to abort changes. 

 Moving Windows  

The “System Configuration,” “Resources,” and “Properties” windows may be 
moved to any location on the main window by clicking on the windows’ title bars 

and dragging the windows to the desired position on the WinLGX interface.  To 
re-dock the windows, click on the windows’ title bars and drag to the far right side 
of the main window. 
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 Rearranging Schedule Column Headings 

To rearrange the order of the schedule column headings, click on the desired 

heading and drag it over the heading you would like it to displace.  The displaced 
heading will shift to the left of the newly positioned heading. 

 Resizing Schedule Column Widths 

To resize a column heading, move the mouse pointer over the right-side border 

of the column you wish to resize.  When the pointer changes to the resize arrows 
symbol (see Illustration 37, Resizing Schedule Column), you may perform one of 
the following: 

Illustration 37, Resizing Schedule Column 

 

 Drag the column border to the desired width. 

 Double click to resize the column so it is only wide enough to accommodate 
the column’s largest field item. 

 Using Subfolders to Organize “Library” Folder Resources  

 Creating library subfolders 

1. Right click in the configuration folders window and select “New” in the 
right-click menu that appears. 

2. A new subfolder will be displayed under the “Library” folder.  To rename 
the subfolder, right click on its name and select “Rename” in the right-click 
menu that appears.  Enter a new folder name. 

Resize Arrows 

Symbol 
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 Adding existing library resources to subfolders 

Right click on a library resource icon and select “Move to” in the menu that 
appears to display the window shown in Illustration 38.  Display the “Library” 

folder’s subfolders by either clicking on the “+” next to the folder icon or 
checking the “Expand all” box. 

Illustration 38, "Select Destination Folder" Window 

 

 Adding new library resources to a subfolder 

Select the desired “Library” subfolder in the configuration folders window and 
create a new library resource in the “Resources View” window. 

 Deleting a library subfolder 

Right click on the desired library subfolder and select “Delete” in the menu 
that appears. 
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CONFIGURING WINLGX INTERFACE COLORS 

From the “View” drop down menu, select “Themes and Colors” to display the 

corresponding window.  Perform the following tasks from the window’s three color 
selection tabs.  Click “Done” on the bottom of the “Themes and Colors” window to save 
changes you have made in any of the tabs and close the window. 

Schedule Colors Tab 

Click the “Schedule Colors” tab and choose the text and background colors shown in 
Illustration 39 for the following elements on the “Schedule” view window:  

Illustration 39, “Schedule Colors” Tab 

 

 

 Event rows in the “Schedule” view 

 Selected events in the “Schedule” view 

 Channel switchbacks (SWB) 

 Filled channel switchbacks (SWB) 

 “Event Properties” window fields available for editing 

 “Event Properties” window fields not available for editing 

Colors of 
Alternating 

Events in 
“Schedule” View  

Colors of “Event 

Properties” Window 
Fields Available for 

Editing 

Colors of  

 “Event Properties” 
Window Fields Not 

Available for Editing 

Colors of Selected 
Events in “Schedule” 

View 

Colors Used to Highlight 
Schedule Events with 

MPEG Files Not in 
USB/NAS Storage 

Colors of Channel 

Switchbacks (SWB) 

Colors of Channel 

Switchbacks (SWB) 

Filled with “Playlist” 
Resources 

Colors of Filled 

Channel 
Switchbacks (SWB)  

Colors of 

“Playlist“ Library 
Resource Events  

These options do not 
apply to the E-HD2. 

Toggles the Schedule 

Grid Lines On/Off  
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 “Playlist” library resource events 

 Selected day and output channel tabs 

 Day and output channel tabs with and without schedule events 

 

Control Panel Colors Tab 

Click the “Control Panel Colors” tab (see Illustration 40) and choose the text and 
background colors for the E-HD2 control panel. 

Illustration 40, “Control Panel Colors” Tab Window 

 
 

Other Colors Tab 

This tab is not used for the E-HD2. 

Colors Shown on 

the “List” View 
Colors Shown 

on the 
“Buttons” View 
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SETTING USER ACCOUNT RIGHTS (INCLUDING WINLGX PASSWORD CHANGES) 

1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window 
(see Illustration 41).  

NOTE: This menu item will only become enabled upon login for users with 
“Administrator” rights. 

Illustration 41, “User Accounts” Window 

 

2. WinLGX and E-HD2 web interface user rights are described in Table 16, User 

Control and Configuration Rights (see page 75) and Table 17, User File Access 
Rights (see page 76).  Perform any of the following according to the steps below: 

 Add a user account 

 Edit a user account 

 Delete a user account 

NOTE: All functions controllable from the E-HD2 server’s front panel are only 
restricted by the front panel password. 

3. When finished configuring user information, exit the “User Accounts” window by 

clicking the “Close” button. 

 Add a user account 

a. Click “Add.” 

b. Enter new username and password. 

NOTES:  Logins are case sensitive. 
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  Your username and password may only contain letters and 
numbers. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking the 

corresponding user rights boxes.  To deselect a right, uncheck it by 
clicking on its box. 

d. Click “Ok” to send the new user settings to the E-HD2 server or “Cancel” to 
abort the addition. 

 Edit a user account 

NOTE: When editing the “admin” user account, only the password may be 
changed. 

a. Highlight the desired username and click “Edit.” 

b. If desired, change username and/or password. 

c. Select the user rights you want the user to be able to access as follows: 

 Click the “All” button to select all of the “Control and configuration” user 
rights. 

 Click the “None” button to deselect all of the “Control and configuration” 
user rights, except “System Status.” 

NOTE: The “System Status” right is automatically given to each user 
and may not be deselected. 

 Individually select the rights you want the user to possess by checking and 
unchecking the corresponding user rights boxes.  

d. Click “Ok” to send the new user settings to the E-HD2 server or “Cancel” to 
abort the edit. 

 Delete a user account 

a. Highlight the desired username and click “Delete.” 

b. In the dialog box that appears, click “Yes” to delete user or “No” to abort the 
change.  
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Table 16, User Control and Configuration Rights 

USER RIGHTS DESCRIPTIONS 

“Administrator (user 
accounts, firmware)” 

 WinLGX: allows user to change user account rights, front 

panel password, and volume names and perform firmware 
updates 

 Web Interface: allows user to perform Virtual Channel and 

program guide functions 

“Automatic slide 

authorization” 

Does not apply to the E-HD2  

“Device (play, 

rewind, stop)” 

Allows user to cause a device to play, rewind, or stop 

“Device (record)” Allows user to cause a device to record 

“MPEG/Slide 

control (play)” 

Allows user to play a digital video file from the WinLGX Control 

Panel; slide playback control does not apply to the E-HD2 

“MPEG/Slide 
control 

(record/setup)” 

Allows user to record digital video files from the WinLGX Control 
Panel; slide record control does not apply to the E-HD2  

“Schedule control” Allows user to stop or run a schedule  

“Site identity 

configuration” 

Allows user to edit the E-HD2 site name and location and reboot 

the server 

“Slide Administrator” Does not apply to the E-HD2 

“Switcher control” Allows user to perform switches from the WinLGX Control Panel 

“Switcher and serial 
configuration” 

Not used 

“System 

configuration 
(control/clock)” 

Allows user to set clock from the “Controller” window under the 

“Tools” menu 

“System status” This is a default right that allows all users to view the E-HD2 
server status from the WinLGX Control Panel 

“TCP/IP 

configuration” 

Allows user to set up the TCP/IP addresses 
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Table 17, User File Access Rights 

USER RIGHTS DESCRIPTIONS 

“No file access” WinLGX: user prevented from performing the following: 

 Sending and receiving E-HD2 image files 

 Opening the “Storage Manager” window (see “Managing 
Storage of Digital Video and Image Files,” on page 223, 
for more information on the “Storage Manager” window).   

 Accessing current log files 

“Receive only” WinLGX: user prevented from sending E-HD2 image files and 

moving/copying digital video files from one storage device to 
another  

“Send and receive” WinLGX: user allowed to send digital video files to E-HD2 

servers, but not image (schedule) files; user prevented from 
renaming and deleting files on the remote storage devices 

“Send, receive, 

rename and delete” 

WinLGX: user allowed to perform all software functions, including 

sending and receiving E-HD2 images (schedules) and renaming 
and deleting digital video files on the remote storage devices 

 
CHANGING FRONT PANEL PASSWORD 

1. Select “Set front panel password” in the “Tools” menu to open the window shown in 
Illustration 42. 

Illustration 42, “Set Front Panel Password” Window 

 

2. Click on a combination of five arrows for the new front panel password. 

3. Click “Set” to accept new password or “Clear” to cancel. 

4. Click “Done” to close the “Set Front Panel Password” window. 
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CONFIGURING SITE INFORMATION, CLOCK, UPDATING FIRMWARE, AND 
REBOOTING 

1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 43, 

“Controller” Window. 

Illustration 43, “Controller” Window 

 

2. Use the “Controller” window to set the following configuration maintenance settings.  
After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for 

confirmation to perform the action on the connected E-HD2 server.  Clicking “Yes” 
opens a box showing location name, action status, progress bar, and connection 
and action attempt counts.  An “action completed” box appears when finished.  If the 

action appears to be stalled or if you would like to interrupt the action, click the 
“Cancel” button. 
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 Site name 

Click on the “Site name” field and enter an alias into the field.  Click “Set” to make 

the change.  This name will appear on the server’s product tab on the main 
window. 

 Site location 

Click on the “Site location” field and enter the server’s location into the field.  
Click “Set” to make the change. 

 Time Zone 

Select the desired time zone from the list and click the “Set” button above the 
time zone field.  The list contains the standard Windows time zones for the 
United States.  If you would like the clock to automatically adjust for daylight 
savings time, check the corresponding box under the time zone field. 

 Clock 

Set your server’s clock using one of the following methods: 

 Use your PC’s time: click the “Set” button to the right of the “PC Current time” 
field.  WinLGX uses the PC time, PC time zone, and server time zone to set 

the time, adjusting the time to account for zones crossed.  All of these items 
need to be correct for the set time to be accurate. 

 Enter the date and/or time in the “User time” date and time fields.  Either type 
or use each field’s drop down menu to enter the new date and/or time and 
click the “Set” button. 

 Firmware Update 

To perform a firmware update, refer to “Updating E-HD2 Server,” on page 235. 

 Reboot   

To reboot the connected E-HD2 server, click the “Reboot” button. 

3. Click “Close” to close the “Controller” configuration window. 
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CREATING TEMPLATES FOR EXPORTING/PRINTING SCHEDULES 

Schedule templates allow you to determine what schedule information will be exported 
or printed.  Schedules can be exported into a comma separated values format and then 

printed (see “Exporting Schedules into Comma Separated Values Files,” on page 204) 
or printed directly from WinLGX (see “Printing Schedules from WinLGX,” on page 203). 

1. Create a schedule template per the following steps:  

a. Click “Export/Print templates” in the “Tools” menu to open the window shown in 
Illustration 44.  

Illustration 44, “Export/Print Templates” Window 

 

b. Select template display items as follows: 

NOTES:  The “Format” field is intended for future use and may only be set to 
“Report.” 

 Click “New” to clear all settings. 
` 

 Determine which event windows will be filtered for the schedule template:   

1. Check the boxes in “Day/LT” section to select the desired days (or LT). 

2. Check the boxes in the “Channel” section to select the channel outputs 
that should be included for the selected days.   

NOTE: The channel list varies depending on your system switcher 
configuration.   
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 Check the “Export/print switchbacks” checkbox to display channel 

switchbacks between programs.   

 Check “Export/print all records” to include all events in the selected event 

windows.   

NOTE: This function overrides any export or print values set to “No” in the 

device and library resource and event properties. 

 Add/remove schedule fields (columns) in template as follows: 

 Add a field to the “Used” list by double clicking a field item in the 

“Available” list or selecting it and clicking “>>.” The fields in the “Used” list 
will be printed/exported in the selection order listed.   

 To add a field in a specific order within the “Used” list, highlight the “Used” 

display item you would like to display the new field before.  Double click a 
field item in the “Available” list or select it and click “>>.” The new field is 
added above the selected field (select the blank field at the bottom to add 

a field to the end of the list). 
 Remove a “Used” field, by double clicking it or selecting it and clicking 

“<<.” 

c. Click “Save” to save the template to a file.   

2. To revise a template: 

a. Click “Export/Print Templates” in the “Tools” menu to open the window shown in 
Illustration 44, “Export/Print Templates” Window. 

b. Click “Load.”  In the “Select Export/Print Template” window that appears, browse 
for the desired template and open.  The filename will then appear in the 
“Template” box at the top of the “Export/Print Templates” window.   

3. Click “Done” when finished to close the “Export/Print Templates” window. 
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CONFIGURING PAGE LAYOUTS FOR SCHEDULES PRINTED FROM WINLGX 

The following steps allow you to determine the page layout of schedules printed directly 
from WinLGX.   

1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 45, 

“Page Setup” Window, and configure the schedule printout according to the following 
options: 

Illustration 45, “Page Setup” Window 

 

 “Print Header information” section: check the items you want to appear at the top 

of the printout.  “Program version” refers to the top two lines shown in Illustration 
46, Example of a Schedule Header. 

Illustration 46, Example of a Schedule Header 

WinLGX  Version 6.0.1.41                                                          Page 1 

Copyright © 2012,  LEIGHTRONIX, INC. 

Image Filename: EHD2.nmg 

Template Filename: nxs.xpt 

Today is: Mon Apr 02 13:02:33 2012 

  “Print Record information” section: check the items you want to appear above 
the schedule data.   

 “Field names” shows the column headers.   
 “Separator bar” inserts a line of dashes. 

 “Print Font” section: choose the font size and weight (normal/bold). 

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 
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CONFIGURING PRINTER AND PAPER SETTINGS FOR SCHEDULES PRINTED 
FROM WINLGX 

1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 47, 

“Print Setup” Window, which allows you to configure the printer and paper settings 
as follows:   

Illustration 47, “Print Setup” Window 

 

 “Printer” section: choose the desired printer from a list of your PC’s available 
printers.  When a printer is chosen, its status appears below the “Name” field.   

 “Properties” button”: click to open a window specific to the printer, so that 

detailed printer settings can be made. 

 “Paper” section: choose the size and source tray of the paper.   

 “Orientation” section: choose to print in portrait or landscape mode.  If your 
printing template has many fields (columns) chosen, you may want to print in 

“Landscape” mode to fit it all from left to right.  Print in “Portrait” mode if you don’t 
have many fields (columns) and want to fit more events on a page. 

 “Network” button: click to open a network printing window so that you can attach 

to and print to a network printer, if it is not already in the upper list.  

2. Click “OK” to save your settings or “Cancel” to close the window without saving. 
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CREATING CUSTOM SCHEDULE COLUMNS 

The 11 generic “Field Name” schedule columns allow you to categorize the events in 
your schedule.  Users may assign each of these columns a new heading along with a 
list of menu items that can be used to classify each event added to the schedule. Using 

the “User Defined Data” window, shown in Illustration 49, rename and add menu items 
to the desired field columns as follows: 

Illustration 48, Example of Schedule with User-Defined Fields 

 

1. Click “User defined data” under the “Tools” menu to open the window shown in 

Illustration 49. 

Illustration 49, “User Defined Data” Window 

 

User-Defined 

Column Headers 

User-Defined 

Field Items 
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2. Select the fields displayed on your schedule as follows: 

 To show all fields, ensure the “Show all field names” box is checked.  

 To hide all fields, ensure the “Show all field names” box is unchecked. 

 To hide one or more fields, uncheck the “Show” box next to the each field you 

would like to hide. 

3. Click on the field which you would like to rename.  In the “Edit Field Options” window 
that appears (see Illustration 50), perform the following: 

Illustration 50, “Edit Field Options” Window 

 

a. Enter a new schedule heading into the “Menu title” field. 

b. Add a list of menu items that will be used to define schedule events under the 

renamed column.  The number of menu items that may be added corresponds to 
the number of options shown over each section of field names on the window. 

 Add new menu items: click the “Add” button to display the “Add menu item” 
window (see Illustration 51).  Enter the desired menu item and click “OK” to 
add to the “Menu item” drop down list or “Cancel” to abort the change. 

Illustration 51, “Add Menu Item” Window 
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 Edit menu items: select the desired menu item from the drop down list and 

click the “Edit” button to display the “Edit menu item” window (see Illustration 
52).  Enter a new menu item and click “OK” to change the “Menu item” drop 
down list or “Cancel” to abort the change. 

Illustration 52, “Edit Menu Item” Window 

 

 Delete menu items: select the desired menu item from the drop down list and 
click the “Delete” button to display a confirmation window (see Illustration 53).  

Click “Yes” to change the “Menu item” drop down list or “No” to abort the 
change. 

Illustration 53, Menu Item Delete Confirmation Box 

 

4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the 
“Edit Field Options” window and return to the “User Defined Data” window.  

5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User 

Defined Data” window. 
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SETTING WINLGX VIEWING AND COMMUNICATION PREFERENCES 

In the “Tools” menu, choose “Preferences” to open the “Preferences” window.  Perform 
the following tasks from the window’s five tabs.  Click “OK” on the bottom of the 

“Preferences” window to save changes you have made in any of the tabs or “Cancel” to 
discard them. 

Application Tab 

Click the “Application” tab (see Illustration 54, “Application” Tab) and perform any of the 
following: 

Illustration 54, “Application” Tab 

 

 “Default controller type”: select a default controller type from the drop down 
menu.  When opened, WinLGX will automatically display the window settings for 

the selected controller type.  This allows you to create and save image files when 
you are not connected to your server. 
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 “Set schedule to current day on file load”: this preference causes WinLGX to 

select the current day tab when an E-HD2 image file is loaded 

 “Sync library resources when sending or receiving image”: when this option 
is selected, WinLGX automatically checks E-HD2 image files for library resources 

and schedule events referencing digital video files no longer on the E-HD2 
system’s storage device(s) (see “Checking Schedule and Library Resources for 
Missing Digital Video Files” on page 200 for more details).  The check is 

triggered when the WinLGX open, receive, and send image file operations are 
performed. 

 “How to indicate when a tab has data”: to highlight which of your day and 

channel output tabs contain schedule events, select either the “Asterisk” or 
“Parentheses” indicator options.  The default is “None.” 

 “24 hour time format”: select to change WinLGX to a 24 hour (military) time 
format.  If left unselected, WinLGX defaults to a 12 hour (A.M./P.M.) time format.   

NOTE: This does NOT change the time format on the front of your E-HD2 
server.  

 “Load image from controller after connect/login”: selecting this option 
causes the image file last sent to the server to be loaded after the user logs into 

WinLGX. 

 “Use passive FTP”: if your firewall is blocking your schedule and digital video 

files, check this option and then resend the files to your E-HD2 server.    

 “Hide event editor when dropping library objects”: if selected, an event 
properties window will not be displayed when a library item is dragged onto any 
of the schedule’s day tabs unless you are holding down the keyboard “Alt” key.  

 “Show WinLGX-LT tab in the schedule window”: select this box to display the 

corresponding tab at the bottom of the schedule window.  Refer to “WinLGX-LT 
Tab” in the “About Schedule Window Components” section on page 157 for more 
information on this tab. 

 “Default single slide length”: this option does not apply to the E-HD2 

 “Frame rounding threshold (frames)”: type or use the up/down arrows to set a 

rounding threshold from 5–29 frames (the default value is 5 frames).  This option 
allows you to control the playback duration of your digital video files based on the 
last milliseconds of video/audio frames (1 second of a .m2t digital video file = 30 

frames).  Once the threshold value is set, the digital video player will round the 
playback duration of any files with frames equal to or greater than the threshold 
up to the nearest second.  If the number of frames at the end of a file is less than 

the threshold value, the file’s playback duration will be trimmed down to the 
nearest second.   

 “Apply to all channel switchbacks”: when a digital library resource is dragged 

onto a channel switchback and the “Apply to all switchbacks” option is checked 
(see page 198 for more information on changing channel switchbacks), the 

following will occur based on which of the options below is selected: 
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 “By the day”: adds resources to channel switchbacks between scheduled 
program events on the selected channel output’s day tab 

 “By the week”: adds resources to channel switchbacks between scheduled 
program events on all of the selected channel output’s day tabs  

 “Default MPEG clip editor device”: use this option to either select a default 

MPEG player for clip editing (choose “MPEG Player 1” or “MPEG Player 2”) or to 
display a window allowing you to select an MPEG player at the start of each clip 

editing process (choose “Ask”).  If a default player is selected, WinLGX still 
allows you to switch to the other player at the start of clip editing. 

 “Default control panel switch layout (for 256 or fewer crosspoints)”: if you 
are using an external routing switcher that has a total of 256 or less input/output 
crosspoints (to obtain your total crosspoints, multiply your switcher’s inputs by its 

outputs), then you may choose to display your inputs/outputs on the WinLGX 
Control Panel as either “Buttons” or in a “List.”  Those with an external switcher 
having more than 256 crosspoints will automatically see their inputs/outputs in 

the “List” view on the Control Panel.  Refer to “EXTERNAL SWITCHER 
Configurations Only—Performing Forced Switches and Viewing Switcher Status” 
on page 208 for more details on both options. 

 “Total Backup application folder”: not for use with the E-HD2 

 Under “Log viewer,” click the button to the right of the log viewer field to select a 

software program for viewing your E-HD2 log files. 
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Event Editor Tab 

Each event properties window for a device or library resource item may be configured to 
show different fields under a “minimum” and “maximum” view.  During scheduling, you 

may toggle between these views by selecting and deselecting the “Maximum view” 
checkbox on the event properties dialog (refer to Illustration 55). 

Illustration 55, Example of Event Properties Window 

 
 

Maximum View 

Selected 
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To configure the field views for your device and library event properties windows, click 
the “Event Editor” tab (see Illustration 56, “Event Editor” Tab Window) and perform the 

following: 

Illustration 56, “Event Editor” Tab Window 

 

1. Under “Format type,” select the format of the device/library event properties window 

you would like to configure. 

2. Perform any of the following options: 

 “Restore defaults” button: click to return the selected format’s minimum and 
maximum views to the factory default settings. 

 “Minimum view” column 

 Click the desired boxes to select/deselect individual event property fields.  A 
checkmark indicates the corresponding field will appear in the minimum view 
for the event properties dialog. 
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 “All” button: click to show all fields within the minimum view for the event 
properties dialog.  

 “None” button: click to hide all fields within the minimum view for the event 
properties dialog. 

  “Maximum view” column 
 Click the desired boxes to select/deselect individual event property fields.  A 

checkmark indicates the corresponding field will appear in the maximum view 
for the event properties dialog. 

 “All” button: click to show all fields within the maximum view for the event 

properties dialog.  
 “None” button: click to hide all fields within the maximum view for the event 

properties dialog. 
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Preview Monitor Tab 

WinLGX includes preview monitor windows for displaying digital video files prior to 
scheduled or immediate playback and as files are recorded.  Set up and control the 
operation of these software monitors by clicking the “Preview Monitor” tab (see 

Illustration 57, “Preview Monitor” Tab) and performing any of the following: 

Illustration 57, “Preview Monitor” Tab 

 

 “Clip editor playback”: choose “Hardware monitor” to view your video clips 

on an external monitor attached to your E-HD2 during clip editing.  The 
“Software monitor” option (ability to view and edit clips with the WinLGX video 
clip editor) is not available for the E-HD2. 

 “Default hardware playback device”: use this option to either select a 
default MPEG player to display clips (choose “MPEG Player 1” or “MPEG 
Player 2”) or to display a window allowing you to select an MPEG player at 
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the start of each clip editing process (choose “Ask”).   

 “MPEG preview playback”: choose one of the following options for 

previewing your MPEG video library resources in the WinLGX instant video 
preview monitor: 

 “Context menu only”: video library resources may only be displayed in 

the instant video preview monitor by right clicking on a resource and 
choosing the “View resource” option.   

 “Double-click filename”: video library resources can be displayed in the 
instant video preview monitor by either double clicking a resource or by 

right clicking on a resource and choosing the “View resource” option. 

 “Remember screen size and position”: causes the WinLGX instant video 
preview monitors to display in the last place and size they were changed to  

 “Timecode display”: does not apply to the E-HD2. 

 “Forward and Reverse jump value”: does not apply to the E-HD2. 

 “Record playback delay”: specify how long (five to ninety seconds) after a 
recording begins before the resulting file will display on the WinLGX confidence 

monitor. 

 “Video driver interface”: leave this option set to “Auto-detect,” unless you find 
the WinLGX preview monitors will not display your digital videos.  In that case, try 

the other options until you find the one compatible with your computer’s video 
card. 

 “VLC Application Folder”: VLC media player must be installed on the computer 
running WinLGX if you wish to display digital videos in the WinLGX preview 

monitor windows.  If WinLGX states that it cannot find the VLC media player 
when you open a preview monitor window, first ensure that VLC player is 
installed on your computer.  If the VLC player is not installed, download the free 

program from the Internet.  Once installation has been verified or completed, find 
your computer’s file path for the folder containing the VLC executable file 
(“vlc.exe”).  Enter your file path into the “VLC Application Folder” field (for 

example, C:\Program Files\VideoLAN\VLC). 
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Resource Library Tab 

Click the “Resource Library” tab (see Illustration 58, "Resource Library" Tab) and check 
the “‘Show in program guide’” property to automatically populate the corresponding 
fields when creating digital video .m2t file playback library resources (go to page 126 for 

more information on creating digital video library resources).   

Illustration 58, "Resource Library" Tab 
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Resource View Tab 

Click the “Resource View” tab (see Illustration 59, “Resource View” Tab Window) and 
configure the icon sorting filter for your library resource items. 

Illustration 59, “Resource View” Tab Window 
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Schedule Tab 

Click the “Schedule” tab (see Illustration 60, “Schedule” Tab Window) and hide/display 
columns in the “Schedule” view.  Note that the “Day Tab Columns” listing corresponds 
to the columns in the schedule day tabs and the “WinLGX-LT” listing corresponds to the 

columns in the schedule WinLGX-LT tab.  Perform the following steps: 

Illustration 60, “Schedule” Tab Window 

 

1. Select the columns displayed on your schedule as follows: 

 To show all columns in the corresponding schedule tab, click the “All” button.  

 To hide all columns in the corresponding tab, click the “None” button. 

 To hide one or more columns in the corresponding tab, uncheck the boxes next 
to the columns you would like to hide. 

2. When all changes have been made, click “OK” to display changes on schedule or 
“Cancel” to abort changes. 
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CONFIGURING THE SWITCH TYPE OF AN E-HD2  

In order to control your system’s inputs and outputs from WinLGX, you will need to 
specify the switch type setup of your E-HD2 system.  Your switch type setup indicates 

whether your destinations and sources are directly wired to your E-HD2 server or 
connected through one of a wide range of compatible external switchers.     

Click on the “System Configuration” folder on the right side of the schedule editor 
window to display the E-HD2 “System Configuration” windows.  Click on the “Switch” 

icon and complete the “Properties” fields for the switch type that applies to your E-HD2 
system.  Each switch type and its properties are described in the following subsections: 

 “No Switch Configuration” on page 97 

 “External Switcher Configuration” on page 100 

 “Shared Switcher Configuration” on page 104 

NOTE: Input and output label, description, and icon assignments are optional. 

No Switch Configuration 

An E-HD2 server not connected to an external switcher is represented by the WinLGX 
“No Switch” type.  Refer to Illustration 61, No Switch Type Properties throughout the 
“Direct Connect Configuration” section. 

Illustration 61, No Switch Type Properties 
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 “Switch type”:  if not already selected, choose “No Switch.” 

 Channel Tab Assignments 

The E-HD2 has two digital video playback/record channels, which are represented 

by their playback and record functions on the channel tabs on the left side of the 
schedule window.  WinLGX automatically assigns playback on Player/Recorder 1 
(“Out 1”) to Channel 1, playback on Player/Recorder 2 (“Out 2”) to Channel 2, 

recording on Player/Recorder 1 to Channel 3, and recording on Player/Recorder 2 to 
Channel 4.   

NOTE: Each HD/SD digital video player/recorder can only operate as a player or 
recorder at one time.  

You have the option of changing the default channel tab assignments for Channels 
1–4 as follows: 

1. In the “Channel” field, select the channel number for the output you want to 
reassign.   

2. From the “Output” drop down menu, select “None.” 

3. Select a new channel from the “Channel” field drop down menu. 
4. Select the newly unassigned output from the “Output” drop down menu.  The 

change will be reflected by the channel output tabs on the schedule window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel tabs on your 

WinLGX schedule window.  From the “Channel” drop down box, select the channel 
tab you would like to hide and then select “No” from the “Visible” drop down box.  To 
display the tab, again select the channel and then choose “Yes” under “Visible.”  
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 Virtual Channel 

“Yes” enables both Virtual Channel video sources for use as switchback inputs in a 
schedule, while “No” disables the Virtual Channels feature for this purpose.   

NOTE: If enabled, you will only be able to schedule HD/SD digital video 
Player/Recorder 1 on the first WinLGX channel output tab and HD/SD 

digital video Player/Recorder 2 on the second channel output tab (see 
Illustration 62, Virtual Channel WinLGX Output Tab Assignments). 

Illustration 62, Virtual Channel WinLGX Output Tab Assignments 

 

 

The first channel output tab 

in WinLGX is tied to Virtual 

Channel 1. 

This is the second channel 

output tab, so it is tied to 

Virtual Channel 2. 
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External Switcher Configuration 

Refer to Illustration 63, External Switcher Properties, throughout the “External Switcher 
Configuration” section. 

Illustration 63, External Switcher Properties 

 

 “Switch type”:  select the choice that matches your external switcher and complete 
the following steps: 

 Non-LEIGHTRONIX external switchers only: enter the number of levels in the 
“Levels” field (video, audio left, audio right, etc.). 

NOTES:  Consult your switcher’s manual to determine how many levels 

should be assigned. 
  Pesa switchers automatically send level information to E-HD2 

servers. 
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 “Status rate (sec)” field: use to configure the interval at which the E-HD2 server 
polls the external switcher for output status information.  The range is 0 – 60 
seconds, where 0 means never poll.  The default is 2 seconds. 

 To ensure your switcher works with the E-HD2 server, set your switcher’s serial 
parameters according to Table 18, Supported External Switchers and 
Parameters (refer to your switcher’s manual for further instructions).    

Table 18, Supported External Switchers and Parameters 

SUPPORTED SWITCHER OPTIONS SWITCHER SERIAL PARAMETERS 

AUTOPATCH 9600 baud, 8N1 (Level 1: Video, Level 0: All) 

Creator 9600 baud, 8N1 

EXTRON A (most common) 9600 baud, 8N1 

EXTRON B (ISS series) 9600 baud, 8N1 

KNOX  9600 baud, 8N1 

KRAMER 9600 baud, 8N1 

LEIGHTRONIX PRO-16 or NET-164 9600 baud (PRO-16 min. ver. 1.09, 2.03; 
NET-164 min. ver. 1.00.42) 

LEITCH 9600 baud, 8N1 

PESA P1N Network N/A 

PESA Serial 9600 baud, 8N2 

SIERRA 9600 baud, 8N1 

SIGMA A 9600 baud, 8N1 

SIGMA B 9600 baud, 8N1 

UTAH A 38400 baud, 8N1 

UTAH B 1200 baud, 7E2 

UTAH Sandar 9600 baud, 7O1 
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 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 
descriptions: 

 
0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 

appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
input values into the “First” and “Last” input fields.     

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 
 

0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 

Panel output button, schedule editor window channel output tab, and the web 
program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 

appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 
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 Non-LEIGHTRONIX external switchers only: enter the switcher’s first and last 
output values. 

 “Switchback Input”: select one of your inputs as the video source you would like 

WinLGX to automatically switch to the selected output at the end of a scheduled 
event.  During scheduling, the switchback input may be changed in the event 
properties window. 

NOTES:  If you would like to use a “Virtual Channel” video source, ensure 
“Yes” has been selected in the “Virtual Channel” field. 

  The Virtual Channel video sources are tied to the first two 

WinLGX channel output tabs, with Virtual Channel 1 
corresponding to the first WinLGX channel output tab and Virtual 
Channel 2 on the second channel output tab (see Illustration 62, 
Virtual Channel WinLGX Output Tab Assignments). 

 Channel Output Tab Assignments 
An external switcher configuration can have up to 16 outputs represented by 

channel output tabs on the left side of the schedule window.  WinLGX automatically 
assigns Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows 
you to change the default channel-output assignments according to the following 

steps.  This is especially useful if you have a large switcher, as you can choose 
which 16 outputs that you’d like to automate for scheduling.   

NOTE: The two highest numbered channel output tabs automatically represent 

the record functions of both E-HD2 players/recorders.  You may 
reassign the E-HD2 record functions to any of your switcher’s available 
outputs.  

1. In the “Channel” field, select the channel number you would like to reassign to a 
different output. 

2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu 

 Associate one of Outputs 1–16 with the channel by first unassigning the 
output according to the steps below: 

a. In the “Channel” field, select the channel number for the output you want to 
reassign.   

b. From the “Output” drop down menu, select “None.” 

c. In the “Channel” field, select the channel number you would like to reassign 
to the output. 

d. Select the newly unassigned output from the “Output” drop down menu.  

The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 
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channel tab you would like to hide and then select “No” from the “Visible” drop down 
box.  To display the tab, again select the channel and then choose “Yes” under 

“Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel video sources for use as switchback inputs in a 
schedule, while “No” disables the Virtual Channels feature for this purpose.   

NOTE: To use the Virtual Channel feature during scheduling, you will need to 
configure and schedule your E-HD2 system’s HD/SD digital video 
Players/Recorders 1 and 2 on the first two WinLGX channel output tabs 
(see Illustration 62, Virtual Channel WinLGX Output Tab Assignments). 

Shared Switcher Configuration 

The “Shared Switch” type allows users to share one external routing switcher between 
multiple E-HD2 servers.  Use the following steps to configure each E-HD2 server not 
directly connected to the external switcher it is sharing (refer to Illustration 64, Shared 

Switcher Properties, throughout this section).  Follow the “External Switcher 
Configuration” section on page 100 to configure the E-HD2 server directly connected to 
the external switcher.  

Illustration 64, Shared Switcher Properties 

 

 Switch Type: select “Shared Switch” from the switch type drop down menu.  WinLGX 

treats the “Shared SW” switch type as an external switcher.  Complete the following 
properties: 
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 “Levels”: ignore, as WinLGX does not use this setting for the shared switch type 

 “Status rate (sec)”: set to specify how often the E-HD2 server polls the E-HD2 
server directly connected to the routing switcher for switcher status information.  

The range is 0 – 60 seconds, with the default set to 2 seconds.  Do not select 0, 
as this means never poll.  

 Input Settings 

In the “Input” field, select an input (the number of available inputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 
 

0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 

 

 “Label”: type the label you would like to appear on the corresponding Control 
Panel input button (up to 10 characters total—the number of characters that fit 
will depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 

appear when your mouse cursor moves over the corresponding Control Panel 
input button. 

 “Icon”:  select an icon to represent the selected input in the Control Panel 
window. 

 “First” and “Last” input fields: to allow access to all inputs connected to the 
routing switcher, enter the switcher’s first and last input values.  If you would like 

the E-HD2 server to only control a dedicated range of inputs on the shared 
routing switcher, enter the first and last input values for the dedicated range.  
Dedicating a range of inputs would limit the programming the E-HD2 server could 
display and record.  

 Output Settings 

In the “Output” field, select an output (the number of available outputs matches the 
capabilities of the switch type selected) and complete the following settings: 

NOTE: Any combination of the following characters may be used for labels and 

descriptions: 
 

0 1 2 3 4 5 6 7 8 9 

/ # $ ‘ ( ) * - . : < > [ ] _ { | } 

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z 

a b c d e f g h i j k l m n o p q r s t u v w x y z 
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 “Label”: type the label you would like to appear on the corresponding Control 
Panel output button, schedule editor window channel output tab, and the web 

program guide (up to 10 characters total—the number of characters that fit will 
depend on the case and characters you choose). 

 “Description”: type the description (up to 32 characters total) you would like to 
appear when your mouse cursor moves over the corresponding Control Panel 
output icon and schedule editor window channel output tab. 

 “Icon”:  select an icon to represent the selected output in the Control Panel 
window. 

 “First” and “Last” output fields: to allow access to all outputs connected to the 
routing switcher, enter the switcher’s first and last output values.  If you would 

like the E-HD2 server to only be able to access a dedicated range of outputs on 
the shared routing switcher, enter the first and last output values for the 
dedicated range. 

 “Switchback Input”: select one of your inputs as the video source you would like 

WinLGX to automatically switch to the selected output at the end of a scheduled 
event.  During scheduling, the switchback input may be changed in the event 
properties window. 

NOTES:  If you would like to use a “Virtual Channel” video source, ensure 
“Yes” has been selected in the “Virtual Channel” field. 

  The Virtual Channel video sources are tied to the first two 
WinLGX channel output tabs, with Virtual Channel 1 

corresponding to the first WinLGX channel output tab and Virtual 
Channel 2 on the second channel output tab (see Illustration 62, 
Virtual Channel WinLGX Output Tab Assignments). 

 Channel Output Assignments  

An external routing switcher can have up to 16 outputs represented by channel 

output tabs on the left side of the schedule window.  WinLGX automatically assigns 
Output 1 to Channel 1, Output 2 to Channel 2, and so on.  WinLGX allows you to 
change the default channel-output assignments according to the following steps.  

This is especially useful if you have a large switcher, as you can choose which 16 
outputs that you’d like to automate for scheduling. 

NOTE: The two highest numbered channel output tabs automatically represent 
the record functions of both E-HD2 players/recorders.  You may 

reassign the E-HD2 record functions to any of your switcher’s available 
outputs.  

1. In the “Channel” field, select the channel number you would like to reassign to a 
different output. 

2. Perform one of the following: 

 Select Output 17 or higher from the “Output” drop down menu. 

 Associate one of Outputs 1–16 with the channel by first unassigning the 
output according to the steps below: 
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a. In the “Channel” field, select the channel number for the output you want 
to reassign.   

b. From the “Output” drop down menu, select “None.” 
c. In the “Channel” field, select the channel number you would like to 

reassign to the output. 

d. Select the newly unassigned output from the “Output” drop down menu.  
The change will be reflected by the channel output tabs on the schedule 
window. 

 Hide/Show Channel Output Tabs on Schedule Window 

The “Visible” field under “Channel” gives you the option to hide channel output tabs 
on your WinLGX schedule window.  From the “Channel” drop down box, select the 
channel tab you would like to hide and then select “No” from the “Visible” drop down 

box.  To display the tab, again select the channel and then choose “Yes” under 
“Visible.” 

 Virtual Channel 

“Yes” enables both Virtual Channel video sources for use as switchback inputs in a 
schedule, while “No” disables the Virtual Channels feature for this purpose.   

NOTE: To use the Virtual Channel feature during scheduling, you will need to 
configure and schedule your E-HD2 system’s HD/SD digital video 

Players/Recorders 1 and 2 on the first two WinLGX channel output tabs 
(see Illustration 62, Virtual Channel WinLGX Output Tab Assignments). 



E-HD2 

Software Installation & Configuration 

Page 108 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

CONFIGURING DIGITAL VIDEO RECORDING PRESETS 

Click on the “System Configuration” folder on the right side of the schedule editor 
window to display the E-HD2 “System Configuration View” windows.  Click on the 

“Internal MPEG Record” icon and complete the “Properties” fields for each record preset 
according to the following steps (see Illustration 65, E-HD2 Record Preset Fields).  For 
more information on recording a broadcast-quality MPEG file, refer to “Digital Video 
Recorder Specifications,” on page 20. 

Illustration 65, E-HD2 Record Preset Fields 
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 “Record Preset x”: if desired, click in the field and enter a new name for the preset. 

 “Video resolution”: select one of the following: 

 “Native”: records files at the incoming video signal’s resolution 

 “1920 -> 1440”: records an incoming video signal with a resolution of 1920 x 
1080i at a video resolution of 1440 x 1080i.  If this setting is used to record a 
video signal of any resolution other than 1920 x 1080i, the signal will be recorded 

at its native resolution. 

 “Bitrate type”: select “CBR” for constant bit rate or “VBR” for variable bit rate. 

 If you selected “VBR,” the “Min video bitrate” and “Max video bitrate” fields will be 

displayed: click on the fields and use the up/down arrows to set your minimum 
and maximum video bitrates.  WinLGX requires that an increment of two be left 
between the bit rates.  Select a minimum of at least 1.50 Mb/sec and a maximum 

of up to 10.00 Mb/sec 

 If you selected “CBR,” the “Video bitrate” field will be displayed.  Click on the field 

and use the up/down arrows to set the video bit rates to a minimum of at least 
1.50 Mb/sec and a maximum of up to 8.00 Mb/sec 

 “Record audio source”: from the “Record audio source” drop down, select the type of 
embedded or non-embedded (“Analog” or “AES”) audio signal your system is setup 

to record.  
o “Analog”: corresponds to the analog audio inputs on the E-HD2’s back panel 

terminal blocks  

o “AES”: corresponds to the AES audio inputs on the E-HD2’s back panel 
terminal blocks  

o “Embedded 1-2”, “Embedded 3-4,” “Embedded 5-6,” and “Embedded 7-8”: if 
your audio is embedded within the incoming video signal, select the 

embedded audio channel pair that you want to record 

 “Audio bitrate”: select 192, 224, or 256 kb/sec from the drop down list 

 “Audio sample rate”: fixed at 48 kHz 
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EDITING INTERNAL DIGITAL VIDEO PLAYBACK AND RECORDING DEVICE 
RESOURCES 

The E-HD2 contains two digital video play/record channels, which are each represented 

in the WinLGX “Resource View” window as separate player and recorder device icons 
(see Illustration 66, “Devices” Window).  The following steps describe how to change 
the optional settings for the E-HD2 server’s built-in play/record devices:  

NOTE: Each E-HD2 digital video channel does not provide simultaneous playback 
and recording.  However, one of the channels may be used for playback while 
the other is recording. 

1. Click on the “Devices” folder on the right side of the schedule editor window to 

display the “Devices” window (refer to Illustration 66, “Devices” Window). 

Illustration 66, “Devices” Window  

 

2. In the “Resource View,” click on the desired device icon to reveal the corresponding 
properties fields.  
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Digital Video Players 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: under “Input,” choose the external switcher 
input connected to the selected digital video player’s output on the rear panel of your 

E-HD2.  Output 1 on the rear panel of each E-HD2 server is tied to playback on 
HD/SD Digital Video Player/Recorder 1, while Output 2 is assigned to playback on 
HD/SD Digital Video Player/Recorder 2.  Selecting an input number removes it from 
the input list. 

 “Assigned Channel/Output”: the function of this property depends on whether or not 
the “Virtual Channel” feature has been enabled in the “Switcher Configuration” 

properties (see “Configuring the Switch Type of an E-HD2,” on page 97 for more 
details).  The following outlines both scenarios: 

 Virtual Channel Feature Enabled: select the output you would like to display 
playback from each E-HD2 digital video player/recorder from the “Assigned 

Channel/Output” drop down menu. 

 Virtual Channel Feature Disabled: you may assign a channel output to each E-

HD2 digital video player/recorder to automate device selection for digital video 
library resources during scheduling.  Whenever a digital video library resource is 
dragged onto the selected HD/SD player/recorder’s assigned channel/output, the 

player will automatically appear in the library resource’s “Device” field. 

 “Setup time”: if desired, indicate how long after the selected player receives a PLAY 
command that picture and/or sound is produced. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties  

window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 
comma separated values format.  If “No” is selected, then you can enable the export 
function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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Digital Video Recorders 

 “Title”: if desired, click on “Title” field and enter new alias. 

 “Icon”: if desired, click on the “Icon” field button and select a new icon to represent 
the selected player or recorder. 

 External switcher configurations only: select a “Record Channel” that 
corresponds to the external switcher output connected to Input 1 on the rear panel of 

the E-HD2 server (see Illustration 67, E-HD2 Record Channel Output Tab 
Configuration). 

NOTE: WinLGX automatically completes this field for HD/SD digital video 
Player/Recorder 1 with the output assigned to the second highest 

numbered channel under “System Configuration,” while HD/SD digital 
video Player/Recorder 2 is auto-assigned to the highest numbered 
channel. 

Illustration 67, E-HD2 Record Channel Output Tab Configuration 

 

 “Video Quality”: if desired, select a digital video recording quality mode for your 
recording events.  This mode may be changed for each recording event action—see 
“Internal Digital Video Recorder Device Resources,” starting on page 179, for more 
details.  
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 “Record overwrite”: if desired, select one of the following: 

 “Always”: prompts WinLGX to automatically record over an existing file with the 
same name.  

 “Create unique”: if an existing filename is entered, WinLGX automatically records 
the file under the first 14 characters of the original filename followed by 
“yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as year/month/ 
day and hh/mm/ss is the file record time in hours/minutes/seconds).   

The “Record overwrite” option may be changed for each recording event action—
see “Internal Digital Video Recorder Device Resources,” starting on page 179, for 
more details. 

 “Print”: select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

1. Individual event records: select “Yes” in the “Print” field of each event properties  
window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 

 “Export”: select “Yes” to allow all of the resource’s event records to be exported into 

a comma separated values  format.  If “No” is selected, then you can enable the 
export function as follows: 

1. Individual event records: select “Yes” in the “Export” field of each event 
properties window that appears during scheduling of the resource. 

2. All of the resource’s event records: check the “Export/print all records” option 
under the “Export/Print Templates” window. 
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CREATING EXTERNAL SWITCH DEVICE RESOURCES 

NOTE: This section only applies to those using an external switcher with their 
E-HD2 server. 

A device resource must be created for each external switch device attached to the 

external switcher connected to your E-HD2 server.  Creating a device causes a new set 
of user-configurable information fields to be displayed in the “Properties” window.  The 
E-HD2 system uses this information to identify your external device.  Create external 
switch device resources as follows: 

1. Click on the “Devices” folder on the right side of the schedule editor window to 
display the “Devices View” window (refer to Illustration 68, New Switch Device 
Properties). 

Illustration 68, New Switch Device Properties  

 

2. Right click in the “Resource View” window and select “New” to display the device 

type menu.  Select the “SWITCH” device type to add a new device to the window 
(see Illustration 68, New Switch Device Properties). 

3. Complete the switch device “Properties” field shown in Illustration 69, Switch Event 
Properties Window.  Refer to Table 19, Switch Event Properties, for a description of 

the editable switch resource properties. 
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Illustration 69, Switch Event Properties Window 

 

Table 19, Switch Event Properties 

FIELD DESCRIPTION 

Title Allows a name of up to 31 characters to be entered. 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 
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FIELD DESCRIPTION 

Input Choose the switcher input number to which the device is connected.  If the 

device is not connected to a switcher input, select “<None>.”  Assigning an 
input to a device removes the input number from the input list.     

Preferred 
Playback 

Channel/Output 

You may assign a channel output to your device to automate device 
selection for same-type library resources during scheduling.  Whenever a 

library resource of the same format is dragged onto this device’s preferred 
playback channel, this device will automatically appear in the library 
resource’s “Device” field.   

Interface “Switch (SW)” is automatically assigned. 

Device The device numbers for switch resources are automatically assigned. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
a comma separated values format.  If “No” is selected, then you can 

enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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CREATING EPRO-BUS-CONTROLLED DEVICE RESOURCES 

The E-HD2 ePRO-BUS control feature uses your Ethernet network rather than 
additional wiring to send start/stop RECORD commands to up to 16 remote or locally 

connected LABvault-HD digital video recorders.  To use, create an ePRO-BUS resource 
for each LABvault-HD digital video recorder that will be receiving ePRO-BUS control 
commands from your E-HD2 system.  Create and configure ePRO-BUS-controlled 

resources as follows: 

NOTE: Ensure that you have assigned each LABvault-HD recorder’s IP address to an 

ePRO-BUS address number in the E-HD2 web interface (see the “Configuring 
ePRO-BUS Settings” section on page 274 for more details). 

1. Click on the “Devices” folder on the right side of the schedule editor window to 
display the “Devices View” window (refer to Illustration 68, New Switch Device 

Properties). 

Illustration 70, New Device Properties  

 

2. Right click in the “Resource View” window and select “New” to display the device 
type menu.  Select either the “DVD” or “Tape” device type to add a new device 

resource to the window (see Illustration 70, New Device Properties). 
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3. Complete the properties fields shown in Illustration 71, ePRO-BUS Resource 
Properties Window according to Table 20, ePRO-BUS Resource Properties. 

Illustration 71, ePRO-BUS Resource Properties Window 

 

Table 20, ePRO-BUS Resource Properties 

FIELD DESCRIPTION 

Title Enter a name of up to 31 characters. 

Format Leave at the default setting 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and clicking 
the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Input External switcher configurations only: select “<None>,” as the device is not 
connected to a switcher input.      
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FIELD DESCRIPTION 

Preferred 

Channel/ 
Output 

External switcher configurations only: select “<None>.” 

Interface Select “PRO-BUS (PB)” for the method being used to control the device. 

Device Select the PRO-BUS address number that was chosen for the LABvault-HD 

device in the E-HD2 web interface ePRO-BUS configuration window (see 
the “Configuring ePRO-BUS Settings” section on page 274 for more details). 

When a number is chosen, it is removed from the “Device” list.   

NOTE: Each LABvault-HD will only respond to those ePRO-BUS 

commands which contain its address number. 

Setup time Not used 

Print Select “Yes” to enable all of the resource’s event records for printing.  If “No” 
is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each event 

properties window that appears during scheduling of the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported into 
comma delimited or Microsoft Excel® formats.  If “No” is selected, then you 

can enable the export function during scheduling for all or individual playlist 
resources. 
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CREATING LIBRARY RESOURCES 

Use the “Library View” windows to create library resources for drag and drop scheduling 
of frequently aired programs.  Then just add properties for a specific digital video or 

switch action to each new library resource.  Before scheduling library resources for 
external devices, ensure you have created resources for the corresponding devices that 
each library resource will be played or recorded on (see “Creating External Switch 
Device Resources,” starting on page 114).   

Create library resources as follows:   

1. Click on the “Library” folder on the right side of the schedule editor window to display 
the library view (see Illustration 72, “Library View” Windows). 

Illustration 72, “Library View” Windows 

 

2. Right-click in the “Resource View” window and select “New” in the context menu to 

insert an undefined, new resource in the window (see Illustration 73, New Library 
Resource Windows). 
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Illustration 73, New Library Resource Windows 

 

3. Complete the “Properties” fields for one of the following library resources:  

 “Switch Library Resources,” on page 124 

 “Digital Video Library Resources,” on page 126 

 “Digital Video Loop Library Resources,” on page 131 

  “Digital Video File Playlist Library Resources,” on page 136 

 “Virtual Channel (VC) List Library Resources,” on page 138  

4. When you have finished creating your library resources, you have the option of 
exporting any digital video library resource properties into resource files (.res) on 

your E-HD2’s USB and NAS storage devices.  Resource files are useful for quickly 
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importing library resource properties into a new E-HD2 image file and, if saved on a 
NAS storage device, are accessible to any E-HD2 server in your system.  To export 

library resources into a resource file, perform the following: 

NOTES:  Only digital video library resource properties can be exported into a 

resource file.    

  Only the library resource properties are exported into a resource file.  
The digital video files remain in their current storage locations. 

a. Right click on the “Library” configuration folder containing the library resources 

you wish to export and select “Export” from the pop-up menu (see Illustration 74) 
to display the “Export MPEG Resource” window (see Illustration 75).  Resource 
files may only be exported and imported on a folder by folder basis. 

Illustration 74, Library "Export" Option 

 

Illustration 75, "Export MPEG Resource" Window 
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b. If the selected library folder contains resources for digital videos on more than 
one USB or NAS device, single click to select a storage device in the “Export 

MPEG Resource” window (see Illustration 75, "Export MPEG Resource" 
Window).  Only the library resources referencing digital video files on the 
selected storage device will be exported in the resource file. 

c. If you wish to overwrite an existing resource file, single click to select the file in 
“Resource Files” listing.  Click the “Export” button and, if saving a new resource 

file, enter an alphanumeric filename without spaces into the “Export resource” 
window (see Illustration 76).  Click “Ok” to upload the file to the selected storage 
device or “Cancel” to abort. 

Illustration 76, "Export Resource" Library Resource Filename 

 

d. When the resource file has been uploaded to the selected E-HD2 USB or NAS 
storage device, click “Ok” when you are prompted. 

e. If desired, repeat steps 4.a–d for each set of library resources in the folder 
referencing digital videos on your other storage devices. 
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Switch Library Resources—External Switcher Configurations Only 

Create switch library resources containing properties for switch inputs, such as studio 
feeds or external character generators (CG) connected to your external switcher.  Click 
the “Library” folder and then right click in the “Resource View” window and select “New.”  

Select a switch input type under “Format” in the “Properties” window and then edit the 
remaining properties described in Table 21, referring to Illustration 77 throughout. 

Illustration 77, Example of Switch Library Resource Properties 

 

Table 21, Switch Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters 
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FIELD DESCRIPTION 

Format Choose one of the following switch types: 

 External CG 

 IRD 

 Switch 

 Studio  

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on the web program guide (see “Viewing Web Program Guide,” on 
page 251).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.     

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Length Enter the on-air length of the program medium. 

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 

field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 
into a comma separated values format.  If “No” is selected, then you 

can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video Library Resources 

Create digital file library resources containing properties for .m2t video files that will be 
displayed by the E-HD2 server’s internal HD/SD play/record devices.  Click the “Library” 
folder and then right click in the “Resource View” window and select “New.”  Select 

“MPEG” under “Format” in the “Properties” window and then edit the remaining 
properties described in Table 22, referring to Illustration 78 throughout. 

Illustration 78, Digital Video Library Resource Properties 
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Table 22, Digital Video Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “MPEG” from the drop down list. 

Show in program 

guide 

Select “Yes” from the drop down list to include the scheduled 

resource on the web program guide (see “Viewing Web Program 
Guide,” on page 251).  The scheduled resource will be listed 
according to its event start time and the text entered into the 

“Comment” field.   

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort 
selection. 

Video filename Use the “Filename” field to select the appropriate filename for the 
source as follows:  

1. Select the “Filename” field.  Click the ellipsis button to open the 
“Select File” window (see Illustration 79, “Select File” Window).  

Illustration 79, “Select File” Window 

 

2. Select a USB drive from the “Storage device” drop down list to 
display the drive’s stored Digital video files. 

3. To display a file’s properties and view the clip before 
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FIELD DESCRIPTION 

completing the selection, either right click on the file or click 

“Properties” to display the instant video preview monitor window 
(see Illustration 80).  For more information on the preview 
monitor, go to the “Using Instant Video Preview Monitor to 

Display Digital Video Files within WinLGX” section on page 
155. 

Illustration 80, Instant Video Preview Monitor 

 
4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 
within the same schedule: 

NOTE: The digital video record library resource is 

scheduled for recording through the E-HD2 digital 
video recorder device resources.  Refer to “Internal 
Digital Video Recorder Device Resources” on page 
179 for further instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept 
filename or “Cancel” to abort. 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Select the desired file. From the “Select file” dialog, click 
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FIELD DESCRIPTION 

“OK” to accept selection or “Cancel” to abort. 

Storage device The USB drive containing the .m2t digital video file is automatically 
displayed once the filename is selected. 

In/Out point (in 
HH:MM:SS:FF, 

where 
FF=frames) 

To specify where in the selected file you would like playback to 
begin and end, use the “In point” and “Out point” fields.  Either type 

the desired file start and end times into the fields or click either 
field’s ellipsis button to open the clip editor.  Set your in and out 
points according to the following steps: 

1. Specify the clip’s playback in and out points using one of the 
following methods: 

NOTE: If you did not specify a default MPEG player for clip 
editing under “Tools”/”Preferences/Preview Monitor” 

(see page 92 for further instructions), WinLGX asks you 
to select the MPEG 1 or 2 clip editor. If the selected or 
default digital video player is currently playing a file, 

WinLGX allows you to stop playback and continue with 
the clip editing process or select the other MPEG player.   

 Click the  button to start playing the file and click the 

 or  button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 or  button. 

 Click the  or  button to move between groups of 
pictures (GOPs) in the digital video file and click the 

 or  button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length Automatically displayed once the .m2t digital video filename is 
selected.  This length may be changed to a value between 10 

seconds and 4 hours. 

Video bit rate Automatically displayed once the .m2t digital video filename is 
selected. 

Video bitrate type Automatically displayed once the .m2t digital video filename is 

selected. 

Audio sample 

rate 

Automatically displayed once the .m2t digital video filename is 

selected. 
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FIELD DESCRIPTION 

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may 

be changed.  

Media ID If desired, assign a library tracking number. 

Field Name 1–11 If desired, select the user-defined column field items that pertain to 

the new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  
If “No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of 

each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be 

exported into a comma separated values format.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling 
of the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video Loop Library Resources 

Create digital video loop library resources containing properties for .m2t digital video 
files that will be repeatedly displayed on the E-HD2 server’s internal HD/SD digital video 

players.  Each digital video loop library resource displays the selected digital video file 
for a specified number of times or loops.  Click the “Library” folder and then right click in 
the “Resource View” window and select “New.”  Select “MPEG Loop” under “Format” in 

the “Properties” window and then edit the remaining properties described in Table 23, 
referring to Illustration 81 throughout. 

Illustration 81, Digital Video Loop Library Resource Properties 

 



E-HD2 

Software Installation & Configuration 

Page 132 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

Table 23, MPEG Loop Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “MPEG” from the drop down list. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 

page 251).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the ellipsis button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Video 

filename 

Use the “Filename” field to specify the file you wish to loop as follows:  

1. Select the “Filename” field and click the ellipsis button to open the 
“Select File” window (see Illustration 82, “Select File” Window).  

Illustration 82, “Select File” Window 

 

2. Select a hard drive or NAS storage device from the “Storage 
device” drop down list to display the drive’s stored Digital video 
files. 

3. To display a file’s properties and view the clip before completing 
the selection, either right click on the file or click “Properties” to 
display the instant video preview monitor window (see Illustration 
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FIELD DESCRIPTION 

83).  For more information on the preview monitor, go to the 

“Using Instant Video Preview Monitor to Display Digital Video 
Files within WinLGX” section on page 155. 

Illustration 83, Instant Video Preview Monitor 

 
4. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 
within the same schedule: 

NOTE: The digital video record library resource is scheduled 
for recording through the E-HD2 digital video recorder 
device resources.  Refer to “Internal Digital Video 

Recorder Device Resources” on page 179 for further 
instructions.  

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the desired record time for the 
file.  

c. From the “Select file” dialog, click “OK” to accept filename 
or “Cancel” to abort. 

 Select the filename of a pre-recorded file: 

 Double-click the desired file to automatically accept 
selection and close “Select file” window.  

 Select the desired file.  From the “Select file” dialog, c lick 

“OK” to accept selection or “Cancel” to abort. 
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FIELD DESCRIPTION 

Storage 

device 

The storage device containing the .m2t digital video file is automatically 
displayed once the filename is selected. 

Length The file length is automatically displayed once the filename is specified.  

To specify the number of times or length of time you would like the file 
to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “MPEG Loop Calculator” (see Illustration 84).  

Illustration 84, MPEG Loop Calculator 

 

2. Enter the number of times you would like the file to loop in the 
“Loop count” field and/or enter a length of time, up to 24 hours, in 

the “Loop length” field. 

Video bit rate Automatically displayed once the .m2t digital video filename is 
selected. 

Video bit rate 

type 

Automatically displayed once the .m2t digital video filename is 

selected. 

Audio 

sample rate 

Automatically displayed once the .m2t digital video filename is 

selected. 

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource in the program guide.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID If desired, assign a library tracking number. 

Field Name 
1–11 

If desired, select the user-defined column field items that pertain to the 
new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 

“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 
event properties window that appears during scheduling of the 

resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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FIELD DESCRIPTION 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into a comma separated values format.  If “No” is selected, then you 
can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 

each event properties window that appears during scheduling of 
the resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 
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Digital Video File Playlist Library Resources 

Create digital video file playlist library resources containing properties for multiple digital 
video files that will be displayed by the E-HD2’s internal HD/SD player/recorders.  
Playlist resources allow users to simultaneously schedule one or more .m2t digital video 

files.  Click the “Library” folder and then right click in the “Resource View” window and 
select “New.”  Select “Playlist” under “Format” in the “Properties” window and then edit 
the remaining properties described in Table 24, referring to Illustration 85 and 

Illustration 86 throughout. 

Illustration 85, Playlist Library Resource Properties 

 

Illustration 86, “Playlist Editor” Window 
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Table 24, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “Playlist.” 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

Resource list Select the “Resource list” field and click the button that appears to 

open the “Playlist Editor” window shown in Illustration 86 and perform 
the following steps: 

1. Under “Library View,” click on the library folder to display the 
resource you would like to add to the playlist. 

2. Select the desired resource under “Resource View.” 

3. Click the “Add” button to add resource to the “Playlist” window. 

4. Repeat steps for each additional resource you would like to place 
in the playlist. 

5. Use any of the following options to edit playlist: 

 To remove an item from the playlist, highlight the resource and 
click the “Delete” button. 

 To remove all items from the playlist, click the “Clear All” 

button and select “Yes” in the dialog that appears or “No” to 
abort the operation. 

 To reorder playlist, highlight a resource and click the “Up” 
and/or “Down” buttons to move resource into new playlist 

position. 

6. Click “OK” to create playlist resource or “Cancel” to abort 
changes. 

Length Displays total length of library resources added to playlist. 

Playlist Displays filename and length of each library resource added to playlist. 
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Virtual Channel (VC) List Library Resources 

Virtual Channel library resources allow you to use your Virtual Channel playlist files as 
scheduled programming.  Before you can create a Virtual Channel library resource, you 
must first create one or more Virtual Channel playlist files in the E-HD2 web interface 

(see “Creating/Modifying Virtual Channel Playlists,” on page 258).  Click the “Library” 
folder and then right click in the “Resource View” window and select “New.”  Select “VC 
List” under “Format” in the “Properties” window and then edit the remaining properties 

described in Table 24, referring to Illustration 85 and Illustration 86 throughout. 

Illustration 87, VC List Library Resource Properties 

 

Table 25, Playlist Library Resource Properties 

FIELD DESCRIPTION 

Title Enter a unique and descriptive name, up to 31 characters. 

Format Select “VC List.” 
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FIELD DESCRIPTION 

Icon Select the desired icon to represent your library item.   

1. Open the icon selection window by selecting the “Icon” field and 
clicking the button that appears.   

2. Select the desired icon. 

3. Double click icon or click “OK.”  Click “Cancel” to abort selection. 

VC List 
Filename 

Click the ellipsis button to open the “Select Virtual Channel” popup 
window.  Single click to select a Virtual Channel playlist file from the 

listing and click “OK” to add the file to your library resource’s properties 
or “Cancel” to abort.  

Length Defaults to the total length of all resources in the playlist, but may be 

changed to any length of time up to 23 hours:59 minutes:59 seconds.  
If a longer length is specified, the playlist will repeat in order, and if 

less, not all of the playlist resources will be displayed.   

Media ID If desired, assign a library tracking number. 

Field Name 

1–11 

If desired, select the user-defined column field items that pertain to the 

new library item. 

Print Select “Yes” to enable all of the resource’s event records for printing.  If 
“No” is selected, then you can enable printing as follows: 

 Individual event records: select “Yes” in the “Print” field of each 

event properties window that appears during scheduling of the 
resource. 

 All of the resource’s event records: check the “Export/print all 
records” option under the “Export/Print Templates” window. 

Export Select “Yes” to allow all of the resource’s event records to be exported 

into comma delimited or Microsoft Excel® formats.  If “No” is selected, 
then you can enable the export function as follows: 

 Individual event records: select “Yes” in the “Export” field of 
each event properties window that appears during scheduling of 

the resource. 

 All of the resource’s event records: check the “Export/print all 

records” option under the “Export/Print Templates” window. 
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SOFTWARE OPERATION 

ABOUT THIS SECTION 

Introduced in the previous section, the tabs, icons, and menu items for the WinLGX 
schedule view will now be explained in greater detail.  The first part of this section 

teaches you how to use the schedule view components to add events to your E-HD2 
image files for automated playback and recording.  The system, device, and library 
(media) properties must be entered into the current image file before event scheduling 

can occur (see “Software Installation & Configuration,” starting on page 48, for 
instructions).  To create a schedule, simply drag and drop your device and library icons 
onto the schedule view and then complete the corresponding event properties windows.  

This section also shows you how to use the WinLGX control panel for the times you 
wish to immediately perform switching and device control or start/stop a schedule. 

At the end of this section, you will learn how to manage the storage of any digital videos 
on your E-HD2 system’s internal and external storage areas.  With the WinLGX 

“Storage Manager” window, you can delete, move, and copy digital video files between 
your local (PC) and remote storage areas.   
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PERFORMING GENERAL WINLGX OPERATIONS 

OPENING WINLGX AND CONNECTING TO AN E-HD2 SERVER 

1. Double click the WinLGX desktop icon.  The login window shown in Illustration 88 
automatically appears when WinLGX is opened or when you click one of the 
following: 

 Select “Site manager” in the “Tools” menu 

 Click the  icon on the toolbar 

Illustration 88, “Site Manager” Window 

 

2. If desired, reorder your IP address listing.  Clicking on any column header in the 
“Site Manager” sorts the associated information in ascending order, while clicking 

the header again sorts the list in descending order. 

3. Connect as follows (see Illustration 88, “Site Manager” Window): 

NOTE: The WinLGX title bar on the main window states whether or not you are 

connected. 

a. Select one or more IP addresses.  You may select up to eight IP addresses by 

holding down your keyboard “Ctrl” key and clicking each address with the left 
mouse button.     
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b. Log in with the username and password given to you by the E-HD2 system 
administrator.  To simultaneously log into multiple servers, all of the selected IP 
addresses must have the same username and password. 

NOTE: Connect to multiple E-HD2 servers with different usernames and 
passwords by logging in separately to each system. 

If the username and password have not been changed from the factory defaults, 
enter the following: 

E-HD2 FACTORY-DEFAULT USERNAME AND PASSWORD 

 “USER” FIELD: “ADMIN” IN LOWER-CASE LETTERS 

 “PASSWORD” FIELD: THE LAST SIX DIGITS OF YOUR E-HD2 SYSTEM’S SERIAL 

# 

NOTE:  ENTER ANY LETTERS IN UPPER CASE. 

 

NOTES:  Only letters and numbers may be used in your username and 
password. 

  Logins are case sensitive. 

 If the correct characters are not entered, an error message will 
be displayed. 

  An administrator can assign various degrees of rights to each 
username, so not all menu items or functions may be available 

to a user. 

  The last six digits of your E-HD2 server’s serial number are 

viewable from the front panel (see “Configuring Front Panel 
Settings,” on page 39) and a sticker on the back of your E-HD2 

server. 

c. Click “Connect” or press “Enter” to connect to the chosen E-HD2 server(s) and 

close the login dialog box.  Once you are connected, a tab appears for each E-
HD2 server on the main window beneath the toolbar.   

d. If you logged into more than one E-HD2 system, switch between the servers by 
clicking on the product tabs on the main window.   
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DISPLAYING WINLGX VERSION NUMBER 

Select “About WinLGX” in the “Help” menu or click the  main toolbar icon to open a 
window with the WinLGX version number.  Click on the window to close it. 

Illustration 89, About WinLGX Window 
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DISCONNECTING FROM AN E-HD2 SERVER 

To disconnect WinLGX from your E-HD2 system, perform the following steps: 

NOTE: The E-HD2 system will continue to operate while disconnected from WinLGX. 

1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to 

open the “Site Manager” window shown in Illustration 88. 

2. Select the E-HD2 address(es) you would like to disconnect.  If you want to 

disconnect from more than one address, hold down your keyboard “Ctrl” key and 
click on each address with the left mouse button. 

3. Click the “Disconnect” button.  A box will appear asking whether or not you would 
like to disconnect from the current E-HD2 location(s).  Click “Yes” to disconnect or 

“No” to remain connected. 

EXITING WINLGX 

To disconnect from your E-HD2 server(s) and close the WinLGX software, perform the 
following steps: 

NOTE: The E-HD2 server will continue to operate while disconnected from WinLGX.  

1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main 
window.   

2. If an image file has not been saved for one of the connected E-HD2 servers, the 

dialog box shown in Illustration 90 appears and asks if you want to save the 
changes.  Select one of the following options: 

Illustration 90, WinLGX Exit Dialog Box 
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 “Save to disk”: click “Yes” to open the “Save As” window.  Once you browse to 

the desired file path and save your changes (see “Saving E-HD2 Image Files,” on 
page 151), WinLGX will automatically close.  

 “Save to controller”: click “Yes” to send the image file to the E-HD2 server.  Once 

the send is complete, the server will contain and execute the schedule and 
WinLGX will automatically close.   

 “Save to disk and controller”: click “Yes” to open the “Save As” window.  Once 
you browse to the desired file path and save your changes (see “Sending E-HD2 

Image Files,” on page 202), WinLGX will send the image file to the E-HD2 server.  
Once the send is complete, the E-HD2 server will contain and execute the 
schedule and WinLGX will automatically close.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 

open. 

OPENING E-HD2 IMAGE FILES 

Each E-HD2 image file (.nmg) holds your schedule events along with your 

system, device, and library resource properties.  The “Configuring WinLGX” section, 
starting on page 60, describes how to define these configuration properties.  The image 
file’s configuration properties must be entered into the current image file before event 
scheduling can occur.    

NOTE: If you have not yet created an E-HD2 image file, go to “Creating New E-HD2 
Image Files,” on page 58. 

If an unsaved image is open in WinLGX when you attempt to open another image, a 
dialog box (see Illustration 90) appears and asks if you want to save the changes.  
Select one of the following options: 

 Save to disk: click “Yes” to open the “Save As” window.  Browse to the desired 
file path and save your changes (see “Saving E-HD2 Image Files,” on page 151).  

 Save to controller: click “Yes” to send the image file to your E-HD2 system.  
Once the send is complete, the E-HD2 system will contain and execute the 
schedule.   

 Save to disk and controller: click “Yes” to open the “Save As” window.  Once you 
browse to the desired file path and save your changes (see “Saving E-HD2 

Image Files,” on page 151), WinLGX will send the image file to the E-HD2 
system.  Once the send is complete, the E-HD2 system will contain and execute 
the schedule.   

 Select “No” to discard any changes made since the last save and close WinLGX. 

 Select “Cancel” to prevent WinLGX from closing and keep the current image file 

open. 
 
Open an E-HD2 image file according to one of the following subsections: 

 “Opening a Saved Image File,” on page 147 
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 “Opening an Image File as New,” on page 148 

 “Receiving Image Files from the Connected E-HD2 Server(s),” on page 149 

 “Associating E-HD2 Image Files with WinLGX,” on page 150 

OPENING A SAVED IMAGE FILE 

An image file contains any data that was entered and saved in the schedule and 
system, device, and library properties windows.  Open a saved image file as follows: 

1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open the 

file selection window shown in Illustration 91.   

Illustration 91, Open Image File Window 

 

NOTE: If your image file was saved without the Virtual Channel feature enabled 
and the image file contains MPEG events scheduled on the first two 

channel output tabs, WinLGX will display a “schedule fixup” message.   

 No external switcher configurations will be given the option to 

automatically enable the Virtual Channel feature and assign MPEG 
players to the first two channel output tabs.  Be aware that all MPEG 

events on the first channel output tab will then be changed to display 
on MPEG Player 1 and all events on the second channel output tab will 
display on MPEG Player 2. 

 External switcher users who would like to use the Virtual Channel 

feature must manually make the necessary image changes.  Assign 
channels to the MPEG players, change existing MPEG events on the 
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first two channel output tabs to display on the assigned MPEG players, 
and then enable the Virtual Channel feature. 

2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 

field. 

3. Select an image file folder from the “Look in” drop down box at the top of the 

window.   

4. Single click a .nmg file to select it and click “Open” or double click the file.  The 
image file data is then loaded into WinLGX.   

5. As you enter/edit your schedule events according to the “Scheduling Events” section 

starting on page 157, periodically save your settings in an image file as described in 
“Saving E-HD2 Image Files,” on page 151. 

OPENING AN IMAGE FILE AS NEW 

Opening a previously saved image file as new causes WinLGX to load any system, 

device, and library configuration properties contained within the file.  Any schedule 
events will not be imported.  

1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to 

open the file selection window shown in Illustration 92, Open Image File as New 
Window.   

Illustration 92, Open Image File as New Window 
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2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” 
field. 

3. Select an image file folder from the “Look in” drop down box at the top of the 

window.     

4. Single click a .nmg file to select it and click “Open” or double click the file.  The 

image file data minus the schedule is then loaded into WinLGX as an unnamed file.    

5. As you enter/edit your schedule events according to the “Scheduling Events” section 
starting on page 157, periodically save your settings in an image file as described in 

“Saving E-HD2 Image Files,” on page 151. 

RECEIVING IMAGE FILES FROM THE CONNECTED E-HD2 SERVER(S) 

An image received from a connected E-HD2 server contains any schedule events and 
system, device, and library properties last sent to the server.   

1. Download the last image file sent to one or more of your E-HD2 servers as follows: 

 One server: ensure the server’s product tab is selected and choose “Receive” in 

the “File” menu or click its  icon on the main toolbar.  A dialog box will ask 

whether you want to receive the image currently loaded on the connected E-HD2 
server.  Click “Yes” to complete the receive and display the status box shown in 
Illustration 93. 

Illustration 93, Image Status Window 

Progress Bar

 

 Multiple servers: from any of the product tabs, select “Receive all” in the “File” 

menu.  Click “Yes” when prompted to download each connected server’s 
image file into WinLGX.  You will see a status box like the one shown in 
Illustration 93 for each image file. 

NOTE: If your image file was saved without the Virtual Channel feature 
enabled and the image file contains MPEG events scheduled on the 

first two channel output tabs, WinLGX will display a “schedule fixup” 
message.   

 No external switcher configurations will be given the option to 
automatically enable the Virtual Channel feature and assign MPEG 
players to the first two channel output tabs.  Be aware that all MPEG 

events on the first channel output tab will then be changed to display 
on MPEG Player 1 and all events on the second channel output tab 
will display on MPEG Player 2. 
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 External switcher users who would like to use the Virtual Channel 
feature must manually make the necessary image changes.  Assign 

channels to the MPEG players, change existing MPEG events on the 
first two channel output tabs to display on the assigned MPEG 
players, and then enable the Virtual Channel feature. 

2. As you enter/edit your schedule events according to the “Scheduling Events” section 

starting on page 157, periodically save your settings in an image file as described in 
“Saving E-HD2 Image Files,” on page 151. 

ASSOCIATING E-HD2 IMAGE FILES WITH WINLGX 

Associating an E-HD2 image (.nmg) files with WinLGX enables you to double click on 

an image file and have it automatically open in WinLGX.  Perform the following 
procedure: 

1. Browse to an E-HD2 image (.nmg) file.   

2. Right click on the E-HD2 image file and choose "Open with" or "Open." 

3. Choose "Select the program from a list." 

4. Browse to and choose the WinLGX executable file path.   

5. Check the "Always use ..." checkbox and click "OK." 
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SAVING E-HD2 IMAGE FILES 

Save a copy of your current image file to your PC or network through one of the 
following options: 

 “Save” Option 

If an E-HD2 image has not been saved to your PC or network or has been modified, 

the “Save” option becomes enabled.  Select “Save” from the “File” menu or click the 

 toolbar button.   

 If the E-HD2 image already has a local filename, visible in the title bar (WinLGX – 
filename.nmg), the “Save” option saves the loaded image to that name without 
prompting, overwriting the old file.   

 If the image does not have a local filename, “Save” opens the “Save as” box 

shown in Illustration 94, allowing a name and file path to be specified. 

 “Save as” Option 

The “Save as” option allows you to save an E-HD2 image under a new filename.  
Select “Save as” in the “File” menu to open the window shown in  Illustration 94, and 

perform the following steps:  

Illustration 94, “Save As” Window 

 

1. From the “Save in” drop down box at the top of the window, navigate to the folder 
where you want to save the E-HD2 image file.   
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2. Type a name for the image in the “File name” field.   

3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” 
option has been selected in the “Save as type” field. 

4. Click “Save” to save the image under the entered name or “Cancel” to abort the 

“Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if 
you want to overwrite it. 
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IMPORTING DIGITAL VIDEO LIBRARY RESOURCES 

If your digital video library resource properties have been exported into one or more 
resource files (see step 4 on page 121 for information on exporting digital video library 

resource properties), simply upload the resources into your current E-HD2 image file as 
follows: 

1. Right click on the “Library” configuration folder you wish to import digital video library 
resources into and select “Import” from the pop-up menu (see Illustration 95) to 

display the “Import MPEG Resource” window (see Illustration 96).  Resource files 
may only be imported on a folder by folder basis. 

Illustration 95, Library "Import" Option 

 

Illustration 96, "Import MPEG Resource" Window 

 

2. If more than one device is shown in the “Storage Device” listing on the “Import 

MPEG Resource” window (see Illustration 96, "Import MPEG Resource" Window), 
single click to select the storage device containing the resource files with the library 
resource properties you wish to import.   
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3. If more than one resource file exists, single click to select the file with the library 
resources you wish to import (see Illustration 97). 

Illustration 97, Selecting File on "Import MPEG Resource" Window 

 

4. Click the “Import” button to start importing the resources or “Done” to cancel the 

operation and close the “Import MPEG Resource” window. 

5. After clicking the “Import” button, click “Yes” when prompted to import the file’s 

digital video library resource properties or “No” to abort. 

6. When the digital video library resource properties have been imported, click “Ok” 
when you are prompted.  The imported library resources will be shown in the 

“Resource View” (see Illustration 98 for an example). 

Illustration 98, Imported Library Resources 

 

7. If you wish to import digital video library resources from additional resource files, 

repeat steps 1–6.  
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USING INSTANT VIDEO PREVIEW MONITOR TO DISPLAY DIGITAL 
VIDEO FILES WITHIN WINLGX 

WinLGX gives you the option to preview the .m2t digital video files on your remote (USB 

and/or NAS devices) and local (PC, network) storage areas through its instant video 
preview monitor window.  Conveniently access the instant video preview monitor when 
you are scheduling a digital video device or library resource, choosing a digital video file 

for immediate display through the control panel, or using the Storage Manager window 
to manage your digital videos.   

Access the instant video preview monitor (see Illustration 99) from any of the following: 

 Storage Manager window 

 Double click a digital video file 

 Right click a digital video file and select “View” from the right-click menu 

 “Select File” window (available when initiating playback from control panel, 
scheduling digital video device resources, and creating library resources):  

 Right click on digital video file 

 Single click an digital video file and click the “Properties” button 

 Library Resource View Window 

 Double click a library resource 

 Right click a library resource and select “View Resource” from right-click menu 

IMPORTANT! VLC media player must be installed on the computer running WinLGX 

if you wish to display digital video videos in the WinLGX preview 
monitor windows.  If WinLGX states that it cannot find the VLC media 
player when you open a preview monitor window, first ensure that VLC 

player is installed on your computer.  If VLC player is not installed, 
download the free program from the Internet.  Once installation has 
been verified or completed, find your computer’s file path for the folder 

containing the VLC executable file (“vlc.exe”).  Open the WinLGX 
“Preferences” window, select the “Preview Monitor” tab, and enter your 
file path into the “VLC Application Folder” field (for example, 
C:\Program Files\VideoLAN\VLC). 

The instant video preview monitor includes controls for managing playback of the 

selected digital video file.  Refer to the following for more information on each of the 
controls labeled in Illustration 99, Preview Monitor Controls: 
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Illustration 99, Preview Monitor Controls 

 

 Scrub Bar Slider: click and drag with your mouse pointer to go forward or backward 

in  the video 

 Play/Pause Button: click to toggle between pause and playback of the video 

 Step Forward Button: moves the video one frame forward each time it is clicked 

 Close Window Red X Icon: closes preview monitor window when clicked 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  

The volume control defaults to no audio. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 File Properties: provides the name, length, video bit rate, audio sample rate, and 
storage device of the selected digital video file 

NOTE: The digital video file’s properties are only displayed when the preview 
monitor is accessed from the “Select File” window. 

 Resize Window Control: use to expand or shrink the size of the preview monitor 

window. 
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SCHEDULING EVENTS 

The “Schedule” window, shown in Illustration 100, with a sample schedule loaded, is 
where an event schedule is created.   

Illustration 100, Schedule Window 

 

ABOUT SCHEDULE WINDOW COMPONENTS 

Product Tabs 

For each LEIGHTRONIX product you are logged into, a separate tab appears on the 

main window.  Click on a tab to display the corresponding product view and then enter 
your scheduling information for the selected product. 

Schedule View 

The schedule view window displays the channel output tabs, day tabs, WinLGX-LT tab, 
and schedule columns.  Add your events to this window. 

Channel Output Tabs 

 Channel output tabs: use to schedule events that contain switches to the selected 

tab’s assigned output.   

NOTE: The number of outputs, labels, and channel/output assignments are 

entered in the “System Configuration View” (see “Configuring the Switch 
Type of an E-HD2,” on page 97).  On external switchers, WinLGX only 
allows scheduling on up to 16 channel output tabs. 

 No external switcher configurations: use “Sch Rec 1” tab to schedule record events 
on HD/SD digital video Player/Recorder 1 and the “Sch Rec 2” tab to schedule 

record events on HD/SD digital video Player/Recorder 2. 
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Day Tabs 

Day tabs are used to schedule events on specified days.  The day tabs perform output 
and device conflict checking across all of the channel tabs, so that an output or a device 
can never have more than one event scheduled at the same time.   

Each event contains all of the starting and ending actions for a program, and thus uses 
up a block of time for the length of the program.  WinLGX orders these blocks vertically 
in the schedule window, one row per event, so that for a particular output on a particular 
day, you can see the day’s 24 hours divided into programs. 

 Locked Events 

If an event is locked, it has a fixed time entered by the user.  This allows it to be 
scheduled away from the end of the previous event or away from the beginning 
of the day.  If this is done, a channel switchback is indicated between the events, 

or at the beginning of the day.  Each channel switchback equals the length of 
time separating the preceding event from the next scheduled event.  Channel 
switchbacks appear in a different color (yellow by default). 

 Unlocked Events 

An unlocked event’s time is assigned by WinLGX to coincide with the ending time 
of the event above it.  This time is not fixed and will be adjusted by WinLGX if 

events above the unlocked events are inserted, deleted, moved, or modified. If 
an added or edited event’s time or length causes it to overlap an unlocked event, 
the unlocked event will move downward in the schedule if it can. 

NOTE: If adding, editing, or deleting an event causes two events to conflict, an error 

message appears.  If the added/edited event is one of the conflicting events, 
the event it conflicts with is listed, the error is described, and the outcome is 
given.  If the added/edited/deleted event is not one of the conflicting events, 

the two conflicting events are listed, the error is described, and the outcome is 
given.  Use this information to correct the conflict. 
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WinLGX-LT Tab 

The WinLGX-LT tab (see Illustration 100, Schedule Window) has its own date/day and 
time entry and does not assign blocks of time in a linear fashion like the day tabs.   

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, 

select the “Show WinLGX-LT tab in the schedule window” option on the 
“Application” tab of the Tools\Preferences window. 

The WinLGX-LT tab is useful in the following situations: 

NOTE: The WinLGX-LT tab does not prevent two events from occupying the same 
time. 

 External Switcher Configuration Only: schedule device or library resources 

attached to external switcher outputs outside the range of the 16 channel output 
tabs. 

 When you would like to use the same event on multiple days, schedule the event 

on the WinLGX-LT tab once and avoid having to recreate or copy the event on 
multiple day tabs.  

 If you would like to create a schedule that encompasses more than the next 
seven days, use the WinLGX-LT tab and schedule according to date. 

 Schedule a device-only event without a switch on the WinLGX-LT tab to test a 
device-only event action before sending it to the destination or to perform 
nonplayback events such as recording. 
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Channel and Day/WinLGX-LT Tab Configurations 

Each pair of channel and day tabs displays its own event window.  In addition, the 
WinLGX-LT tab displays a single event window, regardless of the channel.  Selecting 

one of the channel output tabs merely causes its output to be the default when adding 
an event, with the ability to select a different output.  The channel output tabs will 
appear as follows based on the switcher configuration (see Table 26, Channel Output 
Tabs and Available Event Windows).   

NOTE: On an E-HD2 server without an external switcher, Output 3, labeled as “Sch 
Rec 1,” is automatically assigned to the internal digital video Recorder 1 and 
Output 4, labeled as “Sch Rec 2,” is automatically assigned to internal digital 

video Recorder 2.  For external switcher configurations, the two highest 
numbered channel output tabs are automatically assigned to the internal 
digital video recorders. 

Table 26, Channel Output Tabs and Available Event Windows 

SWITCHER CHANNEL OUTPUT TABS # OF EVENT WINDOWS 

No switcher 
Output 1–2, Sch Rec 1, and 

Sch Rec 2 

29 event windows (4 channels x 7 days 

+ 1 WinLGX-LT tab) 

External, LEIGHTRONIX 

PRO-16/NET-164 
Output 1–Output 4 

29 event windows (4 channels x 7 days 

+ 1 WinLGX-LT tab) 

External, Non-
LEIGHTRONIX Switcher 

Output 1–Output 16 
113 event windows (16 channels x 7 
days + 1 WinLGX-LT tab) 

 

Schedule Columns 

The schedule window columns display the events’ fields, giving all the information and 

actions of the event.  When the schedule window contains an event, the columns can 
be moved and resized by dragging the headers and header boundaries.  A horizontal 
scroll bar at the bottom of the window is used to view all of the columns.  For a listing of 
the fields, see Table 27, Schedule Columns. 

Table 27, Schedule Columns 

FIELD DESCRIPTION 

Time  Program’s scheduled time: reflects time of any initial switch and the 
beginning of the program time block.  If the event time is fixed (locked), this 

field will also contain a thumbtack symbol .   

Title  Name of the event.  The title may be assigned in the resource’s “Title” field 
either when the resource is configured or when it is added to the schedule.  If 

the event consists of a channel switchback, the field shows which user-
configured input or video source switchback will be displayed during the 
unscheduled time slot. 
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FIELD DESCRIPTION 

Interface/ 

Device  

N/A 

Format  Format selected for the device or library resource in the “Properties” window. 

Input  Number and name of the device or switch input that will be taken to the 
output at the scheduled time (shown in “Time” field). 

Output  Number and name of the output the initial input switches to at the schedule 

time (shown in “Time” field). 

Channel  Number and name of the channel in which the event resides. 

Title/Chap  N/A 

Setup  Time the device takes to produce video and/or sound after receiving a PLAY 
command. 

Preroll  Indicates amount of unwanted video (black, etc.) at the beginning of the 
program.   

In point If assigned, indicates an digital video’s playback starting point 

Out point If assigned, indicates an digital video’s playback ending point  

Length  Length of the program block and the time between initial and ending 

switches, if any.  WinLGX subtracts “End” from “Time” to obtain the “Length” 
value. 

Reset  Time the device is busy and unavailable for scheduling after the end of the 

block (“End”), usually due to rewind time. 

Start CMD  Device command that occurs initially at “Start.” 

End CMD  Device command that occurs at “End” (usually “Stop” or “Rewind”). 

Switchback  Indicates the input that is switched to the event’s channel output following 
the “End” command.  Back to back scheduled events have the “End” time of 

the first event equal to the “Time” of the second event.  This puts the first 
event’s switchback at the same time as the second event’s initial switch.  If 
this occurs, the E-HD2 system cancels the switchback. 

Start  Indicates time of the initial device command.   WinLGX subtracts “Setup” 

plus “Preroll” from “Time” to obtain the “Start” value, which is the start time of 
the device command.  “Start” is not included in the time block used for 

vertical positioning within the schedule.  The time progression is as follows:   

1. At the time shown in the “Start” field, a PLAY command is issued. 

2. The event waits for “Setup” and “Preroll” to complete before performing 
the initial switch.   
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FIELD DESCRIPTION 

End  Indicates end of the program block, end time of the device command, and 

switchback, if any.  WinLGX adds “Length” to “Time” to obtain “End” value. 

Filename (1) Displays the filename of the chosen digital video file. 

Storage 
Device (1) 

Indicates the storage device of the chosen digital video file. 

Record 

Preset 

Displays the title of the selected record preset for a digital video recording 

event. 

Overwrite Displays the selected file overwrite option for a digital video recording event. 

Record CC 

data 

Indicates whether or not a digital video recording event will capture any 

closed caption data from the source. 

Filename (2) N/A 

Storage 
Device (2) 

N/A 

Audio Input N/A 

Print  Determines if the event will be included in a print operation. 

Export  Determines if the event will be included in an export operation. 

Overlay N/A 

Show in 
program 

guide 

Indicates whether or not an event will be shown on the web program guide 

Comment  Used to enter an event comment up to 31 characters. 

Media ID Assigned by user as a library tracking number. 

Field Name 
(1–11) 

Schedule column headings that may be assigned by user. 
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SCHEDULING/EDITING/DELETING ALL EVENTS 

Scheduling an Event on a Day/Channel Output Event Window 

1. Select a scheduling event window as follows: 

a. Click the desired day tab to select the day you want the event to occur. 

b. Select one of the following channel tabs: 

 Digital video recording events only: select one of the “Sch Rec” tabs for E-

HD2 servers without an external switcher or the channel output tab assigned 
to the desired digital video recorder in an external switcher configuration (see 

“Editing Internal Digital Video Playback and Recording Device Resources,” on 
page 110 for more information on configuring channel output tabs). 

 Channel output tab 

2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event 

window.  This opens an “Event properties” box with editable event information like 
the one shown in Illustration 101, Day/Channel Output Event Properties Box. 

Illustration 101, Day/Channel Output Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 
(described on pages 172–199) and enter the new information.  An icon can be 
dragged and dropped into a day/channel output event window in the following five 

ways: 
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 Empty Window—the event is locked and given the initial time of 12:00 A.M. 

(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 
used.) 

 Initial Channel Switchback—if an event is dragged onto a channel switchback at 

the start of the day (1st row), it is locked and given the initial time of 12:00 A.M.  
(Unless a previous day’s event overlaps midnight, in which case, its “End” time is 
used.) 

 Any Other Channel Switchback—the event is initially unlocked, with a time equal 
to the “End” time of the previous event. 

 On Top of an Unlocked Event—the new event is initially unlocked and given the 
time of the event on which it was dragged.  The existing event is pushed 

downward and out of the way if possible.  If not, an error box appears.  Dragging 
an icon on top of a locked event instantly generates an error. 

 Below the Bottom Event—the event is initially unlocked, with a time equal to the 
“End” time of the previous event. 
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Scheduling an Event on the WinLGX-LT Event Window 

NOTE: To display the WinLGX-LT tab on the bottom of your schedule window, select 
the “Show WinLGX-LT tab in the schedule window” option on the 

“Application” tab of the Tools\Preferences window. 

1. Click the “WinLGX-LT” tab to open the corresponding event window.   

2. Drag an icon from the “Device” or “Library” “Resource View” onto the WinLGX-LT 

event window.  This opens an event properties box like the one shown in Illustration 
102, WinLGX-LT Event Properties Box.   

Illustration 102, WinLGX-LT Event Properties Box 

 

3. To add or change the event information, click on each of the desired editable fields 

(described on pages 172–190) and enter the new information.  The WinLGX-LT 
event properties box is the same as the event edit box displayed for the day/channel 
output event windows with the following exceptions. 

 There is no Lock/Unlock checkbox; you must enter a time for each event.   

 If an output assignment is desired, the output must be selected from the “Output” 
field drop down menu.   

 A date and/or day(s) must be selected as follows: 
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NOTE: If a date is selected, the event happens on that date.  If days are 
selected, the event happens on those days.  If both are selected, the 
event happens on the selected date and days. 

a. To select a date, change “Absolute date” to “Yes.”  A date field appears below to 
allow date entry.   

b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be 
toggled quickly by double clicking on the day name. 

4. If desired, you may edit the properties of a device or library resource and then apply 
those changes to any events added to the WinLGX-LT event window by performing 
the following steps: 

a. Select the desired device or library resource icon. 
b. Click on the desired editable resource fields in the “Properties” window and make 

the changes.  

c. WinLGX displays a dialog box that gives you the option to merge the resource 
editing changes into each event in the WinLGX-LT event window that was 
created from the same resource. 

Copying/Cutting/Pasting an Event 

To move or replicate an event or group of events to another location on the schedule, 
perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 

menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Copy, cut (if you wish to move event), and paste by selecting the function you wish 

to perform from either the “Edit” menu or the right-click pop-up menu.   

3. In the “Event Properties” box that appears once the paste has been completed, click 
“Ok” if one event was pasted or “Ok to all” if more than one event was pasted.   

NOTE: If the event(s) is pasted channel switchback of a shorter duration than the 
event(s) itself, WinLGX will display a dialog asking whether or not you 
would like to trim/discard the ending playlist items to fit the channel 
switchback or cancel the operation. 
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Editing an Event 

To edit an event in the schedule, double click event, right click event and choose “Edit” 
in the right-click menu, or select “Edit” from the “Edit” menu.  Edit the event information 

in the “Event properties” box that appears.  To add or change the event information, 
click on each of the desired editable fields (described on pages 172–190) and enter the 
new information. 

Deleting an Event 

If the first event in the schedule window is deleted, the next event is locked in place, if 

necessary.  If any other event is deleted, any unlocked events immediately below it will 
float up until they rest against the event above (unless this causes a device conflict, in 
which case the first unlocked event will be locked in place).   

To delete an event(s), perform the following steps: 

1. Select the desired event(s) using one of the following options: 

 Highlight an individual event. 

 Hold down your keyboard’s “Ctrl” key and highlight multiple events. 

 Highlight all events on an event window by selecting “Select All” from the “Edit” 

menu or the right-click menu or simultaneously pressing your keyboard’s “Ctrl” 
and “A” keys. 

2. Press the “Delete” key, right click event and choose “Delete” in the right-click menu, 
or select “Delete” from the “Edit” menu.  You will be prompted for confirmation before 
the event is deleted.  If you selected multiple events, one of the following dialog 

boxes is displayed: 

 If you selected a list of events that includes non-playlist events, the dialog 
shown in Illustration 103 appears.  Perform one of the following options: 

Illustration 103, Delete Dialog Box 

 

 “Delete this event?”: click “OK” to delete the current selection in a list of 

selected events.  
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 “Delete all events?”: click “OK” to simultaneously delete all of the selected 
events.   

 “Skip this event?”: click “OK” to keep the current selection in a list of 
selected events. 

 If you only selected a playlist of events, the dialog shown in Illustration 104 
appears.  Perform one of the following options: 

Illustration 104, Playlist Delete Dialog Box 

 
 

 “Delete this event?”: click “OK” to delete the current selection in the playlist.  

 “Delete entire playlist?”: click “OK” to simultaneously delete the entire 
playlist.  

 “Delete entire playlist in all switchbacks?”: this option will be enabled if the 
selected playlist was added to a channel switchback between programs.  

Click “OK” to simultaneously delete all instances of the playlist from the 
selected channel output’s switchbacks. 
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Replacing Library Resource Events 

By performing the following steps, you can replace one or more schedule events 
created with the same library resource with any library resource of the same format: 

1. If you would like to change your library resource before using it to replace event(s), 

select the library resource in the “Resource View” window and then edit its resource 
properties. 

2. Drag a library resource onto a same-format library resource event you would like to 
replace.  The event properties window for the library resource will open, displaying a 

“Replace” button on the bottom of the window (see Illustration 105).   

Illustration 105, "Replace" Button on Event Properties Window 

 

3. If desired, edit the properties of the library resource. 

4. Click the “Replace” button to open the “Find and Replace” window shown in 
Illustration 106.  This window gives you a variety of options for replacing the selected 
event or all schedule events like the selected one with the dragged library resource.   

5. To make a replacement, click one of the replacement buttons on the bottom of the 

“Find and Replace” window.  The replacement buttons are described in Illustration 
106.     
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NOTE: If your library resource is too long for the schedule time slot, you will be 
given the option to trim the resource to fit or cancel the replacement. 

Illustration 106, "Find and Replace" Window 

 
 

If you plan to replace multiple instances of the selected event, pay attention to the 
indicators above the replacement buttons on the “Find and Replace” window.  The 

indicators give a quick overview of how many instances of the selected event exist 
throughout your schedule.  Here is a quick description of each indicator: 

 “Day/Ch: x of x:” the second “x” indicates how many instances of the selected 

library resource event exist on the current day tab and channel output tab 
window, while the first “x” shows how many of the events have been replaced on 
the same window 

 “Ch: x of x:” the second “x” indicates how many instances of the selected library 
resource event exist on the current channel output tab windows, while the first “x” 

shows how many of the events have been replaced on the same windows 

 “Sch: x of x:” the second “x” indicates how many instances of the selected library 
resource event exist on all of the day and channel output tab windows, while the 
first “x” shows how many of the events have been replaced on the same windows  
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Inserting Library Resource Events 

By performing the following steps, you can insert a library resource into the time slot of 
an unlocked library resource event of the same format.  The inserted event will take the 

start time of the event onto which it was dragged.  Unlocked events below the inserted 
event will be automatically pushed downward in the schedule by an amount of time 
equal to the length of the inserted event.   

  If there are locked events above and/or below the selected event, the 

desired time slot may not be long enough to accommodate the dragged 
library resource.   

 If there is not a channel switchback between the selected event and 
a locked event, the “Insert” button will be unavailable on the 

resource’s “Event Properties” window.   
 If there is a short channel switchback between the selected event 

and a locked event, you will be given the option of trimming the 
resource to fit the available time slot or cancelling the insert. 

1. If you would like to change your library resource before inserting it in your schedule, 
select it in the “Resource View” window and then edit its resource properties.  

2. Drag a library resource onto an unlocked library resource event of the same format.  
The event properties window for the library resource will open. If there is enough 

time available to accommodate the new resource’s length, an “Insert” button will be 
displayed on the bottom of the window (see Illustration 107).   

Illustration 107, "Insert" Button on Event Properties Window 
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3. If desired, edit the properties of the library resource. 

4. Click the “Insert” button to assign the selected event’s start time to the dragged 

library resource event.  All unlocked events below the inserted event will shift 
downward in the schedule by an amount of time equal to the length of the inserted 
event.  

SCHEDULING/EDITING DEVICE RESOURCES 

Adding or editing device resource events opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit.   

Switch Device Resources—External Switcher Configurations Only 

Dragging an external switch device resource onto the schedule reveals a box in 
Illustration 108, Switch Device Event Properties Window.  Refer to Table 28, Editable 
Switch Device Event Properties, for a description of the editable event properties. 

Illustration 108, Switch Device Event Properties Window 
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Table 28, Editable Switch Device Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure you have selected the device you wish to schedule. 

Length Enter duration of the event. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air” time of the event. 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 

page 251).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 

comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 
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FIELD DESCRIPTION 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 90).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Internal Digital Video Player Device Resources 

Dragging an E-HD2 digital video player device resource onto the schedule reveals the 
window shown in Illustration 109, Digital Video Player Event Properties Window.  Refer 

to Table 29, Editable Digital Video Player Event Properties, for a description of the 
editable event properties. 

NOTE: Each digital video player may only be scheduled on its assigned playback 
channels (see “Editing Internal Digital Video Playback and Recording Device 

Resources,” on page 110, for more information on digital video playback 
channel assignments). 

Illustration 109, Digital Video Player Event Properties Window 

 

Table 29, Editable Digital Video Player Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 

lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 

“Time” field, causing WinLGX to assign a time to the event that starts 
at the end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Title Allows a name with up to 31 characters to be typed. 

Device Select the digital video player to be scheduled (1 or 2). 

Setup time If desired, indicate how long after the selected digital video player is 

activated that picture and/or sound is produced. 

Reset If desired, enter time the digital video player will be busy and 

unavailable for scheduling after the end of the program.   

Filename Use the “Filename” field to select the appropriate filename for the 
source as follows:  

1. Select the “Filename” field.  Click the ellipsis button to open the 

“Select File” window.  

2. Select a USB drive from the “Storage device” drop down list to 

display the drive’s stored digital video files. 

3. Perform one of the following: 

 Enter a filename for a file that will be recorded and played 

within the same schedule: 

NOTE: The digital video recording library resource is 

scheduled for recording through the MPEG device 
resource.  Refer to “Internal Broadcast MPEG 
Recorder Device Resources” on page 179 for further 
instructions.   

a. Type a filename in the “Name” field. 

b. In the “Length” field, enter the record time for the file. 

c. From the “Select file” dialog, click “OK” to accept filename 
or “Cancel” to abort. 

 Select the filename of a pre-recorded file through one of the 

following methods listed below.  To display a file’s properties 
and view the clip before completing the selection, either right 
click on the file or click “Properties” to display the instant video 

preview monitor.  For more information on the preview monitor, 
go to the “Using Instant Video Preview Monitor to Display 
Digital Video Files within WinLGX” section on page 155. 

o Double-click the desired file to automatically accept 
selection and close the “Select file” window.  

o Click to select the desired file. From the “Select file” dialog, 
click “OK” to accept selection or “Cancel” to abort. 

4. If desired, specify where in the selected file you would like 
playback to begin and end using the “In point” and “Out point” 

fields.  Either type the desired file start and end times into the 
fields or click either field’s ellipsis button to open the clip editor.  
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FIELD DESCRIPTION 

Set your in and out points according to the following steps: 

a. Specify the clip’s playback in and out points using one of the 
following methods: 

NOTE: If you did not specify a default digital video player for 
clip editing under “Tools”/”Preferences/Preview 

Monitor” (see page 92 for further instructions), 
WinLGX asks you to select the MPEG 1 or 2 clip 
editor. If the selected or default digital video player is 

currently playing a file, WinLGX allows you to stop 
playback and continue with the clip editing process or 
select the other MPEG player. 

 Click the  button to start playing the file and click the 

 or  button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 or  button. 

 Click the  or  button to move between groups of 
pictures (GOPs) in the digital video file and click the 

 or  button. 

b. Close the clip creation control panel and add changes to 

library resource by clicking the  button. 

Length The length of the file is automatically entered into this field, but it may 

be changed to a value between 6 seconds and 23 hours:59 
minutes:59 seconds 

Time If the event is locked, the event start “Time” can be modified.  This is 

the scheduled “On-Air” time of the event. 

Command 

(Event start) 

The “PLAY” command is automatically displayed.    

Command 
(Event end) 

Choose between “STOP” and “<None>.”  It will almost always be 
“STOP.”  

Switchback 

input 

If desired, select a video source to be taken to the output at the end 

of the event. 

Show in 

program guide 

Select “Yes” from the drop down list to include the scheduled 

resource on the web program guide (see “Viewing Web Program 
Guide,” on page 251).  The scheduled resource will be listed 
according to its event start time and the text entered into the 

“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
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FIELD DESCRIPTION 

identify the resource on program guides.  The text entered in the 

“Title” field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field Name 1–
x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If 

“No” is selected, then you can enable printing for all of the resource’s 
event records by checking the “Export/print all records” option under 

the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 
a comma separated values format.  If “No” is selected, then you can 

enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 

90).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 
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Internal Digital Video Recorder Device Resources 

Dragging an E-HD2 digital video recorder device resource onto the schedule reveals the 
box in Illustration 110, Digital Video Recorder Event Properties Window.  Refer to Table 

30, Editable Digital Video Recorder Event Properties, for a description of the editable 
event properties.  

NOTE: When creating Digital video files, first create a short test file for playback on 
your E-HD2 system.  Use this test file to verify video playback compatibility 

with your LEIGHTRONIX system and to check your encoding audio level 
settings.  Verify that your audio levels match the audio levels from other E-
HD2 sources.  Once you have determined the proper digital video record 
settings, make note of them for use during future recording sessions. 

If you would like to play an .m2t file within the same schedule it was recorded, 
create and schedule a digital video library resource with the same filename and length 
given to the digital recording event.  See “Digital Video Library Resources” on page 126 

for further instructions on creating a digital video library resource.  The library resource 
will be available for playback once the digital recording event ends. 

Illustration 110, Digital Video Recorder Event Properties Window 
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Table 30, Editable Digital Video Recorder Event Properties 

FIELD DESCRIPTION 

Lock At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Add to 

Library 

The “Add to library” option causes WinLGX to automatically create a 

library playback resource for the recording event.  This library resource 
may be used to schedule a playback event with the recorded digital 
video file.  To enable this option, check the “Add to library” box at the 

bottom of the event properties window.  The “Add to library folder” 
window shown in Illustration 111 will display.  Select the library folder 
you would like to contain the library resource and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that 

possesses the same video filename and length as a 

pre-existing library resource. 

  If the new file possesses the same title as another 

resource, but has a different video filename and/or 
length, WinLGX will copy the new file to the library with 

a numbered increment added to its title.  For example, 
if this is the first time you have reused the title of a pre-
existing library resource, WinLGX will add the new file 

to the library under the name “title01.” 

Illustration 111, “Add to library folder” Window 
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FIELD DESCRIPTION 

Title Allows a name up to 31 characters to be typed. 

Input Select the input signal you want the digital video recorder to record. 

Device Ensure the digital video recorder is selected. 

Setup time If desired, indicate how long after the selected digital video recorder is 
activated that recording starts. 

Reset If desired, enter time the digital video recorder will be busy and 

unavailable for scheduling after the end of the program. 

Record 

Preset 

Select one of the three recording settings configured under “System 

Configuration.” 

Record 
Overwrite 

Select “Always” to automatically record over an existing file with the 
same name or “Create Unique” to record a file entered under an 

existing MPEG filename with the first 14 characters of the original 
filename followed by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record 
date specified as year/month/ day and hh/mm/ss is the file record time 

in hours/minutes/seconds). 

Record CC 
data 

Select “Yes” to capture any closed caption data from the source.  
Closed captions are hidden in the video signal and decoded for display 

on televisions with built-in decoders or televisions connected to 
external decoders. 

Create VOD 

file 

Does not apply to the E-HD2 at this time. 

MPEG 

Filename 

Perform one of the following: 

 Enter up to 27 characters to create a new filename for the 
recording event.   

 If you created a playback library resource for the digital video file 

to be recorded, enter the exact filename used for the library 
resource.   

Storage 

device 

Select the storage device you would like to hold your recorded file. 

Length Enter recording duration of up to 23 hours:59 minutes:59 seconds.  If 
you created a digital video library resource for the digital video file to be 

recorded, enter the same time duration used for the library resource.  

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The “RECORD” command is automatically displayed. 

Command Choose either “STOP” or “<None>.”  It will almost always be “STOP.”   
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FIELD DESCRIPTION 

(Event end) 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Show in 

program 
guide 

Select “Yes” from the drop down list to include the scheduled resource 

on the web program guide (see “Viewing Web Program Guide,” on 
page 251).  The scheduled resource will be listed according to its event 

start time and the text entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 
identify the resource on program guides.  The text entered in the “Title” 

field is automatically placed in the “Comment” field, but may be 
changed.  

Media ID Assign as a library tracking number. 

Field 1–x Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 

comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 90).  
To toggle between these views, select and deselect the “Maximum 

view” checkbox. 
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SCHEDULING/EDITING EPRO-BUS-CONTROLLED DEVICE RESOURCES 

Adding or editing an ePRO-BUS record schedule event for your remote or locally 
connected LEIGHTRONIX LABvault-HD recorder opens an event properties window 

containing editable properties.  Edit the properties for your remote or local ePRO-BUS 
record event according to the following subsections, clicking “OK” to submit the event or 
“Cancel” to abort the add/edit. 

NOTE: ePRO-BUS record events can only be scheduled on the WinLGX-LT 

tab.  If the WinLGX-LT tab is not displayed at the bottom of your schedule 
window, go to the “Tools”/“Preferences” menu option and select “Show 
WinLGX-LT tab” option on the “Application” tab. 

Remote ePRO-BUS-Controlled Devices 

A remote ePRO-BUS-controlled device is a LABvault-HD that has been added to the 

same TCP/IP network as your E-HD2 system.  This allows you to start and stop 
recording on a LABvault-HD that is in a different location than your E-HD2.  Perform the 
following steps to schedule or edit a remote ePRO-BUS resource event: 

1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not 

see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the “Show 
WinLGX-LT tab” option. 

2. Open the ePRO-BUS record “Event Properties” window (see Illustration 112, 
Remote ePRO-BUS Record Event Properties Window) by either adding or editing 

the ePRO-BUS record event.  To add a new event, drag the desired ePRO-BUS-
controlled device resource onto the schedule window.  To edit, double click the 
ePRO-BUS event row on the schedule.   

Illustration 112, Remote ePRO-BUS Record Event Properties Window 
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3. Complete or edit the event properties fields according to Table 31, Editable Remote 
ePRO-BUS Record Event Properties.  Some of the fields will vary, depending on 

whether you used a “DVD” or “Tape” format to create your ePRO-BUS resource. 

Table 31, Editable Remote ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 

end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure this field displays the PRO-BUS address number assigned to 

the LABvault-HD. 

Setup time Not used 

Output Select “<None>.” 

Length Enter duration of the event in hours:minutes:seconds. 

Preroll  Not used 

Reset time Not used 

Event Date 
and/or Days 

Select an absolute date and/or days that you want to event to occur. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Select “RECORD.” 

Command 

(Event end) 

Choose “STOP.” 

Switchback 
input 

Not used 

Show in 

program 
guide 

Not used 

Comment Not used 

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 
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FIELD DESCRIPTION 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 90).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 

Local ePRO-BUS-Controlled Devices 

A local ePRO-BUS-controlled device is a LABvault-HD that has been directly wired to 

an output on your E-HD2 system’s external switcher.  Connecting a LABvault-HD to 
your switcher provides you with another way to record your E-HD2’s external video 
switch resources.  Perform the following steps to schedule or edit a local ePRO-BUS 

record event: 

NOTE: The E-HD2 should be connected to an external switcher when creating local 

ePRO-BUS record events. 

1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not 

see this tab, go to the “Tools”/”Preferences”/”Application” tab and select the “Show 
WinLGX-LT tab” option. 

2. In order to capture playback from an E-HD2 video switch resource, the video source 

must be scheduled on the external switcher output connected to your LABvault-HD.  
For information on scheduling a video switch resource, refer to “Switch Device 
Resources—External Switcher Configurations Only” on page 172 and “Switch 

Library Resources—External Switcher Configurations Only” on page 188.  This step 
may be performed from either the day tabs or the WinLGX-LT tab, but the latter is 
recommended for consistency. 

3. Open the ePRO-BUS record “Event Properties” window (see Illustration 113, Local 

ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-

BUS record event. To add a new event, drag the desired ePRO-BUS-controlled 
device resource onto the schedule window.  To edit, double click the ePRO-BUS 
event row on the schedule.   
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Illustration 113, Local ePRO-BUS Record Event Properties Window 

 

4. Complete or edit the properties fields according to Table 32, Editable Local ePRO-

BUS Record Event Properties.  Some of the fields will vary, depending on whether 
you used a “DVD” or “Tape” format to create your ePRO-BUS resource. 

Table 32, Editable Local ePRO-BUS Record Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 

field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Title Allows a name up to 31 characters to be typed. 

Device Ensure this field displays the PRO-BUS address number assigned to 

the device you wish to control. 

Setup time Not used 

Output Select “<None>.” 

Length Enter duration of the event in hours:minutes:seconds. 

Preroll  Not used 
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FIELD DESCRIPTION 

Reset time Not used 

Event Date 

and/or Days 

Select an absolute date and/or days that you want to event to occur. 

Time If the event is locked, the event “Time” can be modified.  This is the 
scheduled “On-Air“ time of the event. 

Command 

(Event start) 

Select “RECORD.” 

Command 

(Event end) 

Choose “STOP.” 

Switchback 
input 

Not used 

Show in 

program 
guide 

Not used 

Comment Not used 

Media ID Assign as a library tracking number. 

Field Name 

1–x 

Schedule column headings you may assign. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

comma delimited or Microsoft Excel® formats.  If “No” is selected, then 
you can enable the export function for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 90).  
To toggle between these views, select and deselect the “Maximum 

view” checkbox. 
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SCHEDULING/EDITING LIBRARY RESOURCES 

Adding or editing a library resource event opens windows like the examples shown in 
this section.  Editable event fields are highlighted in each event properties window.  
Click “OK” to submit the event or “Cancel” to abort the add/edit. 

Switch Library Resources—External Switcher Configurations Only 

Dragging a switch library resource onto the schedule reveals a box like Illustration 114, 
Switch Event Properties Window.  Refer to Table 33, Editable Switch Event Properties, 
for a description of the editable event properties. 

Illustration 114, Switch Event Properties Window 

 

Table 33, Editable Switch Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 
the event or uncheck it to unlock the event.  Locking an event causes 

the “Time” field to become enabled, allowing the user to enter a fixed 
execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Device Allows a same format device to be chosen.  Its associated interface 

and input will appear in the corresponding fields. 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air” time of the event. 

Switchback 

input 

If desired, select a video source to be taken to the output at the end of 

the event. 

Show in 
program 

guide 

Select “Yes” from the drop down list to include the scheduled resource 
on the web program guide (see “Viewing Web Program Guide,” on 

page 251).  The scheduled resource will be listed according to its event 
start time and the text entered into the “Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the “Title” 
field is automatically placed in the “Comment” field, but may be 
changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 

is selected, then you can enable printing for all of the resource’s event 
records by checking the “Export/print all records” option under the 

“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 
comma separated values format.  If “No” is selected, then you can 

enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 
Templates” window. 

Maximum 

view 

Each event properties window for a device or library resource item may 

be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 90).  

To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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Digital Video Library Resources 

To preview a digital video library resource’s video before scheduling the resource, either 
double click the resource or right click on the file and select “View Resource” to display 

the file in the WinLGX instant video preview monitor.  For more information on the 
preview monitor, go to the “Using Instant Video Preview Monitor to Display Digital Video 
Files within WinLGX” section on page 155. 

Dragging a digital video library resource onto the schedule reveals a box like Illustration 

115, Digital Video Library Event Properties Window.  Refer to Table 34, Editable Digital 
Video Library Event Properties, for a description of the editable event properties. 

Illustration 115, Digital Video Library Event Properties Window 

 

Table 34, Editable Digital Video Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 

lock the event or uncheck it to unlock the event.  Locking an event 
causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 
“Time” field, causing WinLGX to assign a time to the event that starts 

at the end of the event above it in the schedule. 
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FIELD DESCRIPTION 

In/Out points 

(in 
HH:MM:SS:FF, 

where 
FF=frames) 

To specify where in the selected file you would like playback to begin 

and end, use the “In point” and “Out point” fields.  Either type the 
desired file start and end times into the fields or click either field’s 

ellipsis button to open the clip editor.  Set your in and out points 
according to the following steps: 

1. Specify the clip’s playback in and out points using one of the 
following methods: 

NOTE: If you did not specify a default MPEG player for clip 
editing under “Tools”/”Preferences/Preview Monitor” (see 
page 92 for further instructions), WinLGX asks you to 

select the MPEG 1 or 2 clip editor. If the selected or 
default MPEG player is currently playing a file, WinLGX 
allows you to stop playback and continue with the clip 
editing process or select the other MPEG player.   

 Click the  button to start playing the file and click the 

 or  button at the desired spot. 

 Drag the playback bar to the desired spot and click the 

 or  button. 

 Click the  or  button to move between groups of 

pictures (GOPs) in the MPEG file and click the  or 

 button. 

2. Close the clip creation control panel and add changes to library 

resource by clicking the  button. 

Length The .m2t file library resource length is automatically entered, but it 

may be edited to a value between 6 seconds and 23 hours:59 
minutes:59 seconds. 

Time If the event is locked, the event start “Time” can be modified.  This is 

the scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The “PLAY” command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end 

of the event. 
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FIELD DESCRIPTION 

Show in 

program guide 

Select “Yes” from the drop down list to include the scheduled 

resource on the web program guide (see “Viewing Web Program 
Guide,” on page 251).  The scheduled resource will be listed 

according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 

changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 

event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

a comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum view Each event properties window for a device or library resource item 
may be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 
90).  To toggle between these views, select and deselect the 
“Maximum view” checkbox. 
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Digital Video Loop Library Resources 

Dragging a digital video loop library resource onto the schedule reveals a box like 
Illustration 116.  Refer to Table 35, Editable Digital Video Loop Library Event Properties, 

for a description of the editable event properties. 

Illustration 116, Digital Video Loop Event Properties Window 

 

Table 35, Editable Digital Video Loop Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to 
lock the event or uncheck it to unlock the event.  Locking an event 

causes the “Time” field to become enabled, allowing the user to enter 
a fixed execution time for the event.  Unlocking an event disables the 
“Time” field, causing WinLGX to assign a time to the event that starts 

at the end of the event above it in the schedule. 
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FIELD DESCRIPTION 

Length To change the number of times or length of time you would like the 

file to loop, perform the following: 

1. Select the “Length” field and then click the ellipsis button to 
display the “MPEG Loop Calculator” (see Illustration 84, MPEG 
Loop Calculator).  

2. Enter the number of times you would like the file to loop in the 
“Loop count” field and/or enter a length of time, up to 24 hours, 

in the “Loop length” field. 

Time If the event is locked, the event start “Time” can be modified.  This is 

the scheduled “On-Air“ time of the event. 

Command 
(Event start) 

The “PLAY” command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 

input 

If desired, select a video source to be taken to the output at the end 

of the event. 

Show in 
program guide 

Select “Yes” from the drop down list to include the scheduled 
resource on the web program guide (see “Viewing Web Program 

Guide,” on page 251).  The scheduled resource will be listed 
according to its event start time and the text entered into the 
“Comment” field.   

Comment Enter a unique and descriptive name with up to 31 characters to 

identify the resource on program guides.  The text entered in the 
“Title” field is automatically placed in the “Comment” field, but may be 

changed.  

Print Select “Yes” to enable the resource’s event record for printing.  If 
“No” is selected, then you can enable printing for all of the resource’s 

event records by checking the “Export/print all records” option under 
the “Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into 

a comma separated values format.  If “No” is selected, then you can 
enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum view Each event properties window for a device or library resource item 

may be configured to show different fields under a “minimum” and 
“maximum” view (for instructions, see “Event Editor Tab” on page 
90).  To toggle between these views, select and deselect the 

“Maximum view” checkbox. 
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Digital Video File Playlist Resources 

Dragging a playlist of .m2t digital video files onto the schedule reveals an event 
properties window for each item in the playlist (see Illustration 117 for an example).  

Perform either of the options below:  

NOTE: If the playlist resource is dragged onto a channel switchback between events 

with a shorter time duration than the playlist itself, WinLGX will display a 
dialog asking whether or not you would like to trim/discard the ending playlist 
items to fit the channel switchback or cancel the operation.   

Illustration 117, Playlist Event Properties Window 

 

 Change the editable fields for each resource item according to the tables referenced 
below.  Click “Ok” after changing or reviewing each resource or “Cancel” to abort 

entire operation. 

 Digital Video File: see Table 34 on page 190  

 Looped Digital Video File: see Table 35 on page 193 

 Click “Ok to all” to enter all playlist resource properties into the schedule without 

editing or “Cancel” to abort entire operation. 
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VC List Library Resources 

Dragging a VC list library resource onto the schedule reveals a box like Illustration 118, 
VC List Event Properties Window.  Refer to Table 36, Editable VC List Library Event 

Properties, for a description of the editable event properties. 

Illustration 118, VC List Event Properties Window 

  

Table 36, Editable VC List Library Event Properties 

FIELD DESCRIPTION 

Lock Box At the top of the event properties window, check the “Lock” box to lock 

the event or uncheck it to unlock the event.  Locking an event causes 
the “Time” field to become enabled, allowing the user to enter a fixed 

execution time for the event.  Unlocking an event disables the “Time” 
field, causing WinLGX to assign a time to the event that starts at the 
end of the event above it in the schedule. 

Length The length assigned to the VC list library resource may be changed to 

any length of time up to 23 hours:59 minutes:59 seconds.  If the 
combined length of the resources in the Virtual Channel playlist is less 

than the time in the length field, the resources will be replayed in order 
(looped) as needed to fill the remaining time. 



E-HD2 

Software Operation 

 

LEIGHTRONIX, INC. Page 197 

2018-05-18 WinLGX ver. 7.0.2.52 
 
 

FIELD DESCRIPTION 

Time If the event is locked, the event “Time” can be modified.  This is the 

scheduled “On-Air“ time of the event. 

Command 

(Event start) 

The PLAY command is automatically displayed.   

Command 

(Event end) 

Choose “STOP” or “<None>.”  It will nearly always be “STOP.” 

Switchback 
input 

If desired, select a video source to be taken to the output at the end of 
the event. 

Comment Enter a description with up to 31 characters to display on schedule. 

Print Select “Yes” to enable the resource’s event record for printing.  If “No” 
is selected, then you can enable printing for all of the resource’s event 

records by checking the “Export/print all records” option under the 
“Export/Print Templates” window.  

Export Select “Yes” to allow the resource’s event record to be exported into a 

comma separated values (.csv) format.  If “No” is selected, then you 
can enable the export function for all of the resource’s event records by 
checking the “Export/print all records” option under the “Export/Print 

Templates” window. 

Maximum 
view 

Each event properties window for a device or library resource item may 
be configured to show different fields under a “minimum” and 

“maximum” view (for instructions, see “Event Editor Tab” on page 90).  
To toggle between these views, select and deselect the “Maximum 
view” checkbox. 
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CHANGING CHANNEL SWITCHBACKS 

Adding Digital Video Library Resources to Channel Switchbacks 

WinLGX gives you the option to use digital video library resources (.m2t video files and 

.m2t video playlists) to automatically fill time between all programs on the selected 
channel output within your schedule.  The bottom of the WinLGX schedule window 
includes a “Channel switchback count” that keeps track of the total number of 

unscheduled time slots between programs on the selected channel output tab (see 
Illustration 119, Channel Switchbacks).   

To add a resource to a switchback, drag a digital library resource onto a channel 
switchback and check the “Apply to all switchbacks” option on the resource’s event 

properties window before clicking “Ok” (see Illustration 119 and  

Illustration 120). Whether you selected “By the day” or “By the week” on the 

“Application” tab of the “Preferences” window will determine if the channel switchbacks 
will be filled on just the selected channel output’s day tab or all of the channel’s day tabs 
(see the “Application” tab section of the “Setting WinLGX Viewing and Communication 

Preferences,” on page 86). 

NOTE: If the library resource is shorter in duration than your channel switchbacks, the 

default channel switchback input will be switched to the channel output for the 
time remaining after the resource displays.  You may add multiple library 
resources to your channel switchbacks. 

Illustration 119, Channel Switchbacks 

 

Channel Switchback 

“Channel 

switchback count” 
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Illustration 120, Digital Library Resource Apply to all Switchbacks Option 

 

 

“Apply to all 

switchback” 
Option 
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Changing Channel Switchback Inputs 

The “Channel Switchback Editor” (see Illustration 121), under the WinLGX 
“Tools”/”System Tools” menu, provides a quick way to change the inputs that will switch 

to your channel outputs between programs.  Change the switchback inputs on each of 
your channel/day tab windows to the “Virtual Channel” feature or any of your external 
inputs.  Perform the following steps: 

Illustration 121, "Channel Switchback Editor" 

 

1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel 

Switchback Editor” (see Illustration 121). 

2. Select the channel output/day tab schedule window containing the switchback inputs 

you would like to change by selecting a channel output under “Channel” and a day 
under “Day of week.”  You may select “All” under “Day of week” to select all 

schedule windows for the channel output. 

3. Under “Replace all,” select the switchback input you would like to change. 

4. Use the “With” drop down menu to select a new switchback input. 

5. Click “OK” to make the changes or “Cancel” to abort. 

CHECKING SCHEDULE AND LIBRARY RESOURCES FOR MISSING DIGITAL 
VIDEO FILES 

Ensure your image files’ schedule events and library resources do not contain digital 

video files that have been removed from your E-HD2 system’s remote storage devices 
(USB hard drives and NAS) as described below:  

1. If you have not already done so, open an E-HD2 image file in WinLGX. 

2. Click the  sync icon on the main toolbar or choose the “Tools”/”System 
tools”/”Sync Library Resources” menu item.  Those events containing missing digital 
video files are highlighted in the schedule and a “Sync Library Resources” box pops 
up to report the total number of schedule events and each library resource 

containing digital video files no longer available on the E-HD2 storage device(s).  
Perform any of the following from the pop-up window: 
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 Delete library resources and corresponding schedule events: empty library 

resources and their schedule events may be removed from the E-HD2 image file 
by selecting each resource in the “Sync Library Resources” window and then 
clicking the “Delete” button.  When prompted, click “Yes” to delete the library 

resource and any events scheduled with the resource or “No” to abort. 

 Update status report on pop-up window: if modifications are made to the 

schedule and/or library resources while the “Sync Library Resources” window is 
open, click the “Refresh” button to update the pop-up window.   

 Close pop-up window: click “Done” to close the window. 

Illustration 122, Synced Schedule 
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SENDING E-HD2 IMAGE FILES 

To activate a schedule of event actions, send an image file to each connected E-HD2 

server as follows: 

NOTE: Users must have “Send, receive, rename and delete” rights in order to send 

an image file to an E-HD2 system (refer to “Setting User Account Rights 
(Including WinLGX Password Changes),” on page 73, for more information on 

user rights).   

1. Send an image file to one or more of the currently connected servers according to 

the following steps: 

 One server: ensure the server’s product tab is selected and choose “Send” in the 

“File” menu or click its  icon on the main toolbar.  A dialog box will ask 

whether you want to send the tab’s currently open image to the connected E-

HD2 server.  Click “Yes” to complete the send and open the status box shown in 
Illustration 123. 

 Multiple servers: from any of the product tabs, select “Send all” in the “File” 
menu.  Click “Yes” when prompted to send each open image to its 
server/controller.  You will see a status box like the one shown in Illustration 123 

for each image file. 

Illustration 123, “Send image” Status Box 

 

NOTE: To interrupt the send, click the “Cancel” button.  If the send action appears 
to be stalled, cancel it and check your default location IP address and your 
network connections. 

2. Once each transfer is completed, the E-HD2 system(s) will contain and execute the 
scheduled events.   
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PRINTING SCHEDULES FROM WINLGX 

Perform the following steps to print the current schedule from WinLGX: 

1. Create a print template to select the desired schedule information for printing (see 

“Creating Templates for Exporting/Printing Schedules,” on page 79).  

2. Determine the page layout of your schedule printout (see “Configuring Page Layouts 

For Schedules Printed from WinLGX,” on page 81).  

3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the 

template selection window shown in Illustration 124. 

Illustration 124, “Select Export/Print Template” Window 

   

4. Choose the desired template from the “File name” list in the “Select Export/Print 
Template” Window (see Illustration 124) and click “Open,” or double click the 

template file to open the “Print” window.  Click “Cancel” to abort the print. 

5. In the “Print” window, configure the printer and copy settings according to the 

following steps. Click “OK” to print or “Cancel” to abort the print. 

NOTE: You may have already performed these steps through the “Print Setup” 
window.  See “Configuring Printer and Paper Settings for Schedules 
Printed from WinLGX,” on page 82. 

 “Printer” section: lets you choose the desired printer from a list of your PC’s 
available printers.  When a printer is chosen, its status appears below the printer 

“Name” field. 
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 “Properties” button: click to open a window specific to the printer, so that detailed 

printer settings can be made. 

 “Print range” is fixed at “All.”   

 “Copies” section: choose the number of schedule copies you wish to print.  If you 
choose more than one, checking “Collate” causes the printer to print each copy’s 

pages together and in order.  If “Collate” is unchecked, all of the first pages will 
be printed together, the second pages will be printed together, etc. 

EXPORTING SCHEDULES INTO COMMA SEPARATED VALUES FILES 

Perform the following steps to export schedules into a comma delimited format: 

1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening 

E-HD2 Image Files,” on page 146). 

2. If you have not already done so, create a template (see “Creating Templates for 
Exporting/Printing Schedules,” on page 79). 

3. Select “Save as” in the “File” menu to open the window shown in Illustration 125, 

which allows you to export the loaded schedule as a comma separated values file 
(.csv) as follows: 

Illustration 125, “Save As” Window 

 

a. Select a folder in the “Save in” field.   
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b. Type a name for the exported file in the “File name” field.  If you leave the 
extension off, WinLGX puts it on for you.   

NOTE: If you enter a name of a file that already exists, WinLGX will ask you if 
you want to overwrite it. 

c. Select the .csv export format in the “Save as type” drop down menu.   

d. Click “Save” to open the template selection window shown in Illustration 126.  To 
apply a template to your schedule information, select the desired template and 

either click “Open” or double click the template file to create the export schedule 
.csv file.  The file can then be opened in your database program. 

Illustration 126, “Select Export/Print Template” Window 
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USING CONTROL PANEL TO PERFORM IMMEDIATE DEVICE AND 
SWITCH ACTIONS 

Use the Control Panel to perform unscheduled control actions, such as starting and 

stopping a schedule loaded on the E-HD2 system, controlling your HD/SD digital video 
players/recorders, and, for external switcher configurations, switching an input to a 
different output.   

1. Open the Control Panel window (see Illustration 127) by clicking “Control Panel” 

under the “Tools” menu or  icon on the main toolbar.   

NOTE: The routing switcher and external switch device information displayed in 
the control panel depends on the switcher configuration (see “Configuring 
the Switch Type of an E-HD2,” on page 97) and the external switch device 

configurations (see “Creating External Switch Device Resources,” on page 
114). 

Illustration 127, Control Panel Window 

 

2. If desired, sort the device icons by right clicking in the “Devices” column and 
selecting one of the sorting filters in the right-click menu that appears (see 

Illustration 128, Control Panel Device Sorting Menu). 

Illustration 128, Control Panel Device Sorting Menu 
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3. Perform any of the following steps: 

 Start/stop a schedule (see page 207). 

 Force a switch and view switcher status (see page 208). 

 Select a device in the “Devices” column and refer to one of the following sets of 
control steps: 

 “Controlling Internal Digital Video Players 1 and 2,” on page 209 

 “Controlling Internal Digital Video Recorders,” on page 217 

 “Controlling ePRO-BUS Record Devices,” on page 222 

4. When finished, click “Close” to exit the Control Panel. 

STOP/START A SCHEDULE 

Once an E-HD2 image file with a schedule of events has been sent to your E-HD2 
server (see “Sending E-HD2 Image” on page 202), you may use the stop/start schedule 
button on the bottom of the Control Panel window (see Illustration 127, Control Panel 
Window) to perform the following: 

 Stop the currently running schedule by clicking the “Stop Schedule” button. 

 Restart the current schedule by clicking the “Start Schedule” button. 
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EXTERNAL SWITCHER CONFIGURATIONS ONLY—PERFORMING FORCED 
SWITCHES AND VIEWING SWITCHER STATUS 

Immediately switch one of your inputs to an output by using the “Switch” portion of the 

Control Panel.  If you are using an external switcher with more than 256 input/output 
crosspoints, your inputs/outputs will automatically be displayed in the list view.  For 
those with 256 or fewer input/output crosspoints, the “Switch” will be configured 

according to the option selected on the “Application” tab of the “Preferences” window 
(see page 86 for more details). 

“Buttons” View 

On the “Switch” section of the Control Panel window (see Illustration 129, Control Panel 

“Switch” “Buttons” View, for an example), locate the output you want to switch your input 
to and then click the input button in the corresponding row. 

Illustration 129, Control Panel “Switch” “Buttons” View 

 
 

The input button will turn green when clicked if the switch is valid or red if the switch is 
invalid.  To the right of each output icon is a box showing the currently selected input.     

“List” View 

To switch an input to an output from the “List” view (see Illustration 130, Control Panel 
“Switch” "List" View), single click on an input and then the output you wish to switch it to.  
When you have both an input and output highlighted, click the “Take” button to make 

the switch.  The “Current Input” column will then change to show the input has been 
routed to the output.  If valid video is present, you will see “Yes” in the “Valid” column of 
the selected output.  Any breakaway audio source accompanying the video will be 
indicated in the “Break Away” column.  
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Illustration 130, Control Panel “Switch” "List" View  

 

CONTROLLING INTERNAL DIGITAL VIDEO PLAYERS 1 AND 2 

Select either the digital video player 1 or 2 icon in the Control Panel window’s “Device” 
list and click the “Play” tab to display the corresponding device control panel (see 

Illustration 131, Digital Video Player Control Panel).  

Illustration 131, Digital Video Player Control Panel 

 

The following is a list of the operations that may be performed: 

 “Queuing a File” on page 210 

 “Looping an MPEG File” on page  211 

  “Playing a File” on page 211 

 “Queuing the Next File” on page 212 

 “Stopping a File” on page 212 

 “Pausing a File” on page 212 

 “Creating a Library Video Clip Resource” on page 213 

“Play” 

Tab 



E-HD2 

Software Operation 

 

Page 210 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

 “Activating the Virtual Channels” on page 215 

 “Selecting and Displaying Virtual Channel Playlist Files” on page 215  

Queuing a File 

Open the “Select File” window for .m2t digital video files as follows: 

1. Click the ellipsis button next to “Queued Video File” to open the “Select File” video 
window (see Illustration 132, “Select File” Video Window).   

Illustration 132, “Select File” Video Window 

 
 

2. Select the storage device containing the desired .m2t digital video file from the 
“Storage device” drop down list. 

3. To display a file’s properties and view the clip before completing the selection, either 
right click on the file or click “Properties” to display the instant video preview monitor.  

For more information on the preview monitor window, go to the “Using Instant Video 
Preview Monitor to Display Digital Video Files within WinLGX” section on page 155. 

4. Select the desired file by double-clicking or highlighting the file and clicking “OK.”  

The digital video player control panel will then display the properties of the selected 
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file under “Queued Video File” (see Illustration 133, Queued Digital Video File 
Properties).  

NOTE: Click “Cancel” to abort any selections and close the “Select File” video 
window. 

Illustration 133, Queued Digital Video File Properties 

 
 

Looping a Digital Video File 

Click the “Loop” checkbox to set up a .m2t digital video file for repeat playback.  Once 

the  button is clicked, the file will play over and over, from beginning to end, until the 

 button is clicked or a scheduled event occurs. 

Playing a File 

Click the  button under “Audio/Video” for a .m2t digital video file to play the most 
recently queued file.  The activated file moves into the current position on the control 
panel.  While a .m2t digital video file is playing, the counter displays the file playback 

time in HH:MM:SS:FF (FF=frames).  The counter displays “**” in the FF or frames place 
holder during playback (furthest to the right) (see Illustration 134), showing the current 
frame number when the file is paused. 

Illustration 134, Digital Video File Playback Counter 

 

Queuing the Next File  

While a file is playing, another file may be loaded into the “Queued Video File” position 
(see “Queuing a File” on page 210 and Illustration 135, Queued and Currently Playing 
Files). 

NOTE: Clicking the  button while another file is playing will cause the queued file 
to override the current file and begin playing. 
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Illustration 135, Queued and Currently Playing Files 

 

Stopping a File 

Click the  button under “Audio/Video” for a .m2t digital video file to stop a file.  

Stopping a file unloads it from the “Current Video File” position. 

Pausing a Digital Video File 

Click the  button under “Audio/Video” to pause a digital video file in the “Current 
Video File” position.  When a digital video file is paused, the counter displays the current 
frame number in the FF or frames place holder (furthest to the right) (see Illustration 

136).  To reactivate the file, click the  button again. 

Illustration 136, Digital Video File Playback Counter with Frame Number Displayed 
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Creating a Library Video Clip Resource 

Use the digital video clip creation panel to create a library resource for a clip of a .m2t 
file. 

 
1. Click the “Clip” tab to display the clip creation panel (see Illustration 137). 

Illustration 137, Digital Video Clip Creation Panel 
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2. Load the file you would like to use to create a clip according to the following steps:  

a. Click the button next to “Storage device” to display the “Select File” window (see 
Illustration 138). 

Illustration 138, “Select File” Window 

 

b. Select the storage device containing the desired digital video file from the 

“Storage device” drop down list. 

c. To display a file’s properties and view the clip before completing the selection, 

either right click on the file or click “Properties” to display the instant video 
preview monitor.  For more information on the preview monitor, go to the “Using 
Instant Video Preview Monitor to Display Digital Video Files within WinLGX” 

section on page 155. 

d. Single click on the desired file to highlight it and either double click or click “OK” 

on the bottom of the window to finish loading the file. 

3. Specify the clip’s playback start point using one of the following methods: 

 Click the  button to start playing the file and click the  button at the 
desired spot. 

 Drag the playback bar to the desired spot and click the  button. 
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 Click the  or  button to move between groups of pictures (GOPs) in the 

.m2t file and click the  button. 

4. Specify the clip’s playback end point using one of the methods outlined above for 

selecting an in point and click the  button. 

5. To move to the selected in point and/or out point, click the  or  button. 

6. Preview the clip before airing by clicking the  button. 

7. Once you have specified the desired in and out points, create a new library item for 
the clip by clicking the “Add to library” button to display the “Add to library folder” 

window (see Illustration 139).  Perform the following steps: 

Illustration 139, “Add to library folder” Window 

 

a. Select the library folder in which the corresponding MPEG file library resource 

will be created. 

b. If desired, rename the clip in the “Resource name” field. 

c. Click “OK” to add the clip to the library or “Cancel” to abort the changes. 

Activating the Default Virtual Channel Playlists 

Before a Virtual Channel’s default “Current” playlist will display, the Virtual Channel 

must be activated through a schedule event or the Control Panel’s  
button.  Select the Virtual Channel’s MPEG player in the “Devices” column and then just 
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click the  button to display the playlist currently saved in the Virtual 
Channel’s default “Current” playlist preset.   

 

Selecting and Displaying Virtual Channel Playlist Files 

Virtual Channel playlist files can be displayed from the WinLGX control panel according 
to the following steps.   

1. Select the MPEG player you want to display the playlist file’s digital resources in the 
“Devices” column. 

2. Click the ellipsis button next to the “Force Start Virtual Channel” button to display the 

"Select Virtual Channel List" Window shown in Illustration 140.   

Illustration 140, "Select Virtual Channel List" Window 

 

3. Select a Virtual Channel playlist as follows: 

 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection.  

Once a playlist file selection is made, the playlist will immediately display. 
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CONTROLLING INTERNAL DIGITAL VIDEO RECORDERS 

Select one of the digital video recorder icons in the control panel window’s “Device” list 
to display the corresponding recorder’s control panel (see Illustration 141, Digital Video 
Recorder Control Panel).  Perform the following steps: 

Illustration 141, Digital Video Recorder Control Panel 

 

1. Select the digital video file recording parameters: 

a. Check the “Record CC data” box to capture any closed caption data from the 
source during recording.  Closed captions are hidden in the video signal and 
decoded for display on televisions with built-in decoders or televisions connected 

to external decoders. 

b. Select one of the following record overwrite options: 

 “Never”: WinLGX does not allow a file entered with an existing filename to 

record and displays an error message  

 “Always”: WinLGX records over an existing file with the same name 

NOTE: Selecting the “Always” option disables the “Add to library” option. 

 “Create unique”: if an existing filename is entered, WinLGX automatically 
records the file under the first 14 characters of the original filename followed 

by “yy/mm/dd-hh/mm/ss” (yy/mm/dd is the file record date specified as 
year/month/ day and hh/mm/ss is the file record time in 
hours/minutes/seconds) 

c. Select the volume of the drive on which you would like to store the recorded file 
from the “Storage Device” drop down list. 

d. Under “File,” enter up to 27 characters (no spaces) for the filename. 

e. Select one of the user-defined record presets for the desired recording quality.  
See “Configuring Digital Video Recording Presets,” on page 108, for more 
information on defining the recording quality settings. 

f. If you would like a library resource for the .m2t digital video file added to the 
“Library” tab window, select the “Add to library” option.  Once the digital video 

recorder stops, WinLGX displays the “Add to library” window (see Illustration 
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142).  Select the library folder in which the corresponding digital video file library 
resource will be created. 

 NOTES:  WinLGX will not create a library resource for a file that possesses 

the same video filename and length as a pre-existing library 
resource. 

  If the new file possesses the same title as another resource, but 

has a different video filename and/or length, WinLGX will copy the 
new file to the library with a numbered increment added to its title.  
For example, if this is the first time you have reused the title of a 

pre-existing library resource, WinLGX will add the new file to the 
library under the name “title01.” 

Illustration 142, “Add to library folder” Window 

 

2. Start and stop recording through one of the following options: 

 All Switch Type Configurations (with and without external switcher): 

 Manual Start/Stop 

a. Click the  button to begin recording the source connected to the E-HD2 
digital video recorder. 

b. When you have captured all of the desired video/audio, click the  
button to stop recording. 

 Direct Connect Configuration (no switcher):  

 Manual Start/Automated Stop 

a. Click on the “MPEG Ingest” button on the digital video recorder control 

panel to display the window shown in Illustration 143. 
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Illustration 143, Digital Video Ingest Window for a “No Switch” Configuration 

 

b. If desired, set a delay time for the digital video recorder from the 

“Recorder delay” field.  Once recording is initiated, this is the time that will 
elapse before the recorder begins capturing video/audio from the source 

connected to the recorder input.  WinLGX displays a countdown window 
that allows you to cancel the delay. 

c. Enter a record time in the “Length” field.   The digital video recorder 
automatically stops at the end of the record time. 

d. Start recording by clicking the  button. 

e. Click the “Close” button to exit the window. 

 External Switcher Configurations Only: 

 Switcher Panel 

a. From the switcher panel on the bottom of the Control Panel window (for an 
example, see Illustration 129, Control Panel “Switch” “Buttons” View), go 

to the digital video recorder output row and click on the external input 
switch resource that you would like to record.  

b. Click the  button to begin recording. 

c. Once the file reaches the desired length, click the  button to stop the 
recording.   

 Ingest Option 

Use the ingest option to digitally record playback from your switch resources 

connected to your external switcher inputs.  This option also allows you to 
delay the activation of the selected E-HD2 digital video recorder and set a 
record time length.  Perform the following steps: 

a. Click on the “MPEG Ingest” button on the digital video recorder control 

panel to display the window shown in Illustration 144, “MPEG Ingest” 
Window. 
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Illustration 144, “MPEG Ingest” Window 

 

b. From the “Input/Source” drop down list, select the external switch resource 
that you would like to record. 

c. Under “Destination,” select the E-HD2 digital video recorder that you 
would like to use to record the selected input. 

d. If desired, set a delay time for the digital video recorder from the 
“Recorder delay” field.  Once recording is initiated, this is the time that will 

elapse before the recorder begins capturing video/audio from the external 
switch resource.  WinLGX displays a countdown window that allows you to 
cancel the delay. 

e. If desired, enter a record time in the “Length” field.   The input device and 
digital video recorder automatically stop at the end of the record time. 

f. Start recording by clicking the  button. 

g. If you did not enter a record time in the “Length” field, stop the digital video 

recorder by clicking the  button. 

h. Click the “Close” button to exit the window. 

MONITORING AN MPEG FILE RECORDING 

Once a digital video file recording has been initiated from a scheduled event or the 
control panel, WinLGX allows you to watch the recorded video on the control panel’s 

confidence monitor.  Select an MPEG recorder icon in the control panel window’s 
“Device” list to display the corresponding recorder control panel and then click the 
“Monitor” tab (see Illustration 145).  After the recording is initiated, the confidence 

monitor automatically begins to display the recorded video footage after the number of 
seconds specified on the “Preview Monitor” tab of the “Preferences” window (default is 
10 seconds; see page 92 for more details).  To control playback of the recorded video, 

refer to the information below on the confidence monitor controls: 
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Illustration 145, MPEG Recorder Confidence "Monitor" Tab Window 

 

 “Recorder” Time Display: shows the total length of the recording file in 

hours:minutes:seconds 

 Play/Pause Button: click to toggle between pause and playback of the video. 

 Step Forward Button: moves the video forward one GOP each time it is clicked. 

 Seek End Button: moves current playback position to the end of the recorded file. 

 Volume Control: click and drag the volume control slider to adjust video’s volume.  

The volume control defaults to lowest audio setting. 

 Mute Button: click the mute button to toggle between silenced and restored audio. 

 “Current Recording File” Properties: provides the name, length, video bit rate, 

audio sample rate, and storage device of the selected MPEG file. 
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CONTROLLING EPRO-BUS RECORD DEVICES 

Select the ePRO-BUS record device icon in the “Device” list to display the 
corresponding control panel (see Illustration 146, Control Panel: ePRO-BUS Record 

Device Control) with the following information:  

Illustration 146, Control Panel: ePRO-BUS Record Device Control   

 

  “Format”: type of device.  This should be a tape or DVD device. 

 “Interface type”: always a “PRO-BUS” device interface for ePRO-BUS record 

devices 

 “Device”: PRO-BUS address number assigned to the LABvault-HD recorder you 

wish to control.  The PRO-BUS address numbers are configured in the E-HD2 web 
interface (see the “Configuring ePRO-BUS Settings” section on page 274 for more 
details). 

 “Input”: should be set to “<None>,” as ePRO-BUS record devices are outputs 

Immediately start/stop a record on your LABvault-HD player/recorder according to the 

following steps.  Start a remote ePRO-BUS record session if the LABvault-HD is 
networked to your E-HD2 server.  A local ePRO-BUS record should be initiated for 
ePRO-BUS record devices that are directly wired to your E-HD2’s external switcher.  

 Remote ePRO-BUS Record: click the record icon to initiate a record on your 

LABvault-HD.  When you have captured the desired footage, click the stop record 
icon. 

 Local ePRO-BUS Record: for LABvault-HDs directly connected to your E-HD2’s 

external system switcher, you will first need to switch a video source over to your 
LABvault-HD before initiating a record.  Perform the following: 

1. Use the control panel’s switcher subpanel underneath the ePRO-BUS device 
controls to switch a video source input to the output connected to your LABvault-
HD. 

2. If applicable, activate playback on your video source by selecting the input device 
in the left-hand column of the control panel.  Use the corresponding control panel 

controls to start playback on the video source input. 
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3. Return to the recorder controls by clicking the ePRO-BUS device controls in the 
control panel’s left-hand column.  Click the record icon to initiate a record on your 

LABvault-HD.  When you have captured the desired footage, click the stop 
record icon.  

MANAGING STORAGE OF DIGITAL VIDEO AND IMAGE FILES 

Manage your digital video .m2t files for one or more LEIGHTRONIX digital 
servers/controllers with the WinLGX “Storage Manager” window.  Add and delete the 
files to and from your local (PC/network) and remote (E-HD2 internal hard drive, USB 
hard drives, and NAS) storage devices.   

Open the Storage Manager window by selecting “Storage Manager” from the “File” 

menu or click the  icon on the main toolbar to open the window shown in Illustration 

147, “Storage Manager” Window.   

Illustration 147, “Storage Manager” Window 

 

Perform any of the file management operations listed under the following sections: 

 “Choosing File Storage Devices” on page 224 

 “Managing Digital Files” on page 224 
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 “Previewing Video Files” on page 226 

When you are finished, click the “Close” button to exit the “Storage Manager” window.  

CHOOSING FILE STORAGE DEVICES 

1. The left side of the Storage Manager window allows you to access both your local 
and remote storage devices.  Select a storage device as follows: 

 “Local storage device”: select to access files stored on your PC or network.  Use 
the “Drive” drop down box and file navigation window to find and select your 

videos or graphics files. 

 “Remote storage device”: select to access the internal and external storage 

devices for your E-HD2.  Specify the E-HD2 storage device you wish to access 
as follows:   

a. Select an E-HD2 server from the “Controller” drop down box.  All WinLGX 
connected E-HD2 servers will appear in the drop down box, allowing you to 
access the remote storage devices for the E-HD2 that you choose.  

b. From the “Device” drop down box, select the hard drive or network attached 
storage (NAS) device containing the digital video files you wish to access. 

2. The right side of the “Storage Manager” window provides access to your E-HD2’s 

remote storage devices.  Refer to the remote storage device selection instructions in 
the step above. 

3. Manage your digital video .m2t files according to “Managing Digital Files” on page 
224.  When you are finished, click the “Close” button to exit the “Storage Manager” 
window. 

MANAGING DIGITAL FILES 

 Select one or more files 

Selected files are highlighted with a blue stripe. 

 Single file: single click on the file 

 All Files: right click on a file and select “Select All” from the right-click menu. 

 Block of Files Next to Each Other: while holding down the “Shift” key on your 

keyboard, single click two files to select both files plus any in between. 

 Random: hold down the “Ctrl” key on your keyboard and click on the desired 

files. 

 Copy files from one storage area to another 

Copying leaves the original files in their current locations.  Select one or more files 
and then right click on the selected file(s) to display the right-click menu.  Select 

“Copy” from the menu.  A dialog box (see Illustration 148, “Storage Manager” Copy 
Dialog Box) will ask whether or not you would like the file copied to the storage 
device selected on the opposite side of the Storage Manager screen.  Depending on 

the target destination for your copied file, you will be given one of the following 
options: 
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 Create a library resource for a local file: if you are copying a local file to your E-
HD2 server, you may click the “Add to library” option to create a WinLGX library 

resource for the file. 

 Export XML data to local storage area: if you are copying a digital file from your 

LEIGHTRONIX server to a local storage area, you will see an “Export XML data” 
checkbox in place of the “Add to library option.”  The “Export XML data” 
checkbox is reserved for future use. 

Illustration 148, “Storage Manager” Copy Dialog Box 

 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving a 

file fragment which should be deleted.  Cancel only when necessary.  When 
multiple files are finished, a summary dialog appears giving the final results. 

 Move file(s) from one storage area to another 

Moved files are removed from their original locations and transferred to the selected 

storage areas.  Select one or more files and then right click on the selected file(s) to 
display the right-click menu.  Select “Move” from the menu.  Depending on the target 

destination for your moved file, you will be given one of the following options:  

 Create a library resource for a local file: if you are moving a local file to your E-

HD2 server, you may click the “Add to library” option to create a WinLGX library 
resource for the file. 

 Export XML data to local storage area: if you are moving a digital file from your 

LEIGHTRONIX server to a local storage area, you will see an “Export XML data” 
checkbox in place of the “Add to library option.”  The “Export XML data” 

checkbox is reserved for future use. 

NOTE: Clicking the “Cancel” button on the FTP window stops the transfer, leaving a 

file fragment which should be deleted.  Cancel only when necessary.  When 
multiple files are finished, a summary dialog appears giving the final results. 

 Delete files from your storage areas 

 Select desired file(s) and press the “Delete” key. 

 Right click on the desired file(s) and select “Delete” from the right-click menu.   

A pop-up box will appear, showing the name and path of the digital file to be deleted.  

If you are deleting the file off of a remote internal or external storage device for your 
E-HD2 server, the Storage Manager will also allow you to select an option that 
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automatically deletes any library resources and events containing the file.  Click 
“Yes” to complete the deletion or “No” to abort. 

Illustration 149, “Storage Manager” Digital File Delete Option 

 

 Rename files 

Right click on desired file(s) and select “Rename” from the menu. Enter new volume 
name in the “Rename File” window. 

NOTE: LEIGHTRONIX servers will not display files with filenames containing 
spaces. 

 Create library resources for your digital videos 

Right click on the desired file(s) on one of your remote storage devices and select 

“Add to library” from the right-click menu to display the “Add to library folder” Window 
shown in Illustration 142.  Select the library folder you want to contain the 
corresponding library resource(s) and click “OK.” 

NOTES:  WinLGX will not create a library resource for a file that possesses the 

same filename and length as a pre-existing library resource. 

  If the new file possesses the same title as another resource, but has a 

different filename and/or length, WinLGX will copy the new file to the 
library with a numbered increment added to its title.  For example, if this is 

the first time you have reused the title of a pre-existing library resource, 
WinLGX will add the new file to the library under the name “title01.”  

 Rename remote storage device(s) 

In a remote storage device file listing on either side of the Storage Manager window, 

right click and select “Rename volume.”  Enter the new volume name in the “Rename 
Volume” window and click “OK” to make the change or “Cancel” to abort. 

 Refresh file listing 

Click the “Refresh” button to update the files on the Storage Manager window. 

PREVIEWING VIDEO FILES 

WinLGX gives you the option to display the digital video files in the Storage Manager 
“Video” listings within the instant video preview monitor by either double clicking the file 

or right clicking on the file and selecting “View” in the right-click menu.  For more 
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information on the preview monitor, go to the “Using Instant Video Preview Monitor to 
Display Digital Video Files within WinLGX” section on page 155. 
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RETRIEVING LOG FILES 

Each E-HD2 server keeps track of everything done to or by it in internal log files.  The 
E-HD2 log files cannot be deleted, written to, or manipulated by a user in any way; 

however, once downloaded, you can then save, write, and format the file just like any 
other text document. 

WinLGX allows you to access the E-HD2 log files with the “Get log” menu item under 

the “File” menu or  icon on the main toolbar.  Selecting one of these options will 
display the "Select Controller Log File" Window shown in Illustration 150.   

Illustration 150, "Select Controller Log File" Window 

 

At the top of the “Select Controller Log File” window, you will see three different tabs for 

accessing the E-HD2 log files.  Access the E-HD2 event, system, and firmware log files 
as follows: 

Event Log Files 

Especially useful for tracking playback events, each E-HD2 server logs its event 

execution status into a .CSV file spreadsheet on a monthly basis (see Illustration 151).  
The execution results for each event are logged under the spreadsheet’s “Result” 
column, with “Ok” indicating the event was successfully executed and “Exception” 

meaning the event was not executed.  For those events with the “Exception” status, 
refer to the “Report” column on the spreadsheet for more information about why the 

Log File Tabs 
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event did not occur.  Also logged are each event’s date and time of execution, format 
type, device type, and other major event descriptors. 

Illustration 151, Example of Event Log File 

 

To access event log files, perform the following steps: 

1. Click on the “As played” tab on the “Select Controller Log File” window.   

2. Single click on the desired .CSV file to select it and then click “OK.”   

3. A “Save as Played log File” window will open.  Save the .CSV f ile to a new file path 
or use the WinLGX default log file path (Shared 

Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).   

4. Click the “Save” button to save the file to your chosen file path.  The “Save as 

Played log File” and “Select Controller Log File” windows will close.   

5. Navigate to the file path for the saved .CSV file and open it in Excel. 
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System Log Files 

The E-HD2 system activity log files are called “EVENTS.LOG” and “OLDEVNTS.LOG.”  
When a new E-HD2 server is powered on for the first time, it creates a file called 

“EVENTS.LOG.”  The E-HD2 system will continually write to this file until it reaches 7 
MB.  Once “EVENTS.LOG” reaches 7 MB, the E-HD2 system will rename it to 
“OLDEVNTS.LOG” (deleting the previous “OLDEVNTS.LOG”) and then create a new 
“EVENTS.LOG.”  This ongoing cycle ensures that recent events are always logged.  

The E-HD2 system log files are useful in identifying specific events within the system, 
such as when a particular program aired, when a user logged in from a remote terminal, 
and more.  To view a system log file, perform the following steps: 

1. Click on the “System” tab on the “Select Controller Log File” window (see Illustration 

152, “System” Tab on the “Select Controller Log File” Window).  

Illustration 152, “System” Tab on the “Select Controller Log File” Window 

 

2. Select one of the log files from the listing and then download log records based on 
the following filter options: 

 “Date/Time filter”: check box to enable the date/time fields 
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 Within a range of dates and times: use the start/end date and start/end time 

fields to download all log records within the selected dates and times  

 No filter: click the “Raw data (no filter)” button to download all log records  

 Digital video playback events of low severity: click the “MPEG Play” filter 
preset button to download all noncritical log records containing the text “MPEG 

Play” in their action descriptions 

 Severity of event action: download all log records with the event severity 

code selected with the “Severity filter” drop down menu 

 Group action type: download all log records with the group action type 

selected with the “Group filter” drop down menu 

 Action descriptions: download all log records with action descriptions 
containing one of the text options selected with the drop down menu under 

“Text filter.”  To create your own action description filter, select “User text” from 
the drop down menu and type in the desired keyword in the “User text” 
comment field. 

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired 
location, the log is displayed in a text editor of your choosing (see Illustration 153, 

Example of Log File).  This will also turn off the log LED  that appears on the E-
HD2 system’s front panel when a severity 1 or 2 event action is logged. 

NOTE: The default viewer is Notepad, but the viewer can be changed from the 

“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 
WinLGX Viewing and Communication Preferences,” beginning on page 
86).  
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Illustration 153, Example of Log File 

 

Each action performed through or by the E-HD2 server is recorded in the log file along 

with its date and time, severity, and action type.  The following information identifies and 
explains each part of the “EVENTS.LOG” file in more detail. 

 Date 

 Time 

 Severity of event action—event actions are classified according to the following 
three levels of severity: 

 0: events that occur during the course of normal operations 

 1: warning events 

 2: critical events or failures 

 Types of actions recorded: 

 Diagnostic: E-HD2 system health and status  

 File: actions involving files, typically file transfers (also E-HD2 image 

send/retrieve)  

 Front Panel: actions performed based on commands given by user through 

the front panel of the E-HD2 system 
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 MPEG: digital video player/recorder actions 

 Remote: actions performed based on commands given by user from the 
WinLGX control panel 

 Schedule: actions performed based on user-created schedule  

 Switcher: actions based on switcher events and functions 

 USB drive: actions pertaining to the external USB hard drives 

 Web: actions performed through the E-HD2’s web interface 

 Descriptive message of actions performed 
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Firmware Update Log Files 

Each E-HD2 server creates log files that specifically track firmware updates.  
LEIGHTRONIX uses firmware update logs to troubleshoot unsuccessful firmware 

updates.  A separate firmware update log is created each time you firmware update 
your E-HD2 system and is named after the corresponding firmware update file.  To 
open a firmware update log file, perform steps 1–3 under “System Log Files.” 

1. Click on the “All” tab on the “Select Controller Log File” window (see Illustration 154). 

NOTE: System and event log files can also be accessed from the “All” tab.  

Illustration 154, "All" Tab on the "Select Controller Log File" Window 

 

2. Select one of the log files from the listing and then download log records based on 
the filter options as described in step 2 under “System Log Files.”  

3. Click “OK” to open the “Save Log File” dialog box.  Once saved to the desired 
location, the log is displayed in a text editor of your choosing (see Illustration 153, 
Example of Log File). 

NOTE: The default viewer is Notepad, but the viewer can be changed from the 

“Tools”/“Preferences”/”Application” tab (for more details, see “Setting 

Firmware Update 
Log Files 
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WinLGX Viewing and Communication Preferences,” beginning on page 
86). 

UPDATING FIRMWARE/SOFTWARE 

LEIGHTRONIX places the most current firmware/software files for each LEIGHTRONIX 
product on its Support Center website.  Save the update files to an accessible directory 

on your PC. 

UPDATING E-HD2 SERVER 

1. Open the WinLGX software and log in to your E-HD2 system (see “Opening WinLGX 
and ” on page 142). 

2. Choose “Controller” under the “Tools” menu to open the “Controller” window shown 

in Illustration 155. 

Illustration 155, Controller Window 
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3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware 

file” window shown in Illustration 156.   

Illustration 156, “Choose Controller Firmware File” Window  

 
- 

4. Navigate to and open the current .lpf file to update your E-HD2 server’s firmware 

and, if needed, your web interface.  Once you have selected and opened the file, the 
“Select firmware options” window is displayed (see Illustration 157).  Leave all 
options checked and click “OK” to save your firmware update options or “Cancel” to 

abort the changes and close the dialog.  If you would like to reopen the window, click 
the “Options” button under “Firmware update.” 
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Illustration 157, “Select Firmware Options” Window 

 

5. Click “Update” to continue the firmware update.  Click “Yes” when prompted to start 

the update. 

6. Once the update has completed, click “OK” to apply the changes and reboot the E-

HD2 server.  You will be logged out and the “Site Manager” window will be 
displayed. 

NOTE: You will not be able to log back in until the E-HD2 system finishes 
rebooting.  The update may take several minutes. 

7. After the E-HD2 system finishes rebooting, log back in and confirm the E-HD2 

system has been upgraded to the latest firmware version in the “Site Manager” 
database.   

UPDATING WINLGX SOFTWARE 

1. Close WinLGX. 

2. Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to 

install the latest version of the client software.  

3. Click “OK” to continue WinLGX update. 

4. Follow the prompts to complete the installation. 
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WEB CONTROL 

ABOUT THIS SECTION 

Access your E-HD2 from the Internet with its built-in, password-protected web interface.  

The E-HD2 web interface provides the ability to create looping playlists for display 
between, as, or in place of scheduled programming, transfer digital video files to 
specified destinations, record digital video files, and view the E-HD2’s status, program 

guide, and log files.     

The E-HD2 web interface works on any computer with Microsoft Internet Explorer 8 and 

above, Google Chrome, Firefox, Safari, and Opera.  While the interface may work with 
other browsers, full functionality is not guaranteed.  No special software installation is 

required.      

Up to 32 different users can log into the E-HD2 web interface.  All user accounts may 

view E-HD2 system status.  Some user accounts have access to additional web 
interface features, as outlined in Table 37.  The “admin” user account has access to all 

web interface features.  See “Setting User Account Rights (Including WinLGX Password 
Changes)” on page 73, for instructions on assigning rights to user accounts. 

Table 37, User Rights with Access to Additional Web Interface Features 

Description 
“Administrator” 

Right 

“MPEG/Slide 
control 
(record/ 
setup)” 

Right 

“No file 
access” 

Right 

“Receive only,” 
“Send and receive,” 
and “Send, receive, 
rename, & delete” 

Rights 

Configure file transfer 
destinations  

  
  

Transfer digital video files 
to another E-HD2 or FTP 

destination  
  

 

Display program guide 
 

   

View log files 
 

   

Manage “System” settings 
 

   

Create looping Virtual 
Channel playlists  
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OPENING AND LOGGING INTO WEB INTERFACE 

1. Open the E-HD2 web interface through one of the following steps: 

 If you already have WinLGX open and are logged into the desired E-HD2’s IP 

address, select “Web interface” from the “Tools” menu or click on the  toolbar 
icon to open the web interface in your default web browser. 

 Enter your E-HD2’s IP address into the address bar of Internet Explorer (see 
Illustration 158). 

Illustration 158, Accessing E-HD2 from Internet Explorer 

 

2. A login prompt will appear (see Illustration 159, Login Prompt).  Enter your 

username and password. 

NOTE: Your username and password are assigned through WinLGX.  Refer to 
“Setting User Account Rights (Including WinLGX Password Changes),” on 
page 73 for information on adding/editing usernames and passwords.  

Illustration 159, Login Prompt 
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If login is successful, the window shown in Illustration 160, “System Dashboard” Screen, 

opens.  All web-based control functions are accessible from the menu sidebar. 

Illustration 160, “System Dashboard” Screen 

 

“SITE INFORMATION” 

Displays your E-HD2’s site information, including serial number and firmware version. 

“STORAGE” 

Displays the storage availability on your E-HD2’s internal hard drive and for any 
connected USB drive and NAS storage device. 

MPEG PLAYER/RECORDER STATUSES 

Displays the properties of the files currently playing on MPEG Players 1 and 2 and the 

files currently being recorded by MPEG Recorders 1 and 2.  Click the tab of the desired 
MPEG Player or Recorder to display the corresponding information. 
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“NETWORK SETTINGS” 

Displays your E-HD2’s network addresses. 

“SWITCHER STATUS” 

If using an external switcher, provides a quick overview of which of your inputs are 
currently switched to the switcher outputs. 

MANAGING DIGITAL VIDEO FILES 

The “File Management” and “File Destinations” screens provide the ability to control 

digital video file transfers from the Internet.   

SETTING UP TRANSFER DESTINATIONS 

Easily control where your recorded files are transferred by clicking the 
“DESTINATIONS” button and using the “File Destinations” screen tabs.  Recorded files  

may be automatically or manually transferred to another E-HD2 server/controller and/or 
third party server with FTP capabilities, as outlined below.  The settings apply to each 
recording session until you change them. 

E-HD2 Video Server Destination 

If you own another LEIGHTRONIX E-HD2 video server, you can send your digital video 

files to any of the other server’s storage volumes.  Enter the destination E-HD2 server’s 
IP address, username, and password along with the name of the volume that you want 
to store the files.  The names of your storage volumes can be viewed in the WinLGX 

“Storage Manager” window.  Complete the remaining settings according to the steps 
below and click the “Apply Changes” button when you have finished (refer to Illustration 

161). 

1. “Verify Connectivity”: after entering your E-HD2’s IP address, username, and 

password, click the “Verify Connectivity” button to ensure your E-HD2 can connect to 
the destination server. 

2. “Automatic Upload”: when selected, files will be automatically transferred to the 
specified E-HD2 after each recording session. 

3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 

hours of the week your E-HD2 will transfer files to your destination E-HD2.  Single 
click each hour segment on the timeline to toggle transfer capabilities on or off 
(green = on, red = off). 
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Illustration 161, "E-HD2" File Destinations Tab 

 
 

Server with FTP Capabilities 

Push your files to another LEIGHTRONIX or third party video server with FTP 

capabilities.  Enter your server’s IP address, username, and password along with the 
name of the destination path.  Complete the remaining settings according to the steps 
below and click the “Apply Changes” button when you have finished (refer to Illustration 

162).  

1. “Verify Connectivity”: after entering your server’s IP address, username, and 

password, click the “Verify Connectivity” button to ensure your E-HD2 can connect to 
the destination server. 

2. “Automatic Upload”: when checked, MPEG broadcast files will be automatically 

transferred to the specified server after each recording session. 

3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which 

hours of the week your E-HD2 will transfer files to your destination server.  Single 
click each hour segment on the timeline to toggle transfer capabilities on or off 

(green = on, red = off). 
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Illustration 162, "FTP Server" File Destinations Tab 

 



E-HD2 

Web Control 

 

LEIGHTRONIX, INC. Page 245 

2018-05-18 WinLGX ver. 7.0.2.52 
 
 

MANUALLY TRANSFERRING DIGITAL VIDEO FILES 

Click the “Files” menu button to display the screen shown in Illustration 163.  The “File 
Management” screen displays a “Video Files” listing of the digital video files on your E-

HD2’s storage volumes and a video file transfer queue.   

NOTE: Ensure that any destinations you want to receive files have been configured 
on the “File Destinations” screen. 

Illustration 163, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

“Video Files” Listing 



E-HD2 

Web Control 

 

Page 246 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

VIEW FILE INFORMATION 

Hovering over a filename in the “Video Files” listing with your mouse pointer will bring 
up a popup that shows the file’s storage volume, filename, length, size, and date of 

creation.  Except for storage volume, this information is also displayed in each row of 
the “Video Files” listing. 

ADD FILES TO TRANSFER QUEUE 

Under the “Video Files” listing, use one of the following methods to add a digital video 
file to your transfer queue: 

 Drag the desired file to the right side of the screen 

 Double click the desired file 

 Single click on the digital video file you would like to transfer and click the “Add” 
button to transfer the file to any configured destination(s) 

 Right click on the file and select a configured destination(s) from the pop-up 
menu (see Illustration 163).   

RENAME FILES ON DIGITAL STORAGE DEVICES 

Under the “Video Files” listing on the left side of the screen, either single click on the file 
you would like to rename and then click the “Rename” button or just right click on the file 

and select “Rename” from the menu that appears (see Illustration 164).  In the “Rename 
File” window that appears, enter a new filename of up to 27 alphanumeric characters, 
no spaces, and click “Ok” to accept the change or “Cancel” to abort.    

Illustration 164, Pop-Up Menu for "Video Files" Listing on the "File Management" Screen 

 

DELETE FILES FROM STORAGE DEVICE/TRANSFER QUEUE 

• Storage Device:  under the “Video Files” listing, either single click on the file you 
would like to delete and then click the “Delete” button or just right click on the file and 

select “Delete File” from the pop-up menu.  Click “Yes” when prompted to delete the 
file or “No” to abort. 
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• Transfer Queue: to delete a single file under “Video Transfers,” either single click 
on the file you would like to delete and then click the “Remove” button or just right 

click on the file and select “Remove Transfer” from the pop-up menu.  To remove all 
files from the transfer catalog, either single click on a file and then click the “Remove 
All” button or just right click on the file and select “Remove All Transfers” from the 

pop-up menu.  Click “Yes” when prompted to delete the file(s) or “No” to abort. 

CHANGE FILE TRANSFER DESTINATIONS 

Change the destination of any file in the “Video Transfers” queue by right clicking on the 

file and selecting one of the add/remove options in the popup menu (see Illustration 
165).  The remove options de-select current file transfer destinations, while the add 
options transfer the file to the corresponding destinations.   

Illustration 165, Pop-Up Menu for "Video Transfers" Listing on the "File Management" Screen 

 

STOP FILE TRANSFERS 

End a file transfer from the “Video Transfers” queue by either single clicking the 
filename and then clicking the “Remove” button or right clicking on the file and selecting 

the remove option for the file’s intended destination.  To end all file transfers, either click 
the “Remove All” button or right click on a file and select the “Remove All Transfers” 
option. 
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MANAGING LOG FILES 

Each E-HD2 server keeps track of everything done to or by it in internal log files which 
are accessible from its web interface.  Click the “LOGS” menu button to display the list 

of current logs for your E-HD2 on the “Log Files” screen (see Illustration 166 and Table 
38).  

Illustration 166, "Log Files" Screen 

 

Table 38, Log File Types 

Log File Type Description 

Playback Event Each playback event log file is a monthly record of digital video 

playback events scheduled on your E-HD2 (see Illustration 
151 for an example).  Playback event log filenames are 
formatted as “PLyear-month.CSV.” 



E-HD2 

Web Control 

 

LEIGHTRONIX, INC. Page 249 

2018-05-18 WinLGX ver. 7.0.2.52 
 
 

Log File Type Description 

Tracked in each playback event log are playback event dates 

and start times, format types, device types, and other major 
event descriptors, including the status of each event.  Event 
execution results are logged in the file’s “Result” column, with 

“OK” indicating the event was successfully completed and 
“Exception” meaning the event did not occur.  For those 
events with the “Exception” status, refer to the “Report” column 

in the file for more information about why the playback event 
was not executed. 

System Event The E-HD2 activity log files are called “EVENTS.LOG” and 

“OLDEVNTS.LOG” (see Illustration 166 for example).  When a 
new E-HD2 is powered on for the first time, it creates a file 

called “EVENTS.LOG.”  The E-HD2 will continually write to this 
file until it reaches 7 MB.  Once “EVENTS.LOG” reaches 7 
MB, the E-HD2 will rename it to “OLDEVNTS.LOG” (deleting 
the previous “OLDEVNTS.LOG”) and then create a new 

“EVENTS.LOG.” This ongoing cycle ensures that recent 
events are always logged. 

The system event logs are useful in identifying specific events 
occurring on the E-HD2, such as when a particular program 
aired, user logins, file transfers, all schedule event actions, 

and more.  Refer to page 232 for more detailed information on 
system event logs. 

Firmware Update The E-HD2 server creates log files that specifically track 

firmware installations.  LEIGHTRONIX uses firmware update 
logs to troubleshoot unsuccessful firmware updates.  A 

separate firmware update log is created each time you update 
your E-HD2 server and is named after the corresponding 
firmware update file.   

Disk Diagnostics The “scan_C.log” file displays information from the most recent 

E-HD2 server drive scan performed with the “Disk Diagnostics” 
utility.  The “scan_C.log” file is automatically overwritten each 

time you run a drive scan. 

   

Manage your E-HD2 server log files according to the following: 

SAVE/OPEN A LOG FILE 

From the top panel on the “Log Files” screen, single click on the desired log file to select 
it and then click the “Save” button to display an open/save file dialog box.  Either open 

or save the selected log file on your computer or network as a .txt file. 
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SEARCH A LOG FILE 

Search for specific entries within either of the event or firmware logs.  From the top 
panel on the “Log Files” screen, single click the desired log file to display the “Find” box 

and corresponding log information.  Enter your search term into the “Find” box and click 
the “Search” button to filter out any entries not containing the search term.  Use the 
“Previous” and “Next” buttons to move up and down between entries in the log file.  

DELETE A LOG FILE 

From the top panel on the “Log Files” screen, single click the desired log file to select it 
and then click the “Delete Log” button.  A popup box will appear, asking whether or not 
you wish to delete the file.  Click “Yes” to delete or “No” to abort. 
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VIEWING WEB PROGRAM GUIDE 

View upcoming programs on the current E-HD2 schedule from its web interface, a web 

browser, or your own website. 

VIEWING PROGRAM GUIDE WITHIN THE WEB INTERFACE 

1. Click the “Program Guide” menu button to display a program guide screen like the 
example shown in Illustration 167.   

Illustration 167, Web Interface Program Guide Screen 

 

2. From the “Channel” drop down menu, click one of the channel outputs to only 
display the programming lineup for the selected channel or click “All Channels” to 

display the programming schedule for all WinLGX channel tabs. 



E-HD2 

Web Control 

 

Page 252 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

3. From the “Mode” drop down menu, select “Day” if you would like to view 
programming for just one day in your schedule (see Illustration 167) or choose 

“Week” to view programming for all seven days of your schedule (see Illustration 
168).  If you choose “Week,” the “Day Headers” buttons are enabled on the toolbar.  
Selecting “on” will cause each day’s programming to be displayed under separate 

day, date, and program time headings, as shown in Illustration 168.  If the “Day 
Headers” option is set to “off,” each day’s programming will be displayed under one 
set of date, day, and program time headers. 

Illustration 168, Program Guide Screen in Week Mode with Day Headers "ON" 

 

Day Headers 
ON 
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4. For the “Day” mode view, click on a day of the week to view programming for the 
corresponding weekday.  If you selected the “Week” mode, clicking a day button will 

sort your programming schedule by the selected day. 

5. If you wish to display the program start time down to the second, click the “Show 

Seconds” “on” button.  The default option is “off.” 

VIEWING PROGRAM GUIDE FROM A WEB BROWSER OR YOUR OWN WEBSITE 

The E-HD2 program guide frame has been validated by the W3C to be a valid XHTML 
1.0 transitional document.  It has been successfully tested in the following browsers:  

 Microsoft Internet Explorer 
 Google Chrome 
 Mozilla Firefox 

 Opera 
 Apple Safari  

Web Browser 

Users without access to the E-HD2 web interface schedule display can use a web 

address to view the current E-HD2 schedule online.   To obtain the web address and 
display the program guide in a web browser, perform the following steps: 

1. Click the “Program Guide” menu button to display your E-HD2’s program guide.  

2. Click the URL link on the “Program Guide” screen as shown in Illustration 169 to 
open your E-HD2 program guide in a separate browser tab window. 

Illustration 169, Program Guide URL Link 

 

3. If necessary, edit the following variables (shown in red) in the web address to 

change the programming display: 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea

ders=0”: change to the IP address of the E-HD2 server/controller containing the 
schedule you wish to display 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0”: 

 “channel=0”: displays the programming on all channels 

Program Guide URL 

http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
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 “channel=1”: displays the programming on channel one 

 “channel=2”: displays the programming on channel two 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea

ders=0”: to show programming for one day, leave mode as “day” or to display up 
to seven days of your schedule’s programming, enter “week” 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea

ders=0”: to show the day of the week without the date on top of your 
programming display, change “date” to “day” and then enter the first three letters 
of the day whose programming you wish to view from the current schedule 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea

ders=0”: if you are using the “week” mode, you may change the “headers” value 
to “1” to display each day’s programming under separate day, date, and program 
time headings (see Illustration 168) 

 “http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=fri&hea
ders=0&secs=0”: to display each program’s start time down to the second, 
change the “secs” value to “1” 

 “http://10.255.11.142:50001/websched.php?channel=1&date=09/17/2007”: to 

show programming for a specific date, change “day” to “date” followed by the 
month, day, and year.   

4. Distribute the web address as a link or with instructions to paste the address into the 

address bar of one of the supported web browsers. 

Your Own Website 

NOTE: The E-HD2 web interface program guide is linked to Port 50001, preventing 
unauthorized users from accessing the other interface features.  If you need 
to select a different port number for the program guide, refer to “Editing Web 
Schedule Port,” on page 45. 

First make the program guide publically accessible by forwarding Port 50001 through 
your firewall to your E-HD2 server/controller.  Port forwarding requires an external, 
public IP address which is configured in the router to have certain ports forwarded to the 

E-HD2’s internal IP Address. Forward Port 50001 of the external IP address to your E-
HD2 server/controller, then point your website to the external address. 

Once your program guide has been made publically accessible, add the web interface 
program guide embed code to one of your own web pages according to the following 

steps: 

1. Click the E-HD2 web interface’s “Program Guide” button to display the 

corresponding screen. 

2. To display the embed code, click on the “Embed Script” arrow (see Illustration 170).   

http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
http://10.255.11.142:50001/websched.php?channel=1&mode=day&day=
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Illustration 170, Program Guide "Embed Script" 

 

3. Drag your mouse cursor across the code to highlight and select it, then 
simultaneously press the “Ctrl” and “C” keys on your keyboard to copy the code.   

4. Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” 
and “V” keys on your keyboard. 

5. If desired, customize the code for your website by editing the embed code variables 

as described below: 

 var channel = "1"; 

 "channel=0": displays the programming on all channels 
 "channel=1": displays the programming on channel one 

 "channel=2": displays the programming on channel two  

 var mode = "day"; 

 var mode= "day": displays programming for the current day 
 var mode= "week": displays seven days of programming 

 var headers = "0"; 

 var headers= "0": displays the day’s programming under one set of date, day, and program 

time headers  
 var headers= "1": displays each day’s programming under separate day, date, and program 

time headings 

 var showSecs = "0"; 

 var headers= "0": hides the second of each program’s start time  
 var headers= "1": displays the second of each program’s start time 

6. Upload the web page with the embed code to your web server.  The embedded 

program guide will dynamically update to display your current program schedule. 
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USING VIRTUAL CHANNELS 

OVERVIEW 

NOTE: Only users with the “administrator” right are able to access the Virtual 
Channels feature. 

The Virtual Channels provide looping playlists consisting of your digital video files and 

any external switcher input devices.  Virtual Channel playlists are convenient for filling 
time when a schedule is not running or between scheduled programs and also can be 
easily scheduled as program events.  

Click on the “Virtual Channel” menu button to access the E-HD2 web interface Virtual 

Channel editor (see Illustration 171).  The two content boxes on the right side of the 
Virtual Channel editor contain the resources that may be added to your playlists, as 
described in Table 39, Virtual Channel Playlist Resources. 

Illustration 171, Virtual Channel Editor 

 

Table 39, Virtual Channel Playlist Resources 

CONTENT BOX DESCRIPTION 

MPEG Files Displays a list of the digital video files on your attached digital 
media storage devices. 

External Input Displays a list of your external switcher inputs.  The number of 
available inputs in this field will correlate to the number of inputs 

Virtual Channel 
Selection Buttons 

Playlist 
Resources 
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CONTENT BOX DESCRIPTION 

on the external switcher connected to the E-HD2. 

NOTE: This option is disabled if you have not set up an 
external switcher configuration for your E-HD2 server in 
WinLGX. 

 
Set up and use your Virtual Channels according to the following 
steps: 

1. Select Virtual Channel 1 or 2 by clicking the corresponding “Channel” button on top 

of the Virtual Channel editor screen (see Illustration 171, Virtual Channel Editor on 

page 256). 

2. Refer to the following sections for playlist management instructions: 

 “Creating/Modifying Virtual Channel Playlists,” on page 258 

 “Saving Virtual Channel Playlists,” on page 262 

 “Deleting Virtual Channel Playlist,” on page 270 

3. Activate Virtual Channel playlists for display according to “Displaying Virtual Channel 
Playlists,” on page 266. 
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CREATING/MODIFYING VIRTUAL CHANNEL PLAYLISTS 

A Virtual Channel playlist is a collection of playback resources from the four content 
boxes on the right hand side of the Virtual Channel editor.  There are three types of 
Virtual Channel playlists—day/default playlist presets/configuration files (.vcf), playlist 

files (.vc), and the “Current” playlist.  The day presets allow you to create and save a 
separate playlist for automatic display in the empty time slots between scheduled 
programming on each day of the week, while the “Default” preset acts as a backup 

playlist for any empty day presets.  Unique day/default playlist presets can be saved for 
each week in Virtual Channel configuration files (.vcf).  Individual playlists can also be 
saved as Virtual Channel playlist files (.vc) for scheduling as program events or 

immediate display through the WinLGX control panel.  The “Current” playlist contains 
the playlist resources that were last submitted to your E-HD2 server either by clicking 
the “Current” button or automatically through a day/default preset or a scheduled Virtual 
Channel playlist file (.vc).  Any playlist may be displayed in place of a schedule. 

Create or edit playlists with up to 100 resources per list according to the following steps: 

1. If you are modifying an existing playlist, load it according to the corresponding set of 
steps below.  Otherwise, skip to step 2 on page 260. 

 Load Resources from a Virtual Channel Playlist File (.vc) or a Day/Default 
Preset: from the “Preset” drop down box at the top of the Virtual Channel editor, 

select a playlist file or day/default preset to load the corresponding playback 
resources into the playlist window (see Illustration 172).   

Illustration 172, Loading a Playlist Preset into the Virtual Channel Playlist Window 

 

Preset Drop Down Box 

Virtual Channel 

Playlist Window 
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 Load Resources from a Virtual Channel Configuration File (.vcf): 

a. Click the “Advanced” button to display the “Advanced Virtual Channel 
Options” window and then click the “List Config” tab to display the window 

shown in Illustration 173. 

Illustration 173, "List Config" Tab on "Advanced Virtual Channel Options" Window 

 

b. Single click to select a configuration file in the file listing and then click the 
“Load” button to populate the “Preset” drop down menu’s day/default presets 

with the file’s playback resources or “Cancel” to abort. 

c. From the “Preset” drop down box, select a day/default preset to load the 

playlist you wish to modify (see Illustration 172). 
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2. Add, remove, and re-order resources in the Virtual Channel playlist window 
according to Illustration 174 and Table 40.  Virtual Channel playlist resources will 

play in the order listed.  Display durations for each resource type are as follows: 

NOTES:  Resources highlighted green in the “MPEG Files” and “External 

Input” content boxes are in the current Virtual Channel playlist.   
  Red highlights on Virtual Channel playlist items indicate resources 

that are no longer available on the E-HD2 server’s storage areas 
and will be skipped during playlist playback.   

 MPEG: each video clip displays for its file duration 

 External Input: when an external switcher input resource is added to the playlist 

window, each resource is automatically assigned a default duration.  To modify, 
refer to step 3 in this section on page 262. 

Illustration 174, Virtual Channel Playlist 

 

Preset Drop Down Box 

Virtual Channel 

Playlist Window 

4 Content Boxes of 

Playback Resources 
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Table 40, Creating Playlists in the Virtual Channel Playlist Window 

Action Steps 

Select a single 
resource 

Single click the resource.  A successfully selected resource 
will be highlighted in orange. 

Select multiple 

resources 

Perform one of the following: 

 Select a group of consecutive resources: single click 

the first resource in the group you wish to select and 
then hold down your keyboard’s “Shift” key and single 
click the last resource.  All resources between the first 

and last clicked resources will also be selected. 

 Select a non-consecutive group of resources: hold 

down your keyboard’s “Ctrl” key and then single click 
on each of the desired resources.   

Successfully selected resources will be highlighted in 
orange. 

Add a single resource 

to a Virtual Channel 
playlist 

Individual playback resources may be added to the Virtual 

Channel playlist window in one of the following ways: 

 Select a single playback resource and then click the  
add button. 

 Double click the resource.   

Add multiple 

resources from one 
content box to a Virtual 

Channel playlist 

Select multiple resources in the same content box and then 

add to a Virtual Channel playlist window by clicking the  
add button. 

Remove resources 
from a playlist 

Select one or more playback resources in the playlist 

window and then click the  remove button.  Alternatively, 

double clicking a resource in the playlist will also remove 
the resource. 

Remove all resources 

from a playlist 
Click the  clear list button to remove all resources from 

the playlist window.  When prompted, click “Yes” to delete 
the resources from the playlist or “No” to cancel. 

Change the order of a 

playlist 
 One row at a time: select one or more playback 

resources in the playlist window and click the  move 

up or  move down buttons to move the resource(s) 
up or down in the list by one row. 

 First and last playlist positions: select one or more 

playback resources in the playlist window and click the 

 move to top or  move to bottom buttons to move 
the resource(s) all the way to the first or last rows in 
the playlist. 
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Action Steps 

Depending on the operation performed, the remaining 

playlist resources will be pushed above or below the 
moved resources. 

Copy and paste 

resources within and 
between playlists 

Select one or more playback resources in the playlist 

window and click the  copy button.  Click the  paste 
button to add the resources to the bottom of the currently 
loaded playlist preset. 

NOTE: Copy and paste are not available in the Chrome 
and Firefox browsers. 

3. If any switcher input resources were added to the playlist, access each resource’s 

display duration setting by double clicking its length on the playlist window.  The 

resource’s length field will become active, allowing you to type a new length into the 
hours, minutes, and seconds fields.  When you are finished, click off the playlist 
window to complete the change. 

4. Once you have finished creating or modifying your playlist, either continue to “Saving 

Virtual Channel Playlists” on page 262 to learn about the Virtual Channel Editor’s 
options for saving a playlist or click the “Current” button to add the resources into the 
“Current” playlist and submit the resources to your E-HD2 server.  The “Current” 

playlist overrides any previously submitted playlist resources and will immediately 
display if a scheduled program or control panel event is not currently being displayed 
and if the Virtual Channel has already been previously activated through a WinLGX 

schedule or control panel command (see “Displaying Virtual Channel Playlists,” on 
page 266, for more details). 

NOTE: If the Virtual Channel is inactive when the “Current” playlist is submitted, 
the playlist will not be displayed.  The “Current” playlist is overwritten with 
the resources currently in the Virtual Channel playlist window each time 

the “Current” button is clicked or when a day/default playlist preset or 
Virtual Channel playlist file (.vc) is submitted. 

SAVING VIRTUAL CHANNEL PLAYLISTS 

A separate Virtual Channel playlist can be saved for one or more weekdays (seven 

days total plus a default playlist to cover empty days) as well as in files not tied to 
specific days. 

1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on 
page 258. 

2. Save the playlist according to one of the following save options: 
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 Save as a Virtual Channel Playlist File (.vc): save one playlist in a file for 

display in place of scheduling programming or as a scheduled program as 
follows: 

 If you edited an existing .vc file, click the  save button.  

 For new .vc files or to overwrite an existing .vc file, click the  save list as 
button on top of the Virtual Channel playlist window to display the "Save 

Preset" Window shown in Illustration 175 and perform the following steps: 

Illustration 175, "Save Preset" Window 

 

a. Perform one of the following save options: 

o Create a new file: type up to 27 alphanumeric characters without 

spaces into the “File Name” field.   

o  Save over an existing file: single click to select an existing file to 
replace.   

b. Click the “Save” button to save your Virtual Channel playlist file or 
“Cancel” to abort. 



E-HD2 

Web Control 

 

Page 264 LEIGHTRONIX, INC. 

WinLGX ver. 7.0.2.52 2018-05-18 
 

 Save as a Day or Default Preset: save one playlist in a preset for display in 

place of scheduled programming or to fill time between scheduled programs on a 
specific day as follows: 

 If you edited an existing preset, click the  save button.  

 To overwrite a preset, click the  save list as button on top of the Virtual 
Channel playlist window to display the "Save Preset" Window shown in 

Illustration 175 and perform the following steps: 

a. In the preset file listing, single click on either a day preset to save the 

playlist for display on the specified day or the “Default” preset to save the 
playlist for display when the E-HD2 encounters an empty day preset. 

b. Click the “Save” button to save your playlist in a Virtual Channel preset or 

“Cancel” to abort. 
c. If desired, save one or more of your day/default presets in a Virtual 

Channel configuration file (.vcf) as described in the following subsection. 

 Save as a Virtual Channel Configuration File (.vcf): save a collection of up to 

seven weekday playlist presets and one “Default” preset in a .vcf file as follows: 

a. Click the “Advanced” button on the Virtual Channel editor window and then 
click the “List Config” tab to display the window shown in Illustration 176. 

Illustration 176, "List Config" Tab Window 
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b. Perform one of the following save options: 

 Create a new file: type up to 27 alphanumeric characters without spaces 
into the “File Name” field.   

  Save over an existing file: single click to select an existing file to replace.   

c. Click the “Save” button to save your configuration file or “Cancel” to abort.  

3. If desired, immediately activate your Virtual Channel and display your playlist 

according to “Displaying Virtual Channel Playlists,” on page 266. 
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DISPLAYING VIRTUAL CHANNEL PLAYLISTS 

Virtual Channel playlists may be displayed in place of a schedule, as programs within a 
schedule, or in the unfilled time between scheduled programs.  The MPEG player and 
output that display your Virtual Channel playlists are determined by your switch type as 
follows: 

 “No Switch” Type:  
Virtual Channel 1 playlists as well as playlist files added to the first channel 

output tab will be displayed by MPEG Player 1 on the output assigned to 
WinLGX Channel/Output Tab 1, while the Virtual Channel 2 playlist and playlist 
files added to the second channel output tab will be displayed by MPEG Player 2 

on the output assigned to WinLGX Channel/Output Tab 2 (see Illustration 177, 
Virtual Channel WinLGX Tab Assignments). 

Illustration 177, Virtual Channel WinLGX Tab Assignments 

 

 External Switcher:  

In your WinLGX E-HD2 image file, assign the external switcher outputs that you 
wish to display Virtual Channel content to the E-HD2 MPEG player inputs and 

first two WinLGX channel/output tabs.  For more information, see “Editing 
Internal Digital Video Playback and Recording Device Resources,” on page 110 
and “Configuring the Switch Type of a,” on page 97. 

If an E-HD2 image file with switcher settings has not been sent to your E-HD2 
and a Virtual Channel playlist is then activated, the Virtual Channel will use the 
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MPEG player and channel output defined in its web interface default switcher 
settings. To set up default switcher settings for each of your Virtual Channels, 

perform the following steps:     

1. Click the “Advanced” button on the Virtual Channel editor to display the 
“Advanced Virtual Channel Options” window.   

2. Click the “General” tab to display the window shown in Illustration 178.  Select 
an MPEG input and channel output from the drop down menus for each 
Virtual Channel.   

 “MPEG Input”: choose the input on your external switcher that is 

connected to the E-HD2 MPEG player for each Virtual Channel 

 “Channel Output”: choose the output you wish to air each Virtual 
Channel’s active playlists. 

Illustration 178, Default External Switcher Settings 
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3. Click “Save” to make your selections or “Cancel” to abort.  Both buttons also 
close the window. 

The following sections describe each method for displaying your Virtual Channel 
playlists: 

 “Displaying a Playlist between Scheduled Program Events” on page 268  

 “Displaying a Playlist as a Scheduled Program Event” on page 269 

  “Displaying a Playlist in Place of a Schedule” on page 269 

DISPLAYING A PLAYLIST BETWEEN SCHEDULED PROGRAM EVENTS 

Saved day/”Default” Virtual Channel playlists will automatically fill the channel 

switchbacks on the WinLGX schedule editor’s first two channel output tabs.  Virtual 
Channel 1 playlists are tied to E-HD2 MPEG Player 1 and the first WinLGX channel 
output tab and Virtual Channel 2 playlists are tied to the second MPEG player and 
channel output tab (see Illustration 177, Virtual Channel WinLGX Tab Assignments). 

To display a Virtual Channel playlist between scheduled programs, perform the 
following steps: 

1. If your day/default playlist(s) are saved in a Virtual Channel configuration file (.vcf), 

load it in the E-HD2 web interface as follows: 

a. Click the “Advanced” button to display the “Advanced Virtual Channel Options” 
window and then click the “List Config” tab to display the window shown in 

Illustration 173. 

b. Single click to select a configuration file in the file listing and then click the “Load” 
button to add the file’s playlists into the Virtual Channel’s day/”Default” presets. 

2. In your WinLGX schedule file (.nmg), be sure to do the following: 

a. Enable your Virtual Channels for use as WinLGX switchback resources by 
selecting “Yes” from the “Virtual Channel” drop down menu in the “System 

Configuration” properties (see “Configuring the Switch Type of a,” on page 97).  

b. Perform any of the following to fill channel switchbacks on the first two WinLGX 

channel output tabs: 

 During configuration of WinLGX: when selecting your switchback inputs for 

the first two WinLGX schedule tabs (see “Configuring the Switch Type of a” 
on page 97 for further instructions), choose “Virtual Channel” as the video 

source in the “Switchback Input” field.   

 During scheduling: when scheduling a resource on the first two channel 

output tabs, the switchback input may be changed to “Virtual Channel” in the 
resource’s event properties window. 

Your E-HD2 server will automatically display the current day playlist preset, or 

the “Default” playlist preset if the day playlist is empty, during a channel 
switchback at the beginning of the schedule or following the end of a scheduled 
event.   
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DISPLAYING A PLAYLIST AS A SCHEDULED PROGRAM EVENT 

Add a Virtual Channel playlist file (.vc) to your programming lineup with the “VC List” 
library resource.  Refer to page 138 for information on creating a Virtual Channel playlist 

file library resource and page 196 for instructions on scheduling the library resource. 

DISPLAYING A PLAYLIST IN PLACE OF A SCHEDULE 

Any type of Virtual Channel playlist may be displayed 24/7 in place of a schedule as 

described in the following steps.       

NOTE: An active Virtual Channel playlist will continue to loop on air until another 

playlist is activated, the MPEG player is stopped from the WinLGX control 
panel, or a scheduled digital program event is sent to the E-HD2 server. 

 “Current” Virtual Channel Playlist 

1. Add/remove resources to the Virtual Channel playlist window (see 
“Creating/Modifying Virtual Channel Playlists,” on page 258). 

2. Click the “Current” button to submit the resources as your “Current” playlist.  

3. If the “Current” playlist does not display, go to the WinLGX Control Panel, select 
the Virtual Channel’s MPEG player, and click the “Force Start Virtual Channel” 
button. 

 Virtual Channel Day/Default Playlist Presets 

1. Select one or more day/default playlists through one of the following options: 

 Select the current day’s playlist or “Default” from the “Preset” drop down 
menu. 

 Select multiple day/default playlists through a configuration file (.vcf) as 
follows: 

a. Click the “Advanced” button to display the “Advanced Virtual Channel 
Options” window and then click the “List Config” tab to display the window 

shown in Illustration 173. 

b. Single click to select a configuration file in the file listing and then click the 

“Load” button to add the file’s day/default playlists to the Virtual Channel 
editor. 

2. If the current day or default preset does not display, go to the WinLGX Control 
Panel, select the Virtual Channel’s MPEG player, and click the “Force Start 
Virtual Channel” button. 

 Saved Virtual Channel Playlist File 

1. Go to the WinLGX Control Panel and select the MPEG player you want to display 
the playlist’s digital video resources.   

2. Click the ellipsis button to open the “Select Virtual Channel List” window.   

3. Select a Virtual Channel playlist as follows: 

 Double-click the desired file to accept selection and close “Select Virtual 
Channel List” window.  

 Select the desired file and click “OK” to accept or “Cancel” to abort selection.  
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Once a playlist file selection is made, the playlist will immediately display. 

DELETING VIRTUAL CHANNEL PLAYLIST FILES 

To remove a saved Virtual Channel playlist file (.vc) from your E-HD2 server, perform 
the following steps: 

1. From the “Preset” drop down menu, select the playlist file you wish to delete. 

2. Click the  icon on the Virtual Channel toolbar. 

3. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel 
the action and close the popup. 
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EDITING E-HD2 SITE NAME AND LOCATION 

NOTE: Only the “admin” account is able to see the “System Management” 
screen. 

Customize the “Site Name” and “Site Location” on the E-HD2 web interface “System 
Dashboard” screen and WinLGX “Controller Site Manager” window.  Click the 
“SYSTEM” button to display the “System Management” screen and then click the “Site 

Information” tab.  Enter a new identification name for your site into the “Site Name” field 
and a location description in the “Site Location” field.  Click “Apply Changes” to change 
the information on your “System Dashboard” screen. 

Illustration 179, “Site Information” Screen 
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CHANGING E-HD2 SYSTEM TIME 

Click the “SYSTEM” button to display the “System Management” screen and then click 
the “Site Information” tab.  “E-HD2 Time” shows the date and time currently on your 
server.  To change the E-HD2 server’s date/time, perform one of the following:  

 Sync your E-HD2 server’s date and time to your computer’s current date and time by 
clicking the “Set” button next to the “Computer Time” field. 

 Manually change the E-HD2 server’s date and time by editing the “Manual” fields as 

follows: 

1. Use the up/down arrows to adjust the time fields. 

2. Click on the date field and select a new date in the calendar that appears.  

3. Click the “Set” button to make the changes. 

CHANGING THE FRONT PANEL AND “ADMIN” PASSWORDS 

Click the “SYSTEM” button to display the “System Management” screen and then click 
the “Security” tab. See Illustration 180 and refer to the following: 

 “System User (admin)”: the “admin” user account password provides access to 
your E-HD2 server through WinLGX and its web interface.  Enter the new 

password into both fields and then click the “Change Password” button to make 
the change. 

 “Front Panel Password”: click on a combination of five arrows for the new front 
panel password.  Then, click “Save” to accept new password or “Clear” to cancel.  

Illustration 180, "Security" Tab Screen 
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MAINTAINING USB DRIVES AND INTERNAL HARD DRIVE 

Use the E-HD2 web interface disk diagnostics feature to automatically fix many 
common File Allocation Table (FAT) errors that may impair your E-HD2’s USB drives 
and internal hard drive or cause data loss on the drives.  LEIGHTRONIX recommends 

using the feature on a monthly basis to ensure optimal drive performance as well as any 
time you discover file/drive errors in your log files or notice drive performance issues.   

NOTE: The disk diagnostics process does not fix physical hardware degradation.   
 

To run the disk diagnostics feature, log into the web interface and click the “SYSTEM” 
button and then the “Maintenance” tab to display the screen shown in Illustration 181.   

Illustration 181, "Maintenance" Tab Screen 

 

Click the “Disk Diagnostics” button and then select the popup menu’s “Yes” option to 

perform the disk check process.  When the diagnosis has been completed, a log file 
describing any errors discovered and actions performed will be added to your system’s 
“EVENTS.LOG” file (see the “System Log Files” section on page 230 for more 

information on the “EVENTS.LOG” file).   

UPDATING SYSTEM FIRMWARE 

LEIGHTRONIX places the most current E-HD2 firmware files on the LEIGHTRONIX 

Support Center website.  Save the update files to an accessible directory on your 
computer or network. 

Once you have downloaded the E-HD2 firmware update file from the Support Center, 
open the web interface and click the “SYSTEM” menu button.  Select the “Maintenance” 
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tab and use the “Browse” button to navigate to the saved location of the firmware file 
(see Illustration 181).  Click the “Update” button to download and install the firmware file 
onto your E-HD2 server. 

CONFIGURING EPRO-BUS SETTINGS 

The ePRO-BUS control feature allows you to send ePRO-BUS start/stop RECORD 

control commands over your Ethernet network to up to 16 LABvault-HD digital video 
player/recorders.  To get started, the ePRO-BUS feature must be configured for your E-
HD2 server and each LABvault-HD according to the following steps: 

 LABvault-HD: refer to the device’s manual for instructions. 

 E-HD2 Server:  

1. Click the “SYSTEM” menu button and then the “ePRO-BUS” tab to display the 
window shown in Illustration 182.  

Illustration 182, "ePRO-BUS" Tab Screen 

 

2. For each of your LABvault-HD player/recorders, select a PRO-BUS address and 

enter the LABvault’s static IP address. When you schedule or immediately send 
ePRO-BUS commands in WinLGX, your LEIGHTRONIX server uses the PRO-
BUS address assignments to determine which recording devices should receive 

the commands.  The “PRO-BUS Address” and “IP Address” fields can be edited 
once they are double clicked and any changes you make are saved when you 
click off the row.  Make your changes based on the following control options:  
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 Assign each LABvault-HD IP address to a separate PRO-BUS address: 
control each of your LABvault-HDs individually by entering the IP address for 

each of your LABvaults on a separate “PRO-BUS Address” line. 

 Assign the same PRO-BUS address to multiple LABvault-HDs: to control 

multiple LABvault-HDs from one PRO-BUS address, enter each LABvault’s IP 
address on a separate line and then make the PRO-BUS address numbers 
the same for the desired LABvault-HD IP addresses.   

 Give the same PEGvault-SD or LABvault-SD IP address to different PRO-
BUS addresses: allows you to control one PEGvault-SD/LABvault-SD 
independently and as part of a group of PEGvaults/LABvaults. 

3. Click the “Enable” checkbox for each LABvault-HD you want to receive ePRO-
BUS commands from your E-HD2 server. 

4. Create a “DVD” or “tape” device resource in WinLGX for each of your ePRO-
BUS-controlled devices.  Use the device resources to schedule (see 
“Scheduling/Editing ePRO-BUS-Controlled Device Resources,” on page 183) or 

immediately (see the control panel subsection on “Controlling ePRO-BUS Record 
Devices,” on page 222) start/stop recording on your LABvault-HDs. 
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CONFIGURING TOTAL SHARE SETTINGS 

If you are using the included LEIGHTRONIX TOTAL SHARE option for expanded 
storage, the “Total Share” feature can be used to enter the network address settings for 

your LEIGHTRONIX-supported network attached storage (NAS) devices.  The NAS 
configuration settings enable your NEXUS series system to recognize your NAS 
devices.   

NOTE: If LEIGHTRONIX preconfigured all of the E-HD2 servers and NAS devices for 
your TOTAL SHARE network at the factory, then you can skip this step. 

Click the “SYSTEM” menu button and then select the “Total Share” tab to display the 
window shown in Illustration 183. 

Illustration 183, "Total Share" Tab Screen 

 

Enter the requested information for each of your NAS devices and click “Save 
Changes.” 

NOTES:  If you have more than one E-HD2 server connected to your TOTAL 

SHARE network, you will need to repeat these steps on the web 
interface for each E-HD2. 

  For further instructions on setting up your TOTAL SHARE network, refer 
to the “TOTAL SHARE” tutorial. 
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LOGGING OUT OF WEB INTERFACE 

Click the “LOGOUT” button in the menu bar to log out of the E-HD2 web interface and 
return to the login screen. 
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SUPPORT 

Always ensure that the E-HD2 system physical connections (power cable, video/audio 
cables, and Ethernet cables) are secure. 

PARTS REPLACEMENT 

Due to the placement and sensitivity of components inside the E-HD2, the unit does not 
contain any user-serviceable parts.   

The E-HD2 must be sent back to the factory if battery replacement is necessary.  

Whenever the E-HD2 is unplugged, its backup battery automatically provides standby 
power to the unit.  Leaving the E-HD2 unplugged for extended periods of time will drain 
its backup battery. 

CHECKING EXTERNAL USB DRIVES AND INTERNAL HARD DRIVE 

Use the E-HD2 web interface disk diagnostics feature to automatically fix many 
common File Allocation Table (FAT) errors that may impair your E-HD2’s USB drives 

and internal hard drive or cause data loss on the drives.  LEIGHTRONIX recommends 
using the feature on a monthly basis to ensure optimal drive performance as well as any 
time you discover file/drive errors in your log files or notice drive performance issues.   

NOTE: The disk diagnostics process does not fix physical hardware degradation.   
 

To run the disk diagnostics feature, log into the E-HD2 web interface and click the 
“SYSTEM” tab to display the system status screen.   

Click the “Disk Diagnostics” button and then select the pop-up menu’s “Start 
Diagnostics” option to perform the disk check process.  When the diagnosis has been 

completed, a log file describing any errors discovered and actions performed will be 
added to your system’s “EVENTS.LOG” file (see the “System Log Files” section on 
page 230 for more information on the “EVENTS.LOG” file).   

CONTACTING LEIGHTRONIX TECHNICAL SUPPORT 

If you are experiencing a problem that you are unable to resolve, you may: 

Visit our website: www.leightronix.com 
E-mail us at: support@leightronix.com 

Call us at: 
(800) 243-5589 
(517) 694-1600 Fax 

Our technical support phone lines are open Monday through Friday, excluding holidays, 
from 8:30AM – 5:30PM, Eastern Time (ET). 
 
When you report a problem, please provide the following information: 

 Your name, and your company name, address, and phone number 

http://www.leightronix/
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 Model number 

 Serial number 

 Software version 

 Firmware version 

 Description of the problem 

 Status of the unit when the problem occurred (please try to include information on 
user and network activity at the time of the problem) 

 

Please contact the LEIGHTRONIX Technical Support Department at the number below 
for an RMA (Return Material Authorization) number before sending an item in for repair.  
 

LEIGHTRONIX, INC. 

2330 Jarco Drive 
Holt, MI  48842 

Phone:  (800) 243-5589 

Fax:  (517) 694-1600 
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WARRANTY 

LEIGHTRONIX, INC. warrants this E-HD2 high-definition video server/system controller 

against defective workmanship or materials for a period of five (5) years from the 
original date of purchase. 

During this warranty period, any parts found to be defective will be replaced at no 

charge.  Labor to repair or replace defective parts will also be performed at no charge 

during the warranty period. 

This warranty does not cover abuse, shipping damage, neglect, tampering by 
unauthorized personnel, acts of God, damage inadvertently caused by the user, 

preventive maintenance, or any product whose serial number is removed or defaced. 

The sole responsibility of LEIGHTRONIX shall be to repair or replace in accordance 
with this warranty. The seller’s and manufacturer’s only obligation shall be to repair or 

replace such quantity of the product proved to be defective. 

The customer shall bear the cost of shipping products returned to LEIGHTRONIX for 
warranty repair. The cost for return shipment to the customer will be assumed by 

LEIGHTRONIX and shipped via an equal priority service shipper prepaid and insured.  

Neither seller nor manufacturer shall be liable for any injury, loss or damage, direct or 
consequential, arising out of the use of, or the inability to use the product.  Before using, 

the user shall determine the suitability of the product for his/her intended use, and user 
assumes all risk and liability whatsoever in connection therewith. 

The warranty and the obligations and liabilities thereunder shall replace all other 

warranties or guarantees, express or implied. 
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DECLARATION OF STANDARDS CONFORMITY 

FCC NOTICE 

NOTE:   This equipment has been tested and found to comply with the limits for 
a Class A digital device, pursuant to part 15 of the FCC Rules.  These 

limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial 
environment.  This equipment generates, uses, and can radiate radio 

frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio 
communications.  Operation of this equipment in a residential area is 

likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense. 

 

CAUTION 

Changes or modifications to this device not expressly approved by 

LEIGHTRONIX, INC. could void the user’s authority to operate 

this device. 

This equipment is intended to be installed in a controlled environment with restricted 
access. 
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APPENDIX A: COPYRIGHT STATEMENTS 

The E-HD2 firmware contains portions of the following software. 

WHITSOFT SLIMFTPD 

Portions of the LEIGHTRONIX FTP Server are derived from WhitSoft SlimFTPd. 
 
Copyright (c) 2006, Matt Whitlock and WhitSoft Development 

All rights reserved. 
 
Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 
 
  * Redistributions of source code must retain the above copyright notice, 

    this list of conditions and the following disclaimer. 
  * Redistributions in binary form must reproduce the above copyright notice, 
    this list of conditions and the following disclaimer in the documentation 

    and/or other materials provided with the distribution. 
  * Neither the names of Matt Whitlock and WhitSoft Development nor the names 
    of their contributors may be used to endorse or promote products derived 

    from this software without specific prior written permission. 
 
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 

CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 

DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED 

TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON 
ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR 

TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

THE PHP LICENSE, VERSION 3.0 

Copyright © 1999–2002 The PHP Group. All rights reserved. 

--------------------------------------------------------------------  

Redistribution and use in source and binary forms, with or without modification, is 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 

conditions and the following disclaimer. 
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2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 

provided with the distribution. 

3. The name “PHP” must not be used to endorse or promote products derived from this 

software without prior written permission. For written permission, please contact 
group@php.net. 

4. Products derived from this software may not be called “PHP”, nor may “PHP” appear 

in their name, without prior written permission from group@php.net.  You may 
indicate that your software works in conjunction with PHP by saying “Foo for PHP” 
instead of calling it “PHP Foo” or “phpfoo” 

5. The PHP Group may publish revised and/or new versions of the license from time to 

time. Each version will be given a distinguishing version number.  Once covered 
code has been published under a particular version of the license, you may always 
continue to use it under the terms of that version. You may also choose to use such 

covered code under the terms of any subsequent version of the license published by 
the PHP Group. No one other than the PHP Group has the right to modify the terms 
applicable to covered code created under this License. 

6. Redistributions of any form whatsoever must retain the following acknowledgment: 

“This product includes PHP, freely available from <http://www.php.net/>”. 

 

THIS SOFTWARE IS PROVIDED BY THE PHP DEVELOPMENT TEAM ``AS IS’’ AND 

ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO,THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

PHPDEVELOPMENT TEAM OR ITS CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

This software consists of voluntary contributions made by many individuals on behalf of 
the PHP Group. 

The PHP Group can be contacted via Email at group@php.net. 

For more information on the PHP Group and the PHP project, please see 
<http://www.php.net>. 

This product includes the Zend Engine, freely available at <http://www.zend.com>. 
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GD STATEMENT  

 Portions copyright 1994, 1995, 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 

2004 by Cold Spring Harbor Laboratory. Funded under Grant P41-RR02188 by the 
National Institutes of Health. 

 Portions copyright 1996, 1997, 1998, 1999, 2000, 2001, 2002, 2003, 2004 by 
Boutell.Com, Inc. 

 Portions relating to GD2 format copyright 1999, 2000, 2001, 2002, 2003, 2004 Philip 
Warner. 

 Portions relating to PNG copyright 1999, 2000, 2001, 2002, 2003, 2004 Greg 
Roelofs. 

 Portions relating to gdttf.c copyright 1999, 2000, 2001, 2002, 2003, 2004 John 
Ellson (ellson@graphviz.org). 

 Portions relating to gdft.c copyright 2001, 2002, 2003, 2004 John Ellson 
(ellson@graphviz.org). 

 Portions relating to JPEG and to color quantization copyright 2000, 2001, 2002, 
2003, 2004, Doug Becker and copyright © 1994, 1995, 1996, 1997, 1998, 1999, 

2000, 2001, 2002, 2003, 2004 Thomas G. Lane. This software is based in part on 
the work of the Independent JPEG Group. See the file README-JPEG.TXT for 
more information. 

 Portions relating to GIF compression copyright 1989 by Jef Poskanzer and David 
Rowley, with modifications for thread safety by Thomas Boutell. 

 Portions relating to GIF decompression copyright 1990, 1991, 1993 by David 
Koblas, with modifications for thread safety by Thomas Boutell. 

 Portions relating to WBMP copyright 2000, 2001, 2002, 2003, 2004 Maurice Szmurlo 
and Johan Van den Brande. 

 Portions relating to GIF animations copyright 2004 Jaakko Hyvätti 
(jaakko.hyvatti@iki.fi) 

IJPEG STATEMENT 

 “this software is based in part on the work of the Independent JPEG Group”  

FREETYPE STATEMENT 

“Portions of this software are copyright © 1996-2002 The FreeType Project 
(www.freetype.org).  All rights reserved.” 

mailto:jaakko.hyvatti@iki
http://www.freetype/
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The following terms are used throughout this manual. 

TERM DEFINITION 

Baud Rate Controller’s data transmission rate in bits per second  

Bit Rate Bit rate is the speed at which pieces of information are 
transmitted. A bit is the single smallest piece of 

information that is transmitted, and the speed is expressed 
as the number of bits that are transmitted per second.  

BNC Type of connector used with coaxial cables 

CBR Constant Bitrate; the E-HD2 CBR recording preset option 

ensures the internal digital video recorders captures 
programs at the user-defined video bit rate. This option 

works best for video with little motion and allows you to 
reliably predict the record time of a video file. 

Character Generator Electronic device which produces graphics and characters 

for creating video titles 

Client (WinLGX) Software program that is used to contact and obtain data 
from a server software program on another computer 

Controller Provides unattended, automatic control over a wide variety 

of video devices including digital video servers, digital disc 
recorders, DVD players, video/audio routing switchers, 

VCRs, and the like 

Cross-Over Cable A twisted pair patch cable wired to route the transmit 
signals from one piece of equipment to the receive signals 

of another piece of equipment, and vice versa. 

Decoder A software program and/or hardware device that converts 

a signal back into its original format 

Destination Output 

DHCP Dynamic Host Configuration Protocol; protocol that 

automatically assigns IP addresses to devices as they are 
attached to a network 

DTE Data Terminating Equipment; refers to a communications 

device that is the source or destination of network signals 

E-HD2 Image File Contains system, device, and library properties and may 
contain a schedule of events 

Encoder A software program and/or hardware device that converts 
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a signal back into a coded format 

Ethernet Method of networking computers in a local area network 

(LAN) 

Event Control element that holds information about “what” is 

supposed to happen and “when” 

Event Action Any switch or device function 

FAT File Allocation Table; part of a hard disk where data is 

stored 

Firmware Software contained in a hardware device 

Gateway Address IP address of computer or router that transfers 

communications from the local network to the broader 
network 

H.264 Video compression standard for HD video developed by 

the ITU-T Video Coding Experts Group and ISO/ICE 
Moving Picture Experts Group (MPEG); also known as 
MPEG-4 Part 10 and AVC 

HD High-definition video 

Host IP-capable machine connected to an IP network 

Image File See E-HD2 Image File 

Immediate (control) Control of E-HD2 through WinLGX control panel instead of 
a schedule 

IP Address Internet Protocol; 4-byte address used to identify devices 

on a network 

LAN Local Area Network; computer network that covers a 

relatively small area (single building) 

LED Light-emitting diode 

Library Resource Contains the event actions of a frequently scheduled 

device medium.  Each library resource contains event 
actions for a specific digital video or switch action. 

Locked Event An event with an editable, fixed time entered by the user 

Log File List of E-HD2 system actions and alarms 

Mb/s Megabytes per second 

MPEG Moving Pictures Expert Group; standards for compressing 

digital video and audio data 

http://en.wikipedia.org/wiki/ITU-T
http://en.wikipedia.org/wiki/Video_Coding_Experts_Group
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Network A group of connected computers that can communicate 

with one another. Networks enable computers to share 
files and resources and exchange messages. 

NIC Network Interface Card; Ethernet card used to connect to 

a network 

OS Operating System 

PC Personal Computer 

Preroll Amount of time the E-HD2 system waits before switching 
device on-air (prevents the transmittal of black video or 

static found at beginning of a program) 

RCA Plug and jack connector for a two-wire coaxial cable 

Reset Time Time the device is unavailable for scheduling after the end 

of the event, usually due to “Rewind” time. 

Setup Time Amount of time device needs to prepare for playback; 
begins when device receives a playback command and 

ends at the first sign of video 

SD Standard definition video 

SMTP Simple Mail Transfer Protocol; protocol used to transfer 

email between or among servers 

Source Input (video and/or audio) 

Subnet Mask Separates IP address into network address and host 

address as assigned within the network 

Switchback Input Once the scheduled event time ends, the selected 

switchback input will be switched to the scheduled event’s 
channel output 

TCP/IP Transmission Control Protocol/Internet Protocol 

Unlocked Event An event whose start time is assigned by WinLGX to 
coincide with the ending time of the event above it.  This 

time is not fixed and will be adjusted by WinLGX if events 
above it are inserted, deleted, moved, or modified. 

USB 2.0 Hi-Speed Universal Serial Bus: capable of transmitting 

data between computer and external devices at 480 
Mbits/second 

VBR Variable Bit Rate; the E-HD2 VBR recording preset option 

allows the internal digital video recorders to automatically 
adjust the record rate of a program between the user-
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defined minimum and maximum video bit rates. This 
option ensures that the digital video recorders capture the 

more detailed portions of the program (particularly 
important for motion-intensive video). 

VFD Vacuum Fluorescent Display 

Video MPEG file 

Virtual Channel The E-HD2 web interface’s Virtual Channel feature 

provides two looping video sources that may be 
configured to automatically appear between scheduled 
programs or in place of a schedule. 
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INDEX 

AUTOMATIC MPEG FILE TRANSFERS .. 240 

CAUTION ...................................... 35, 280 

COMPLIANCE CERTIFICATIONS .............. 16 

CONFIDENCE MONITOR ....................... 218 

CONTROL PANEL................................. 204 
Digital video player ....................... 207 
Digital video recorder.................... 215 

Forcing a switch ............................ 206 
Ingest function for external switcher 
configurations ............................... 217 

Ingest function for no switch 
configurations ............................... 216 

CONTROLLER SETTINGS WINDOW ......... 75 

COPYING/CUTTING/PASTING EVENTS... 164 

DAY TABS 
Adding an event ............................ 161 

Functions....................................... 156 

DELETING EVENTS .............................. 165 

DEVICE EVENT PROPERTIES......... 170, 181 

DIGITAL VIDEO FILE SYNC .................... 198 

DVPLY 
Scheduling devices ............... 181, 183 

EDITING EVENTS ................................. 165 

E-HD2 STATUS REPORT ...................... 239 

E-HD2 WEB INTERFACE ..................... 237 

EPRO-BUS 
Configuring in Web Interface ........ 272 

Creating device resources............ 115 

ETHERNET 
Connecting directly to a PC via 
Ethernet........................................... 37 

EXTERNAL SWITCHER 
Channel output tab assignments . 101 
Non-LEIGHTRONIX switcher 
configuration steps ......................... 98 

Supported external switchers and 
parameters ................................ 30, 99 

FRONT PANEL 
Display ............................................. 23 
Keypad ............................................ 23 
Password, changing ....................... 74 

Password, entering ......................... 38 

FTP TCP BUFFER SIZE ........................ 44 

IMAGE FILES 
Creating ........................................... 57 
Opening ......................................... 144 

Saving ........................................... 149 
Sending ......................................... 200 

INSERTING LIBRARY RESOURCE EVENTS169 

LIBRARY EVENT PROPERTIES ............... 186 

LOG FILES 
Downloading from an E-HD2 system

 ....................................................... 226 
Viewer ............................................. 86 

MASTER CLOCK SYNCHRONIZATION ...... 46 

MPEG RECORDER (BROADCAST) 
Confidence monitor ....................... 218 

NO SWITCH 
Channel output tab assignments .... 96 

POWERING E-HD2 ON/OFF ................. 38 

PREFERENCES WINDOW ........................ 84 

PRINTING SCHEDULES 
Page layouts ................................... 79 
Print templates ................................ 77 

Printer and paper settings .............. 80 
Printing .......................................... 201 

REAR PANEL ......................................... 27 

REBOOTING E-HD2 FROM WINLGX ...... 76 

REPLACING LIBRARY RESOURCE EVENTS

 ....................................................... 167 

SCHEDULE COLUMN HEADINGS .............. 81 
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SERIAL PORT ........................................ 45 

SHARED SWITCHER 
Channel output tab assignments . 104 

Front panel IP address configuration
......................................................... 43 
WinLGX configuration................... 102 

STORAGE MANAGER 
Copying videos ............................. 222 
Deleting videos ............................. 223 
Moving videos ............................... 223 

Renaming videos .......................... 224 

SWITCHBACK INPUT ............................ 159 

SWITCHER CONFIGURATION ................... 95 

TCP/IP ADDRESSES 
Gateway address ............................ 40 
IP address ................................. 39, 41 

Subnet mask ............................. 40, 42 

THEMES, CUSTOMIZING WINLGX 

APPEARANCE ................................... 50 

UPDATING E-HD2 FIRMWARE.............. 233 

UPDATING WINLGX ............................ 235 

USB DRIVES 
Storage............................................ 19 

USER ACCOUNT RIGHTS ........................ 71 

USER-DEFINED DATA DIALOG BOX ........ 81 

VIRTUAL CHANNELS ........................... 254 
Activating from Control Panel....... 213 
Creating Playlists .......................... 256 

Creating Virtual Channel Playlist File 
(.vc) Library Resource .................. 136 

Deleting Playlists........................... 268 
Displaying Playlists ....................... 264 
Immediately Display Virtual Channel 

Playlist File (.vc) ............................ 214 
Overview ....................................... 254 
Saving Playlists ............................. 260 

Scheduling Virtual Channel Playlist 
File (.vc) Library Resource ........... 194 

WARNING ............................................. 16 

WEB SCHEDULE PORT .......................... 44 

WINLGX 
Changing Themes........................... 50 

FACTORY-DEFAULT USERNAME AND 

PASSWORD ..........................53, 56, 141 
Hiding/Displaying toolbars, windows, 

and schedule columns .................... 65 
Installation ....................................... 48 
Main window components .............. 59 

Moving windows.............................. 67 
Opening and logging in ........... 55, 140 
Rearranging schedule column 

headings .......................................... 67 
Resizing schedule column widths .. 67 
Updating software ......................... 235 

Version number ............................. 142 
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	Introduction
	Important Safety Instructions
	1. Read these instructions.
	2. Keep these instructions.
	3. Heed all warnings.
	4. Follow all instructions.
	5. Do not use this apparatus near water.
	6. Clean only with dry cloth.
	7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
	8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
	9. Do not defeat the safety purpose of the grounding-type plug. A grounding-type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician f...
	10. Protect the power cord from being walked on or pinched particularly at the plugs, convenience receptacles, and the point where they exit from the apparatus.
	11. Only use attachments/accessories specified by the manufacturer.
	12. Unplug this apparatus during lightning storms or when unused for long periods of time.
	13. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatu...
	14. When the apparatus is turned off, certain components in the power supply and system board remain energized. In order to remove all electrical power from the apparatus, unplug the power cord from the MAINS socket outlet.

	Features/Specifications
	Device Control Options
	Digital Video Recorder Specifications
	E-HD2 Front Panel
	Keypad
	Display

	E-HD2 Rear Panel

	Server Installation & Configuration
	About this Section
	Packing List
	Connecting E-HD2 Signal Wiring
	1. Rack mount your E-HD2 as follows, ensuring the ventilation holes on the side of the unit are not covered and adequate space is available behind the back panel for the USB drives.
	a. Insert the E-HD2 into the rack, aligning the holes of the server’s mounting bracket with those of the rack.
	b. Secure the E-HD2 to the rack with user-supplied rack screws.

	2. The E-HD2 has two RS-232 “COM” ports so you have the option to use an external switcher and master clock with your server.  If you are using both external devices, convert the “COM 2” mini-jack connector into a DB9M port with the included cable.  R...
	3. Connect playback destinations to the E-HD2’s HD/SD digital video outputs as follows:
	4. Connect video sources for recording to the E-HD2’s HD/SD digital video inputs as follows:
	5. Your E-HD2 audio connections are determined by the type of audio signals you wish to record and play out, as described below:
	a. Prepare your audio wiring for connection to the terminal blocks by stripping approximately a 1/4 inch of shield off the end of each wire.  Twist each wire’s individual strands together to prevent separation.
	b. Perform the following steps for each E-HD2 channel that you want to play and/or record non-embedded audio (refer to Illustration 15, Audio Terminal Blocks on Rear Panel of E-HD2 Server).
	i. With your fingers, gently grasp the desired terminal block on the E-HD2’s rear panel and pull to separate the block from the server.
	ii. Secure each of your prepared audio wires in their appropriate terminals as follows, referring to Table 2 for each wire’s placement on the terminal block:
	(1) Using a slotted, pocket clip screwdriver with a maximum tip width of 2.5mm and thickness of .4mm, open the terminal’s tension clamp by inserting the screwdriver tip into the clamp’s corresponding tension release slot (see Illustration 19 for an ex...
	(2) Insert the audio wire into its corresponding terminal until it is touches the bottom.
	(3) While holding the wire in place, pull the screwdriver from the slot.  The wire should now be clamped into place and should not fall out of the terminal if gently tugged.
	(4) Repeat steps 5.b.ii(1)–(3) for each of the remaining terminals in your audio terminal block configuration.

	iii. Push the wired terminal block back into its slot on the rear panel of the E-HD2 server, with the AES terminals on the block rotated toward its channel’s BNC video input (“SDI In”).  The block only fits one way into its holder on the rear panel.


	6. Attach up to three, LEIGHTRONIX-approved USB hard drives to the USB ports.  The E-HD2 system can support up to 4 TB.  For more information on USB drives compatible with the E-HD2, refer to www.leightronix.com or contact LEIGHTRONIX at (800) 243-5589.
	7. Attach the included power cord to the power cord connector on the back of the E-HD2, and then plug it into an AC power source.
	8. Turn on the E-HD2 by holding down the front panel red x button for four seconds.
	9. Proceed to “Configuring Ethernet Network Host Management,” on page 37, to configure the E-HD2 for remote control through Ethernet network host management.

	Configuring Ethernet Network Host Management
	Connecting the E-HD2 to an Existing Ethernet Network
	1. Obtain the following from your technical support personnel or network administrator and enter into the front panel of your E-HD2 system (see “Configuring Front Panel Settings,” on page 39):
	2. Using a straight-through RJ-45 Ethernet cable, connect the E-HD2 system’s left Ethernet port (labeled “1”) to a 10/100/1000 BASE-T hub or switch on the TCP/IP network.
	3. Ensure the PC from which you wish to control your E-HD2 system has been configured and attached to the TCP/IP network.

	Connecting a E-HD2 System Directly to a PC via Ethernet
	1. If necessary, install and configure a 10/100/1000 BASE-T Ethernet Network Interface Card (NIC) on the PC.  Refer to the NIC documentation and technical support for help in getting the NIC operational.
	2. Obtain your PC’s TCP/IP networking IP address and subnet mask as follows:
	a. Click on the Windows “Start” menu.
	b. Open the “Run” dialog box and type “command.” Click “OK” or press “Enter” on your keyboard to open the command.com window.
	c. Type in “IPconfig” at the C:\ prompt of the command.com window to reveal your PC’s IP and subnet mask address.

	3. Enter the following IP and subnet mask addresses into the front panel of your E-HD2 system (see “Configuring Front Panel Settings,” on page 39):
	4. Using a cross-over RJ-45 Ethernet cable (not a standard cable), connect the E-HD2 system to the PC’s network interface card (NIC).


	Turning an E-HD2 System ON/OFF
	Configuring Front Panel Settings
	Entering Password
	1. From the front panel of your E-HD2 server, press the right arrow key from any one of the status screens to display the password entry screen (see Illustration 22, Password Entry Screen).
	2. Press five-key password.
	3. If the password entered is correct, the E-HD2 system’s configuration menu will be displayed (see Illustration 23, Configuration Menu Screen).

	Editing TCP/IP Network Addresses
	Editing TOTAL SHARE Network Addresses
	Editing Shared Switcher IP Address
	Editing FTP TCP Buffer Size
	Editing Web Schedule Port
	Selecting Serial Port Settings
	Sharing External Time Clock with Multiple E-HD2 Servers


	Software Installation & Configuration
	About this Section
	WinLGX Minimum System Requirements
	Installing WinLGX Software
	1. Place the LEIGHTRONIX Product Resource Disc in your DVD drive.  A web page should automatically load in your default web browser.
	a. Open the Windows “My Computer” folder.
	b. Right click on your DVD drive and select “Click to display main menu.”

	2. From the LEIGHTRONIX web page, click the button for your E-HD2 server product.  This will load a new page with content specifically for your system.
	3. From your E-HD2’s web page, click on the “WinLGX Software” link.  If the file does not automatically download, choose the save file option when prompted.
	4. Navigate to where the WinLGX installer (“WinLGX v* Installer.EXE”) was saved on your computer.
	5. Right click the WinLGX installer and choose the run as administrator option to start the installation.  Follow the prompts to complete setup.
	6. As WinLGX installs, a succession of two additional installation windows will be displayed.  Refer to the following for a description of each window and installation guidelines:
	7. Click “Finish” to close the WinLGX setup wizard and return to Windows.

	Changing WinLGX Appearance (Themes)
	1. Go to the “View” drop down menu and select “Themes and Colors.”
	2. On the "Themes and Colors" window, click the "Skins and Themes" tab if it is not already selected (see Illustration 24).
	3. Click to choose a different interface, menu bar, and/or tab theme (see Illustration 25). To return to the WinLGX default appearance, just select the "Default" button for each theme that was changed.
	4. Once you are finished with your changes, either click the “Done” button or the close icon in the upper right corner of the pop-up window.

	Adding / Deleting E-HD2 Locations in the Site Manager
	1. If not already open, click “Site manager” in the “Tools” menu or the  icon on the main toolbar to open the “Controller Site Manager” window shown in Illustration 26.
	2. Click “Add” on the “Controller Site Manager” window (see Illustration 26) to open the “Add new controller” window shown in Illustration 27.  Complete the following fields:
	3. Click “Find.”  If you are adding the correct IP address, your server’s site ID, location, serial number, and time zone displays in the “Add new” window.
	4. Click “OK” to enter your E-HD2 server in the site manager database or “Cancel” to abort entry.
	5. If applicable, repeat steps 2–4 for each additional E-HD2 server in your system.
	1. Highlight the E-HD2 IP address you wish to delete.
	2. Click “Delete” to display the delete confirmation box.  Click “OK” to delete the E-HD2 IP address from the site manager location.
	3. Click “OK” at the bottom of the “Site Manager” window to save your changes to the database, or click “Cancel” to discard your changes.

	Connecting to Your E-HD2 Server
	1. Open the WinLGX “Site Manager” window (see Illustration 35) by performing one of the following:
	2. Once the WinLGX “Site Manager” is open, you should see a list of your E-HD2 systems.  If not, refer back to “Adding / Deleting E-HD2 Locations in the Site Manager,” on page 53.
	3. If desired, reorder your E-HD2 server listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	4. Connect as follows (see Illustration 35):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the E-HD2 system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen E-HD2 server(s) and close the login dialog box.  Once you are connected, a tab appears for each E-HD2 server on the main window beneath the toolbar.  If you logged into more than one E-HD2 s...


	Creating New E-HD2 Image Files
	1. WinLGX automatically opens with an empty image file loaded.  If you need to clear any settings, select “New” under the “File” menu.
	2. Select “Save as/Export” in the “File” menu to open the window shown in Illustration 30.”
	3. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the E-HD2 image file.
	4. Type a name for the image in the “File name” field.
	5. Ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	6. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”
	7. As you enter your configuration settings according to the “Configuring WinLGX” section starting on page 60, periodically save your settings in your image file by selecting “Save” from the “File” menu or clicking the  toolbar button.

	Configuring WinLGX
	About the Main Window Components
	Configuring the Main Window Components
	Configuring WinLGX Interface Colors
	Setting User Account Rights (Including WinLGX Password Changes)
	1. Select “User accounts” in the “Tools” menu to open the “User Accounts” window (see Illustration 41).
	2. WinLGX and E-HD2 web interface user rights are described in Table 16, User Control and Configuration Rights (see page 75) and Table 17, User File Access Rights (see page 76).  Perform any of the following according to the steps below:
	3. When finished configuring user information, exit the “User Accounts” window by clicking the “Close” button.

	Changing Front Panel Password
	1. Select “Set front panel password” in the “Tools” menu to open the window shown in Illustration 42.
	2. Click on a combination of five arrows for the new front panel password.
	3. Click “Set” to accept new password or “Clear” to cancel.
	4. Click “Done” to close the “Set Front Panel Password” window.

	Configuring Site Information, Clock, Updating Firmware, and Rebooting
	1. In the “Tools” menu, choose “Controller” to open the window shown in Illustration 43, “Controller” Window.
	2. Use the “Controller” window to set the following configuration maintenance settings.  After clicking “Set,” “Update,” or the “Reboot” button, you will be prompted for confirmation to perform the action on the connected E-HD2 server.  Clicking “Yes”...
	3. Click “Close” to close the “Controller” configuration window.

	Creating Templates for Exporting/Printing Schedules
	1. Create a schedule template per the following steps:
	a. Click “Export/Print templates” in the “Tools” menu to open the window shown in Illustration 44.
	b. Select template display items as follows:
	 Determine which event windows will be filtered for the schedule template:
	 Check the “Export/print switchbacks” checkbox to display channel switchbacks between programs.
	 Check “Export/print all records” to include all events in the selected event windows.
	 Add/remove schedule fields (columns) in template as follows:
	c. Click “Save” to save the template to a file.

	2. To revise a template:
	a. Click “Export/Print Templates” in the “Tools” menu to open the window shown in Illustration 44, “Export/Print Templates” Window.
	b. Click “Load.”  In the “Select Export/Print Template” window that appears, browse for the desired template and open.  The filename will then appear in the “Template” box at the top of the “Export/Print Templates” window.

	3. Click “Done” when finished to close the “Export/Print Templates” window.

	Configuring Page Layouts For Schedules Printed from WinLGX
	1. Select “Page Setup” in the “File” menu to open the box shown in Illustration 45, “Page Setup” Window, and configure the schedule printout according to the following options:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Configuring Printer and Paper Settings for Schedules Printed from WinLGX
	1. Selecting “Print Setup” in the “File” menu opens the box shown in Illustration 47, “Print Setup” Window, which allows you to configure the printer and paper settings as follows:
	2. Click “OK” to save your settings or “Cancel” to close the window without saving.

	Creating Custom Schedule Columns
	1. Click “User defined data” under the “Tools” menu to open the window shown in Illustration 49.
	2. Select the fields displayed on your schedule as follows:
	3. Click on the field which you would like to rename.  In the “Edit Field Options” window that appears (see Illustration 50), perform the following:
	a. Enter a new schedule heading into the “Menu title” field.
	b. Add a list of menu items that will be used to define schedule events under the renamed column.  The number of menu items that may be added corresponds to the number of options shown over each section of field names on the window.

	4. Click “OK” to accept changes or “Cancel” to abort all editing changes made in the “Edit Field Options” window and return to the “User Defined Data” window.
	5. Click “OK” to accept or “Cancel” to abort all field changes and close the “User Defined Data” window.

	Setting WinLGX Viewing and Communication Preferences
	1. Under “Format type,” select the format of the device/library event properties window you would like to configure.
	2. Perform any of the following options:

	Configuring the Switch Type of an E-HD2
	Configuring Digital Video Recording Presets
	Editing Internal Digital Video Playback and Recording Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices” window (refer to Illustration 66, “Devices” Window).
	2. In the “Resource View,” click on the desired device icon to reveal the corresponding properties fields.

	Creating External Switch Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 68, New Switch Device Properties).
	2. Right click in the “Resource View” window and select “New” to display the device type menu.  Select the “SWITCH” device type to add a new device to the window (see Illustration 68, New Switch Device Properties).
	3. Complete the switch device “Properties” field shown in Illustration 69, Switch Event Properties Window.  Refer to Table 19, Switch Event Properties, for a description of the editable switch resource properties.

	Creating ePRO-BUS-Controlled Device Resources
	1. Click on the “Devices” folder on the right side of the schedule editor window to display the “Devices View” window (refer to Illustration 68, New Switch Device Properties).
	2. Right click in the “Resource View” window and select “New” to display the device type menu.  Select either the “DVD” or “Tape” device type to add a new device resource to the window (see Illustration 70, New Device Properties).
	3. Complete the properties fields shown in Illustration 71, ePRO-BUS Resource Properties Window according to Table 20, ePRO-BUS Resource Properties.

	Creating Library Resources
	4. When you have finished creating your library resources, you have the option of exporting any digital video library resource properties into resource files (.res) on your E-HD2’s USB and NAS storage devices.  Resource files are useful for quickly im...
	a. Right click on the “Library” configuration folder containing the library resources you wish to export and select “Export” from the pop-up menu (see Illustration 74) to display the “Export MPEG Resource” window (see Illustration 75).  Resource files...
	b. If the selected library folder contains resources for digital videos on more than one USB or NAS device, single click to select a storage device in the “Export MPEG Resource” window (see Illustration 75, "Export MPEG Resource" Window).  Only the li...
	c. If you wish to overwrite an existing resource file, single click to select the file in “Resource Files” listing.  Click the “Export” button and, if saving a new resource file, enter an alphanumeric filename without spaces into the “Export resource”...
	d. When the resource file has been uploaded to the selected E-HD2 USB or NAS storage device, click “Ok” when you are prompted.
	e. If desired, repeat steps 4.a–d for each set of library resources in the folder referencing digital videos on your other storage devices.




	Software Operation
	About this Section
	Performing General WinLGX Operations
	Opening WinLGX and Connecting to an E-HD2 Server
	1. Double click the WinLGX desktop icon.  The login window shown in Illustration 88 automatically appears when WinLGX is opened or when you click one of the following:
	2. If desired, reorder your IP address listing.  Clicking on any column header in the “Site Manager” sorts the associated information in ascending order, while clicking the header again sorts the list in descending order.
	3. Connect as follows (see Illustration 88, “Site Manager” Window):
	a. Select one or more IP addresses.  You may select up to eight IP addresses by holding down your keyboard “Ctrl” key and clicking each address with the left mouse button.
	b. Log in with the username and password given to you by the E-HD2 system administrator.  To simultaneously log into multiple servers, all of the selected IP addresses must have the same username and password.
	c. Click “Connect” or press “Enter” to connect to the chosen E-HD2 server(s) and close the login dialog box.  Once you are connected, a tab appears for each E-HD2 server on the main window beneath the toolbar.
	d. If you logged into more than one E-HD2 system, switch between the servers by clicking on the product tabs on the main window.


	Displaying WinLGX Version Number
	Disconnecting from an E-HD2 Server
	1. Select “Site manager” in the “Tools” menu or click the  icon on the toolbar to open the “Site Manager” window shown in Illustration 88.
	2. Select the E-HD2 address(es) you would like to disconnect.  If you want to disconnect from more than one address, hold down your keyboard “Ctrl” key and click on each address with the left mouse button.
	3. Click the “Disconnect” button.  A box will appear asking whether or not you would like to disconnect from the current E-HD2 location(s).  Click “Yes” to disconnect or “No” to remain connected.

	Exiting WinLGX
	1. Select “Exit” in the “File” menu or click the  in the upper right corner of the main window.
	2. If an image file has not been saved for one of the connected E-HD2 servers, the dialog box shown in Illustration 90 appears and asks if you want to save the changes.  Select one of the following options:


	Opening E-HD2 Image Files
	Opening a Saved Image File
	1. Select “Open” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 91.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data is then loaded into WinLGX.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 157, periodically save your settings in an image file as described in “Saving E-HD2 Image Files,” on page 151.

	Opening an Image File as New
	1. Select “Open as new” in the “File” menu or click the  icon on the main toolbar to open the file selection window shown in Illustration 92, Open Image File as New Window.
	2. Ensure the “Controller Image (*.nmg)” option has been selected in the “Files of type” field.
	3. Select an image file folder from the “Look in” drop down box at the top of the window.
	4. Single click a .nmg file to select it and click “Open” or double click the file.  The image file data minus the schedule is then loaded into WinLGX as an unnamed file.
	5. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 157, periodically save your settings in an image file as described in “Saving E-HD2 Image Files,” on page 151.

	Receiving Image Files from the Connected E-HD2 Server(s)
	1. Download the last image file sent to one or more of your E-HD2 servers as follows:
	2. As you enter/edit your schedule events according to the “Scheduling Events” section starting on page 157, periodically save your settings in an image file as described in “Saving E-HD2 Image Files,” on page 151.

	Associating E-HD2 Image Files with WinLGX

	Saving E-HD2 Image Files
	1. From the “Save in” drop down box at the top of the window, navigate to the folder where you want to save the E-HD2 image file.
	2. Type a name for the image in the “File name” field.
	3. If you plan to re-open this file in WinLGX, ensure the “Controller Image (*.nmg)” option has been selected in the “Save as type” field.
	4. Click “Save” to save the image under the entered name or “Cancel” to abort the “Save as.”  If you enter a name of a file that already exists, WinLGX will ask you if you want to overwrite it.

	Importing Digital Video Library Resources
	1. Right click on the “Library” configuration folder you wish to import digital video library resources into and select “Import” from the pop-up menu (see Illustration 95) to display the “Import MPEG Resource” window (see Illustration 96).  Resource f...
	2. If more than one device is shown in the “Storage Device” listing on the “Import MPEG Resource” window (see Illustration 96, "Import MPEG Resource" Window), single click to select the storage device containing the resource files with the library res...
	3. If more than one resource file exists, single click to select the file with the library resources you wish to import (see Illustration 97).
	4. Click the “Import” button to start importing the resources or “Done” to cancel the operation and close the “Import MPEG Resource” window.
	5. After clicking the “Import” button, click “Yes” when prompted to import the file’s digital video library resource properties or “No” to abort.
	6. When the digital video library resource properties have been imported, click “Ok” when you are prompted.  The imported library resources will be shown in the “Resource View” (see Illustration 98 for an example).
	7. If you wish to import digital video library resources from additional resource files, repeat steps 1–6.

	Using Instant Video Preview Monitor to Display Digital Video Files within WinLGX
	Scheduling Events
	About Schedule Window Components
	Scheduling/Editing/Deleting All Events
	1. Select a scheduling event window as follows:
	a. Click the desired day tab to select the day you want the event to occur.
	b. Select one of the following channel tabs:

	2. Drag an icon from the “Device” or “Library” “Resource View” into the selected event window.  This opens an “Event properties” box with editable event information like the one shown in Illustration 101, Day/Channel Output Event Properties Box.
	3. To add or change the event information, click on each of the desired editable fields (described on pages 172–199) and enter the new information.  An icon can be dragged and dropped into a day/channel output event window in the following five ways:
	a. To select a date, change “Absolute date” to “Yes.”  A date field appears below to allow date entry.
	b. To enter a day, change the desired day field(s) to “Yes.”  These fields can be toggled quickly by double clicking on the day name.


	Scheduling/Editing Device Resources
	Scheduling/Editing ePRO-BUS-Controlled Device Resources
	1. Select the WinLGX-LT tab on the bottom of the scheduling window.  If you do not see this tab, go to the “Tools”/”Preferences”/”Applications” tab and select the “Show WinLGX-LT tab” option.
	2. Open the ePRO-BUS record “Event Properties” window (see Illustration 112, Remote ePRO-BUS Record Event Properties Window) by either adding or editing the ePRO-BUS record event.  To add a new event, drag the desired ePRO-BUS-controlled device resour...
	3. Complete or edit the event properties fields according to Table 31, Editable Remote ePRO-BUS Record Event Properties.  Some of the fields will vary, depending on whether you used a “DVD” or “Tape” format to create your ePRO-BUS resource.

	Scheduling/Editing Library Resources
	Changing Channel Switchbacks
	1. Select “Switchback editor” under “Tools”/”System Tools” to open the “Channel Switchback Editor” (see Illustration 121).
	2. Select the channel output/day tab schedule window containing the switchback inputs you would like to change by selecting a channel output under “Channel” and a day under “Day of week.”  You may select “All” under “Day of week” to select all schedul...
	3. Under “Replace all,” select the switchback input you would like to change.
	4. Use the “With” drop down menu to select a new switchback input.
	5. Click “OK” to make the changes or “Cancel” to abort.

	Checking Schedule and Library Resources for Missing Digital Video Files
	1. If you have not already done so, open an E-HD2 image file in WinLGX.
	2. Click the  sync icon on the main toolbar or choose the “Tools”/”System tools”/”Sync Library Resources” menu item.  Those events containing missing digital video files are highlighted in the schedule and a “Sync Library Resources” box pops up to rep...


	Sending E-HD2 Image Files
	1. Send an image file to one or more of the currently connected servers according to the following steps:
	2. Once each transfer is completed, the E-HD2 system(s) will contain and execute the scheduled events.

	Printing Schedules from WinLGX
	1. Create a print template to select the desired schedule information for printing (see “Creating Templates for Exporting/Printing Schedules,” on page 79).
	2. Determine the page layout of your schedule printout (see “Configuring Page Layouts For Schedules Printed from WinLGX,” on page 81).
	3. Select “Print” in the “File” menu or click the  icon on the main toolbar to open the template selection window shown in Illustration 124.
	4. Choose the desired template from the “File name” list in the “Select Export/Print Template” Window (see Illustration 124) and click “Open,” or double click the template file to open the “Print” window.  Click “Cancel” to abort the print.
	5. In the “Print” window, configure the printer and copy settings according to the following steps. Click “OK” to print or “Cancel” to abort the print.

	Exporting Schedules into Comma Separated Values Files
	1. Ensure the schedule you wish to export is currently open in WinLGX (see “Opening E-HD2 Image Files,” on page 146).
	2. If you have not already done so, create a template (see “Creating Templates for Exporting/Printing Schedules,” on page 79).
	3. Select “Save as” in the “File” menu to open the window shown in Illustration 125, which allows you to export the loaded schedule as a comma separated values file (.csv) as follows:
	a. Select a folder in the “Save in” field.
	b. Type a name for the exported file in the “File name” field.  If you leave the extension off, WinLGX puts it on for you.
	c. Select the .csv export format in the “Save as type” drop down menu.
	d. Click “Save” to open the template selection window shown in Illustration 126.  To apply a template to your schedule information, select the desired template and either click “Open” or double click the template file to create the export schedule .cs...


	Using Control Panel to Perform Immediate Device and Switch Actions
	1. Open the Control Panel window (see Illustration 127) by clicking “Control Panel” under the “Tools” menu or  icon on the main toolbar.
	2. If desired, sort the device icons by right clicking in the “Devices” column and selecting one of the sorting filters in the right-click menu that appears (see Illustration 128, Control Panel Device Sorting Menu).
	3. Perform any of the following steps:
	4. When finished, click “Close” to exit the Control Panel.
	Stop/Start a Schedule
	EXTERNAL SWITCHER Configurations Only—Performing Forced Switches and Viewing Switcher Status
	Controlling Internal Digital Video Players 1 and 2
	Controlling Internal Digital Video Recorders
	1. Select the digital video file recording parameters:
	a. Check the “Record CC data” box to capture any closed caption data from the source during recording.  Closed captions are hidden in the video signal and decoded for display on televisions with built-in decoders or televisions connected to external d...
	b. Select one of the following record overwrite options:
	c. Select the volume of the drive on which you would like to store the recorded file from the “Storage Device” drop down list.
	d. Under “File,” enter up to 27 characters (no spaces) for the filename.
	e. Select one of the user-defined record presets for the desired recording quality.  See “Configuring Digital Video Recording Presets,” on page 108, for more information on defining the recording quality settings.
	f. If you would like a library resource for the .m2t digital video file added to the “Library” tab window, select the “Add to library” option.  Once the digital video recorder stops, WinLGX displays the “Add to library” window (see Illustration 142). ...

	2. Start and stop recording through one of the following options:

	Monitoring an MPEG File Recording
	Controlling ePRO-BUS Record Devices

	Managing Storage of Digital Video and Image Files
	Choosing File Storage Devices
	1. The left side of the Storage Manager window allows you to access both your local and remote storage devices.  Select a storage device as follows:
	2. The right side of the “Storage Manager” window provides access to your E-HD2’s remote storage devices.  Refer to the remote storage device selection instructions in the step above.
	3. Manage your digital video .m2t files according to “Managing Digital Files” on page 224.  When you are finished, click the “Close” button to exit the “Storage Manager” window.

	Managing Digital Files
	Previewing Video Files

	Retrieving Log Files
	1. Click on the “As played” tab on the “Select Controller Log File” window.
	2. Single click on the desired .CSV file to select it and then click “OK.”
	3. A “Save as Played log File” window will open.  Save the .CSV file to a new file path or use the WinLGX default log file path (Shared Documents\Leightronix\WinLGX\Controller Data\IP xxx.xxx.xxx.xxx\Log”).
	4. Click the “Save” button to save the file to your chosen file path.  The “Save as Played log File” and “Select Controller Log File” windows will close.
	5. Navigate to the file path for the saved .CSV file and open it in Excel.

	Updating Firmware/Software
	Updating E-HD2 Server
	1. Open the WinLGX software and log in to your E-HD2 system (see “Opening WinLGX and ” on page 142).
	2. Choose “Controller” under the “Tools” menu to open the “Controller” window shown in Illustration 155.
	3. Under “Firmware update,” click “Browse” to open the “Choose controller firmware file” window shown in Illustration 156.
	4. Navigate to and open the current .lpf file to update your E-HD2 server’s firmware and, if needed, your web interface.  Once you have selected and opened the file, the “Select firmware options” window is displayed (see Illustration 157).  Leave all ...
	5. Click “Update” to continue the firmware update.  Click “Yes” when prompted to start the update.
	6. Once the update has completed, click “OK” to apply the changes and reboot the E-HD2 server.  You will be logged out and the “Site Manager” window will be displayed.
	7. After the E-HD2 system finishes rebooting, log back in and confirm the E-HD2 system has been upgraded to the latest firmware version in the “Site Manager” database.

	Updating WinLGX Software
	1. Close WinLGX.
	2. Navigate to and open the WinLGX_vx.x.x.x_Installer.exe.  Follow the prompts to install the latest version of the client software.
	3. Click “OK” to continue WinLGX update.
	4. Follow the prompts to complete the installation.



	Web Control
	About this Section
	Opening and Logging into Web Interface
	1. Open the E-HD2 web interface through one of the following steps:
	2. A login prompt will appear (see Illustration 159, Login Prompt).  Enter your username and password.
	“Site Information”
	“Storage”
	MPEG Player/Recorder Statuses
	“Network Settings”
	“Switcher Status”

	Managing Digital Video Files
	Setting Up Transfer Destinations
	1. “Verify Connectivity”: after entering your E-HD2’s IP address, username, and password, click the “Verify Connectivity” button to ensure your E-HD2 can connect to the destination server.
	2. “Automatic Upload”: when selected, files will be automatically transferred to the specified E-HD2 after each recording session.
	3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your E-HD2 will transfer files to your destination E-HD2.  Single click each hour segment on the timeline to toggle transfer capabilities on or off (gr...
	1. “Verify Connectivity”: after entering your server’s IP address, username, and password, click the “Verify Connectivity” button to ensure your E-HD2 can connect to the destination server.
	2. “Automatic Upload”: when checked, MPEG broadcast files will be automatically transferred to the specified server after each recording session.
	3. “Transfer Holdoff Schedule”: 7 day/24-hour timeline allows you to decide which hours of the week your E-HD2 will transfer files to your destination server.  Single click each hour segment on the timeline to toggle transfer capabilities on or off (g...

	Manually Transferring Digital Video Files

	Managing Log Files
	Save/Open a Log File
	Search a Log File
	Delete a Log File

	Viewing Web Program Guide
	Viewing Program Guide within the Web Interface
	1. Click the “Program Guide” menu button to display a program guide screen like the example shown in Illustration 167.
	2. From the “Channel” drop down menu, click one of the channel outputs to only display the programming lineup for the selected channel or click “All Channels” to display the programming schedule for all WinLGX channel tabs.
	3. From the “Mode” drop down menu, select “Day” if you would like to view programming for just one day in your schedule (see Illustration 167) or choose “Week” to view programming for all seven days of your schedule (see Illustration 168).  If you cho...
	4. For the “Day” mode view, click on a day of the week to view programming for the corresponding weekday.  If you selected the “Week” mode, clicking a day button will sort your programming schedule by the selected day.
	5. If you wish to display the program start time down to the second, click the “Show Seconds” “on” button.  The default option is “off.”

	Viewing Program Guide from a Web Browser or Your Own Website
	1. Click the “Program Guide” menu button to display your E-HD2’s program guide.
	2. Click the URL link on the “Program Guide” screen as shown in Illustration 169 to open your E-HD2 program guide in a separate browser tab window.
	3. If necessary, edit the following variables (shown in red) in the web address to change the programming display:
	4. Distribute the web address as a link or with instructions to paste the address into the address bar of one of the supported web browsers.
	1. Click the E-HD2 web interface’s “Program Guide” button to display the corresponding screen.
	2. To display the embed code, click on the “Embed Script” arrow (see Illustration 170).
	3. Drag your mouse cursor across the code to highlight and select it, then simultaneously press the “Ctrl” and “C” keys on your keyboard to copy the code.
	4. Paste the code onto one of your web pages by simultaneously pressing the “Ctrl” and “V” keys on your keyboard.
	5. If desired, customize the code for your website by editing the embed code variables as described below:
	6. Upload the web page with the embed code to your web server.  The embedded program guide will dynamically update to display your current program schedule.


	Using Virtual Channels
	Overview
	1. Select Virtual Channel 1 or 2 by clicking the corresponding “Channel” button on top of the Virtual Channel editor screen (see Illustration 171, Virtual Channel Editor on page 256).
	2. Refer to the following sections for playlist management instructions:
	3. Activate Virtual Channel playlists for display according to “Displaying Virtual Channel Playlists,” on page 266.

	Creating/Modifying Virtual Channel Playlists
	1. If you are modifying an existing playlist, load it according to the corresponding set of steps below.  Otherwise, skip to step 2 on page 260.
	2. Add, remove, and re-order resources in the Virtual Channel playlist window according to Illustration 174 and Table 40.  Virtual Channel playlist resources will play in the order listed.  Display durations for each resource type are as follows:
	3. If any switcher input resources were added to the playlist, access each resource’s display duration setting by double clicking its length on the playlist window.  The resource’s length field will become active, allowing you to type a new length int...
	4. Once you have finished creating or modifying your playlist, either continue to “Saving Virtual Channel Playlists” on page 262 to learn about the Virtual Channel Editor’s options for saving a playlist or click the “Current” button to add the resourc...

	Saving Virtual Channel Playlists
	1. Create the playlist according to “Creating/Modifying Virtual Channel Playlists,” on page 258.
	2. Save the playlist according to one of the following save options:
	3. If desired, immediately activate your Virtual Channel and display your playlist according to “Displaying Virtual Channel Playlists,” on page 266.

	Displaying Virtual Channel Playlists
	1. If your day/default playlist(s) are saved in a Virtual Channel configuration file (.vcf), load it in the E-HD2 web interface as follows:
	a. Click the “Advanced” button to display the “Advanced Virtual Channel Options” window and then click the “List Config” tab to display the window shown in Illustration 173.
	b. Single click to select a configuration file in the file listing and then click the “Load” button to add the file’s playlists into the Virtual Channel’s day/”Default” presets.

	2. In your WinLGX schedule file (.nmg), be sure to do the following:
	a. Enable your Virtual Channels for use as WinLGX switchback resources by selecting “Yes” from the “Virtual Channel” drop down menu in the “System Configuration” properties (see “Configuring the Switch Type of a,” on page 97).
	b. Perform any of the following to fill channel switchbacks on the first two WinLGX channel output tabs:


	Deleting Virtual Channel Playlist Files
	1. From the “Preset” drop down menu, select the playlist file you wish to delete.
	2. Click the  icon on the Virtual Channel toolbar.
	3. On the “Delete Preset” popup window, click “Yes” to delete the file or “No” to cancel the action and close the popup.


	Editing E-HD2 Site Name and Location
	Changing E-HD2 System Time
	Changing the Front Panel and “admin” Passwords
	Maintaining USB Drives and Internal Hard Drive
	Updating System Firmware
	Configuring ePRO-BUS Settings
	Configuring Total Share Settings
	Logging Out of Web Interface

	Support
	Parts Replacement
	Checking External USB Drives and Internal Hard Drive
	Contacting LEIGHTRONIX Technical Support

	Warranty
	Declaration of Standards Conformity
	FCC Notice

	Appendix A: Copyright Statements
	WhitSoft SlimFTPd
	The PHP License, version 3.0
	1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
	2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
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